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Scope of this Guide
This guide provides a general reference for both Spartan’04 and the
Essential Edition of Spartan’04 for Windows. Following a brief
summary of “What’s New in Spartan’04”, it is divided into 17
chapters grouped into three sections, along with several appendices.

Section I (Introduction, Chapter 1) introduces Spartan’04 as a tool
for exploring organic, bioorganic, inorganic and organometallic
chemistry by way of molecular mechanics and quantum chemical
calculations, together with an array of graphical models for conveying
the results of these calculations.

Section II (Getting Started, Chapters 2 to 7) describes the overall
operating environment of Spartan’04 for Windows, and then provides
an extensive set of “hands-on” tutorials. Most of the tutorials can be
completed with the Essential Edition, and sections which can not be
completed are marked as such. This section is the place to start for
new users of the program, and should also be perused by users of
previous versions of SPARTAN.

Section III (Features and Functions, Chapters 8 to 17) describes
in detail the functions available from the menus and dialogs
incorporated into the graphical user interface for Spartan’04. The focus
is on graphical input and manipulation of structure, input of other
required information, and text, spectral and graphical output resulting
from molecular mechanics and quantum chemical calculations. This
section is intended as a general reference to Spartan’04 for Windows.

What this guide does not do is document the “performance” and “cost”
of the different molecular mechanics and quantum chemical models
available in Spartan’04, or recommend specific models or
combinations of models for use on “real” chemical problems. Neither
does it show the utility of graphical models in presenting and
interpreting the results of the calculations. These topics are covered
in depth in “A Guide to Molecular Mechanics and Quantum
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Chemical Calculations” available from Wavefunction, which also
provides a collection of illustrative examples.

Appendices provide an overview of the program’s overall architecture
as well as its present capabilities and limitations (A), a directory of
functions under its menus (B), a listing of commonly-used options
(C), a listing of units (D), NMR chemical shift standards (E), the
proper citation for the program (F), instructions for installing the
Cambridge Structural Database (G), directions for making databases
from Spartan calculations (H) and directions for installing a network
HASP (I). Several of these appendices are included as part of the
program’s “On Line Help” facilities.
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What’s New in
Spartan’04
Several significant capabilities have been introduced in Spartan’04,
and promise to expand in the future.

• NMR. This is available for chemical shifts with Hartree-Fock
models. Future development will implement coupling constants
and to extend the overall capability to density functional models.
Not available in Essential Edition.

• Solvation via mixed quantum mechanics/molecular mechanics.
This allows not only calculation of the solvation energy but also
the effect of the solvent on molecular properties. This is presently
available for water as a solvent. Future development will extend
this to other solvents. Not available in Essential Edition.

• Spartan Molecular Database (SMD). This is a database of
calculated structures, energies and selected molecular properties.
SMD presently comprises approximately 50,000 organic and main-
group inorganic molecules, each of which is available at up to
five different theoretical models: HF/3-21G, HF/6-31G*, EDF1/
6-31G*, B3LYP/6-31G* and MP2/6-31G*. Additional models
may also be added in the future. Database entries may either be
used to directly replace structures built by or imported into Spartan,
and may be accessed through substructure searches. SMD is
expected to grow at 25%/year, and will soon include infrared,
UV/vis and NMR spectra and to extend to transition-metal
inorganic and organometallic compounds as well as transition
states. EDF1/6-31G*, B3LYP/6-31G* and MP2/6-31G* entries
not available in Essential Edition.

• UV/vis Spectra. This is presently limited to vertical excitation
spectra based either on the difference in energy between Hartree-
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Fock and CIS models or between density functional (local, BP,
EDF1, BLYP and B3LYP functionals) and time-dependent density
functional (TDDFT) models. Not available in Essential Edition.

• Import of two-dimensional structures. Input of SDF, TGF and
SKC files and automatic conversion into 3D geometries.

• Intrinsic Reaction Coordinate. This constructs a series of steps
which smoothly follow the reaction coordinate from the transition
state to both reactants and products. Not available for semi-
empirical models. Not available in Essential Edition.

A number of additional important improvements and enhancements
are implemented in Spartan’04.

• Use of NOE data in conformational searching.

• Display of hydrogen bonds.

• Plotting of infrared spectra.

• Inversion of a chiral center.

• Control over animation speed.

• Tube and Ball-and-Spoke models (optionally) showing multiple
bonds.

• Automatic centering of molecules on screen.

• Help functions in individual dialogs.

Spartan’04 is generally faster than Spartan’02 due to improved
compilers. Some specific calculations, e.g., frequencies using density
functional models, have been reworked and are significantly faster.
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Introduction
Molecular mechanics calculations and quantum chemical calculations
play an ever-increasing role in modern chemistry. Traditionally, they
have served to supply information about structures, relative stabilities
and other properties of isolated molecules. Because of their inherent
simplicity, molecular mechanics calculations on complex molecules
have spread widely throughout the chemical community. Quantum
chemical calculations, including Hartree-Fock  molecular orbital
calculations, but especially calculations which take account of electron
correlation, are much more time demanding. Only recently, have fast
enough computers become widely available to make their application
routine among mainstream chemists.

Quantum chemical calculations may also be called on to furnish
information about the mechanisms and product distributions of
chemical reactions, either directly by calculations on transition states,
or indirectly by modeling the steric and electronic demands of the
reactants. Quantitative calculations, leading directly to information
about the geometries of transition states, and about reaction
mechanisms in general, are becoming more and more common, while
qualitative models are still needed for systems which are too large to
be subjected to the more rigorous treatments. Finally, quantum chemical
calculations may be asked to supply information to complement
existing experimental data or to replace it altogether, for example,
atomic charges for QSAR analyses, and intermolecular potentials for
molecular mechanics and molecular dynamics calculations.

Spartan’04 for Windows has been designed to address the ever
increasing role which calculations play in chemistry and related fields.
It represents a continued collaboration between Wavefunction, Inc.,
and Q-Chem, Inc. Q-Chem codes supplement and extend the
traditional strengths of SPARTAN as an easy to learn and use tool for

Section I
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molecular mechanics and semi-empirical and Hartree-Fock molecular
orbital calculations, as well as for a wide range of graphical models,
with a full range of density functional models as well as a selection
of important post-Hartree-Fock models. All models have been
implemented using what we believe are the most robust algorithms
currently available, and have been especially tuned for high
performance on Intel processors.

Spartan’04 is intended to be utilized by chemists, not only
computational chemists who are already familiar with the capabilities
of molecular mechanics and quantum chemical methods, but also
experimental chemists who may have little or no prior experience,
but who want to use calculations much in the same way as
experimental techniques such as NMR spectroscopy. This ambitious
goal is directly reflected in the program’s overall design criteria:
“convenient access to a full range of modern molecular mechanics
and quantum chemical models”, and clearly distinguishes Spartan’04
from other molecular modeling packages.

Section I 12/30/03, 3:20 PM2



3

Spartan’04 for Windows
This chapter provides a brief discussion of the architecture of
Spartan’04 for Windows, focusing on the connectivity of graphics,
database and computational components. Available molecular
mechanics and quantum chemical methods are enumerated, and their
overall role suggested.

Spartan’04 for Windows comprises a series of independent modules
tightly connected via a graphical user interface, which is highly
functional yet rather simple and uncluttered. It has been designed
not only to greatly reduce the drudgery and possibility of human
error associated with the preparation of input, but also to guide the
interpretation of output. The interface is perhaps best viewed as an
interactive and intuitive window into a full range of modern
computational techniques.

Chapter 1

Graphical
User

Interface

Molecular
Mechanics

DatabasesCorrelated

Density
Functional

Properties

Hartree-
Fock

Spectra

Graphics

Semi-
Empirical
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Included in the interface are builders for organic, inorganic and
organometallic molecules, polypeptides and polynucleotides, as well
as a procedure for guessing transition states from a database of organic
and organometallic reactions. Also included is the Spartan Molecular
Database, a collection of over 50,000 calculated structures for organic
and main-group inorganic molecules, each obtained from as many as
five different theoretical models, as well as an interface to the
Cambridge Structural Database, comprising over 300,000
experimental X-ray crystal structures for organic and organometallic
molecules*. Finally, Spartan allows for import of a variety of
“external” data files, most important among them being PDB (protein
structures) and SDF (structure drawings). Thus, it is not only possible
to construct molecules “from scratch”, but also to access a wide variety
of existing structures.

Spartan’s interface also provides the gateway into a range of modern
computational methods, including molecular mechanics models, semi-
empirical and Hartree-Fock molecular orbital models, and a variety of
so-called correlated models including density functional models. None
of these models is “ideal” for every application**. While the most
sophisticated quantum chemical models may yield excellent results,
they will be likely be too expensive for routine application, and it will
usually be necessary to contend with lesser treatments. Spartan’s
interface facilitates “mixing and matching” different molecular
mechanics and quantum-chemical models. Results from one model
may easily be passed on for further analysis with another (better) model.

* The Cambridge Structural Database itself is not included with Spartan’04, but rather is
available on a subscription basis from the Cambridge Crystallographic Data Centre or one
of its distributors. Contact Wavefunction for information.

** Full discussion and assessment of the specific molecular mechanics and quantum chemical
models available in Spartan’04 is provided in: W.J. Hehre, A Guide to Molecular Mechanics
and Quantum Chemical Calculations, Wavefunction, Irvine, 2003. See also: W.J. Hehre,
L. Radom, P.v.R. Schleyer and J.A. Pople, Ab Initio Molecular Orbital Theory, Wiley, New
York, 1986; J. Kong, C.A. White, A.I. Krylov, C.D. Sherrill, R.D. Adamson, T.R. Furlani,
M.S. Lee, A.M. Lee, S.R. Gwaltney, T.R. Adams, C. Ochsenfeld, A.T.B. Gilbert, G.S. Kedziora,
V.A. Rassolov, D.R. Maurice, N. Nair, Y. Shao, N.A. Besley, P.E. Maslen, J.P. Dombroski, H.
Daschel, W. Zhang, P.P. Korambath, J. Baker, E.F.C. Byrd, T. Van Voorhis, M. Oumi, S.
Hirata, C.-P. Hsu, N. Ishikawa, J. Florian, A. Warshel, B.G. Johnson, P.M.W. Gill, M. Head-
Gordon and J.A. Pople, J. Computational Chem., 21, 1532 (2000).
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The simplest computational methods in Spartan’04 are molecular
mechanics models using the SYBYL and MMFF94 force fields. These
are applicable to the determination of equilibrium geometries and
conformations of molecules comprising upwards of several thousand
atoms. Molecular mechanics models are at present the only
computational techniques which are applicable to biopolymers
including proteins. Very large molecule calculations and
conformational analysis on smaller molecules, including both
assignment of lowest-energy conformer and identification of
collections of “reasonable” low-energy conformers, are perhaps the
most important role of molecular mechanics.

Quantum chemical models are required to account for the geometries
of transition states as well as to obtain reaction energies
(thermodynamics) and activation energies (kinetics). The simplest
of these are semi-empirical molecular orbital models, which can be
routinely applied to systems with one to two hundred atoms.
Supported in Spartan’04 are the MNDO model (with “d” extensions
for second-row and heavier main-group elements), the AM1 model,
and the PM3 model with parameters for most transition metals.

Hartree-Fock molecular orbital models remain a mainstay of quantum
chemical techniques, in particular, for equilibrium and transition-state
structure determination, and for thermochemical comparisons. The
models available in Spartan’04 may be routinely applied to molecules
with fifty to one hundred atoms, that is, typical “real” organic molecules.

Hartree-Fock models are, however, not adequate for thermochemical
comparisons where bonds are broken or formed, nor do they provide
a proper account of the geometries of molecules incorporating transition
metals. So-called correlated models are required. Several classes of
correlated models are available in Spartan’04*: density functional
models, Møller-Plesset models and coupled cluster models. Density
functional models may be applied as widely as Hartree-Fock models.
On the other hand, the simplest Møller-Plesset model (MP2) is limited
to molecules comprising thirty or fewer atoms. An approximate “local

* Not available in the Essential Edition.
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MP2” model, based on localized orbitals is available in Spartan’04. It
is less “costly” than MP2 and applicable to larger systems, but is still
significantly more expensive than either Hartree-Fock or density
functional models. Higher-order (MP3 and MP4) Møller-Plesset
models and coupled cluster models are even more expensive
computationally and, therefore, much more limited in their application.
Density functional models and MP2 models may be used for
equilibrium and transition-state structure determination as well as
energy calculations. The local MP2 model and higher-order correlated
methods are available only for energy calculations.

Hartree-Fock and correlated models may be used with a variety of
all-electron Gaussian basis sets. Hartree-Fock models are often
quite successful with minimal and split-valence basis sets, while
correlated models require at the very least polarization basis sets,
and in some situations basis sets incorporating diffuse functions as
well. Pseudopotentials are available for use with both Hartree-Fock
and correlated models for calculations on molecules incorporating
heavy elements.*

G3 and G3(MP2) energy calculations are also available in Spartan’04.*

While applicable at present only to very small systems, these
“procedures”, which are in fact made up of a combination of different
models, have been shown to yield reaction energies in excellent accord
with experiment and, therefore, provide “benchmarks” against which
other calculations may be judged.

The majority of quantum chemical calculations have previously been
performed on molecules in their electronic ground state. Only very
recently have practical and reliable methods for excited-state species
become available. Spartan’04 provides “singles” configuration
interaction (CI) techniques* for energies, equilibrium and transition-
state geometries and conformations. In addition, energy calculations
(only) on excited states with the CIS (D) model as well as a range of
density functional models*, may be performed.*

* Not available in the Essential Edition.
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Spartan provides access to several common spectral quantities, in
particular infrared spectra (molecular mechanics, semi-empirical,
Hartree-Fock, density functional and MP2 models), NMR spectra*

(Hartree-Fock models) and UV/vis spectra* (CIS, CIS(D) and density
functional models). These are available both as numerical data
(vibrational frequencies, chemical shifts, etc.) as well as spectral plots
where appropriate.

Finally, Spartan’04 provides a variety of “visual tools” to assist chemists
in interpreting the results of molecular mechanics and quantum
chemical calculations. Not only do these include the usual variety of
structure models, including structure models appropriate for
biopolymers, but also molecular orbitals, electron and spin densities,
local ionization potentials and electrostatic potentials which can be
displayed as surfaces, slices and property maps and manipulated in
real time. As many quantities as desired can be displayed
simultaneously, and visual comparisons easily made among them both
for single molecules and among different molecules. “Movies” may
be made, based either on structural models alone or in combination
with any graphical models, and these in turn are used to depict
conformational change or chemical reaction.

* Not available in the Essential Edition.

Chapter 1 12/30/03, 3:20 PM7
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Section II
Getting Started

The chapters in this section provide a brief introduction to the
graphical user interface for Spartan’04 for Windows and, following
this, a series of simple tutorials. The objective of the latter is both to
provide “hands on” experience and, in doing so, illustrate the way in
which molecular mechanics and quantum chemical calculations may
be set up, performed and interpreted. This is the place to start for
“new users”. Users of previous versions of SPARTAN are also advised
to peruse this section.

No attempt has been made to illustrate all available program options.
For this, the reader should consult Section III of this guide. Focus is
on the use of Spartan’04 to calculate equilibrium and transition-state
geometries, to search conformation space, to evaluate reaction
thermochemistry and activation energetics and to obtain infrared and
NMR spectra. Also no attempt has been made to assess the
performance of the various molecular mechanics and quantum
chemical models. In fact, the majority of tutorials make use only of
molecular mechanics models and semi-empirical and Hartree-Fock
molecular orbital models, which in some cases may not lead to
“acceptable results”.* Thorough assessment of all models available
in Spartan’04 is provided in “A Guide to Molecular Mechanics and
Quantum Chemical Calculations”.

Graphical models are illustrated in several of the tutorials which
follow, and connections between specific models and chemical
observables are pointed out, for example, between electrostatic
potential maps and electrophilic character. A more complete account

* This is a deliberate decision, in that it “minimizes” the time required to complete the tutorials
and allows nearly all tutorials to be completed using only the Essential Edition of Spartan’04
(which lacks density functional, MP2 and other correlated calculations). Tutorials or sections
of tutorials which cannot be completed with the Essential Edition are indicated as such.

Section II 12/30/03, 3:42 PM9
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is provided in the aforementioned guide. Spartan’04 for Windows
provides greatly enhanced capabilities over previous versions for
display and manipulation of structure models for biopolymers, and
these too are illustrated.

Operating Spartan’04 outlines the basic workings of Spartan’04’s
graphical user interface. It should be perused before starting the
tutorials and referred back to as needed. The tutorials, which make
up the bulk of this section, are divided across five chapters: Organic
Molecules, Groups of Organic Molecules, Organic Reactions,
Biologically Interesting Molecules and Inorganic/Organometallic
Molecules. The first two of these cover a number of “basic” operations
and should be completed first, and in that order. The remaining
chapters cover more specialized topics.

Estimates for required computer time (in minutes, assuming a 2GHz
P4) are indicated at the top of the first page of each tutorial.

Where two times are provided, the second corresponds to the total
time including the optional part. No times are provided where no
actual calculations are to be performed.

5 mins

Section II 12/30/03, 3:42 PM10
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Operating Spartan’04
This chapter describes the general operating features of Spartan’04
for Windows. It should be read prior to starting the tutorial.

Starting and Quitting Spartan’04

To start, click on the Start button, then click on Programs, and finally
click on Spartan’04. To quit, select Exit from the File menu.

Pull-Down Menus

Program functions may be accessed using pull-down menus under
the headings in the menu bar, e.g., the Setup menu.

A listing of menu functions is provided in Appendix B.

Keystroke Equivalents

Keystroke equivalents for menus are designated by the underlined letter:
File, Edit, Model, Geometry, Build, Setup, Display, Search, Options
and Help. To access a menu, press the Alt key and the appropriate
letter key (case insensitive), e.g., Alt “S” to access the Setup menu.

Each menu entry is designated by an underlined letter. To access the
entry, press the appropriate letter key, e.g., press the C key to access
the Calculations dialog.

Chapter 2
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Toolbars

Toolbars provide convenient access to selected functions under the
File, Build, Geometry and Search menus.

New Break Bond Constrain Angle

Open Minimize Constrain Dihedral

Close Measure Distance Define Point

Save As Measure Angle Define Plane

View Measure Dihedral Align Molecules

Add Fragment Freeze Center Databases

Delete Set Torsions Transition States

Make Bond Constrain Distance Tautomers

If desired, one or more toolbars can be removed from view using
functions under the Options menu (see Chapter 16).

Using the Mouse

The following functions are associated with the two-button mouse.

button

keyboard left right

– picking, X/Y rotate, exchangea X/Y translate

Shift range picking, Z rotate scalingb

Ctrl global X/Y rotatec global X/Y translate

Ctrl + Shift multiple picking, global Z rotatec scalingb

Ctrl fragment X/Y rotate, chirality fragment X/Y translate
(build mode) inverta

Ctrl + Shift fragment Z rotate scalingb

(build mode)

Alt group picking, bond rotation bond stretching

a) Requires double clicking.
b) Scaling is always applied to all open molecules and all fragments.
c) Global rotations can be either molecule or screen centered. This is controlled by Global

Rotate in the Miscellaneous Preferences dialog (Preferences... under Options menu).
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Mouse/keyboard operations may be broadly separated into two
categories: selection (picking) and manipulation (translation/rotation).

Selection. The left button is used for picking of objects on screen
and/or of menu items. Left and right buttons together are used to define
a selection box for copying/cutting to the clipboard, as well as for
multiple model selection. Together with the Shift key, the left button
allows for picking over a range. Together with the Ctrl (Control)
key, the left button allows for multiple picking. Both range and multiple
picking applies not only to text items in lists, but to atoms and bonds
in molecules as well. Together with the Alt key, the left button allows
for selection of an entire group (detached molecular fragment). In
build mode, double clicking the left button leads to atom or group
exchange while double clicking on an atom with the Ctrl key
depressed leads to inversion in chirality.

Manipulation. The left button is used for rotation and the right button
is used for translation and scaling of objects on screen. With no keys
depressed, the left mouse button gives rise to rotation about the X
and Y (screen) axes; the right mouse button gives rise to translation
in the X and Y (screen) directions. Together with the Shift key, the
left mouse button gives rise to rotation about the Z direction and the
right mouse button gives rise to scaling.

The Ctrl key in conjunction with the left or right mouse buttons and
(optionally) the Shift key, signifies a change in focus away from the
default for the purpose of rotations and translations. Outside of “build
mode”, the default is focus on a single molecule (the “selected”
molecule). Use of the Ctrl key changes focus to the entire set of
molecules on screen, meaning that rotations and translations are carried
out globally. In “build mode”, the default is focus on the full set of
fragments which make up the molecule being constructed, and rotations
and translations refer to this set of fragments as a whole. Use of the
Ctrl key changes focus to a single fragment (the selected fragment),
and rotations and translations now refer only to this fragment.

Use of the Alt key in addition to the left mouse button allows for
rotation about a selected bond and, in addition to the right mouse
button, for stretching of the selected bond.
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Keyboard Functions

Additional keys control various Spartan’04 functions. These are
enumerated below:

3 Shifts into 3D (stereo). Pressing 3 again returns
to non-stereo display.

Page Up, Page Down Moves “up” (Page Up), “down” (Page Down),
Home, End to the “top” (Home) and to the “bottom” (End)

of the set of open molecules. Also, moves up
and down pages in the Output dialog.

Insert In build mode only, inserts a new fragment on
screen. This is accomplished by selecting the
fragment from the model kit, holding down the
Insert key and clicking on screen. One-time
fragment insertion can also be accomplished by
clicking on the Insert button at the bottom of
the model kit prior to clicking on screen. See
“Entry Model kit” in Chapter 12.

Delete Allows deletion of a fragment, a free valence,
reaction arrow, the contents of a selection box,
a spectrum, a curve or a plot. Deletion is
accomplished by holding down the Delete key
and clicking on the fragment, etc. No warnings
are provided. Deletion may also be invoked by
selecting Delete from the Build menu or by
clicking on the  icon, prior to clicking on the
fragment, etc.

Selecting Molecules, etc.

Two or more molecules may be simultaneously displayed in
Spartan’04’s window. However, only one molecule may be selected.
The selected molecule has access to all capabilities (molecule
building, job setup and submission and text and graphical display
and manipulation), while non-selected molecules may only be
displayed as static images. The exceptions involve scaling and the
use of the Ctrl key.
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Selection of a molecule occurs by clicking on its structure model or
on any of its associated graphical surfaces. This results in deselection
of the previously selected molecule. Molecular properties for the
selected molecule are available in the Properties dialog (Display
menu). Atom, bond and surface display properties, as well as
information about geometrical constraints may be accessed by
subsequent clicking on an atom, bond, graphical display, or constraint
marker respectively, associated with the selected molecule. Selected
atoms, bonds and constraint markers are highlighted (colored gold).
Clicking on the selected atom, bond or constraint marker resets the
display to molecular properties. Clicking on another molecule results
in display of molecular properties for that molecule. Information about
plots (including spectra) and changes to plot style and range are also
available from this dialog.

Where the molecule belongs to a list with more than a single member,
selection from among the different members in the list may be made
using either the  and  buttons or the scroll bar at the bottom left of
the screen. Alternatively, if the spreadsheet for the list is open on screen
(see Chapter 14), selection can be made by clicking on the name of
the desired molecule at the left of the spreadsheet. Clicking on  at
the bottom left of the screen “animates” the display of molecules in
the list, that is, steps through them sequentially. This is useful for
displaying a progression of graphical surfaces along a reaction
coordinate. Clicking on  (which replaces ) stops the animation.

Two or more molecules from the same list may be displayed at once
(although only one may be selected). Molecules are marked for display
by checking the box immediately to the right of the molecule name
in the spreadsheet (Chapter 14).

Dialogs

Dialogs are either “modal” (as indicated by “...” following their
reference in a menu) or “non-modal”. Modal dialogs (Open, Save
As, Append Molecule(s), Print and Print Setup from the File menu,
Find from the Edit menu, Configure from the Model menu,
Calculations from the Setup menu, Plots from the Display menu
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and About, Preferences and Fonts from the Options menu) need to
be dismissed before program operation can continue, while non-modal
dialogs may be kept open on screen. Non-modal dialogs fall into two
categories: those which reference the selected molecule (or list of
molecules) and those which reference a specific molecule (or list of
molecules). Only one copy of each of the former may be open on
screen, while several copies of the latter (each copy referring to a
different molecule or list of molecules) may be open on screen.
Properties, Surfaces and Spectra exemplify dialogs which refer to
the selected molecule, while Output and Spreadsheet exemplify
dialogs which refer to a specific molecule.

3-Dimensional Displays

Any object displayed on Spartan’04’s screen may be rendered in 3D
(stereo) using color filtration techniques. “Red/blue” glasses (supplied
with Spartan’04) must be worn. 3D is turned “on” and “off” by
toggling the “3” key, or by checking Stereo in the Miscellaneous
Preferences dialog under the Options menu (Chapter 16).

Changing Colors and Setting Preferences

Colors and Preferences... under the Options menu (Chapter 16)
allows for changing default background and graphical object colors,
and for setting (and resetting) program defaults, respectively. Further
control of color is discussed in Chapter 14.

Monitoring and Killing Jobs

Monitor under the Options menu (Chapter 16) allows for monitoring
of executing jobs as well as for killing jobs.

Iconifying Spartan’04

Spartan’04 may be iconified  by clicking  on “ ” at the top right of
the screen. A small icon appears at the bottom of the screen.

Clicking on this icon returns the user to Spartan’04.
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Chapter 3
Organic Molecules

This chapter shows how to construct organic molecules from atomic
fragments, functional groups and rings, how to carry out quantum
chemical calculations, how to calculate and draw infrared and NMR
spectra and how to interpret graphical models. It also illustrates use
of the Spartan Molecular Database of calculated structures, energies
and molecular properties as well as Spartan’04’s interface to the
Cambridge Structural Database.

The simplest building blocks incorporated into Spartan’04’s entry
model kit are “atomic fragments”. These constitute specification of
atom type, e.g., carbon, and local environment, e.g., tetrahedral.
However, much of organic chemistry is organized around functional
groups, collections of atoms the structure and properties of which
are roughly the same in every molecule. The entry model kit also
incorporates a small library of functional groups which can easily be
extended or modified. For example, the carboxylic acid group may
be modified to build a carboxylate anion (by deleting a free valence
from oxygen), or an ester (by adding tetrahedral carbon to the free
valence at oxygen).

R
C

O
H

C

carboxylic acid

R
C

O–

O

carboxylate anion

R
C

O
CH3

O

ester

Polyatomic rings are also common components in organic molecules,
and the entry model kit incorporates a library of commonly-
encountered hydrocarbon rings, which can easily be modified by atom
replacement. For example, pyridine can be built starting from benzene
by selecting aromatic nitrogen from the list of atomic fragments, and
then double clicking on one of the carbons.
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N

pyridinebenzene

select aromatic nitrogen
and double click on carbon

Functional groups may also be modified in this manner.

The tutorials in this chapter illustrate construction of organic molecules
using atomic fragments, functional groups and rings. They also
illustrate the way in which quantum chemical calculations are set up,
their results examined and interpreted, and infrared and NMR spectra
computed and displayed. A variety of graphical models are introduced
and illustrated. Finally, examples of the use of the Spartan Molecular
Database of calculated molecular structures, energies and properties
and of the Cambridge Structural Database of experimental X-ray
crystal structures are provided.
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Acrylonitrile

C C

H

H H

C

N

Acrylonitrile provides a good opportunity to illustrate the basics of
molecule building in Spartan’04, as well as the steps involved in
carrying out and analyzing a quantum chemical calculation.

1. Click with the left mouse button on File from the menu bar.

Then click on New from the menu which appears (or click on
the  icon in the File toolbar). The “entry” model kit appears.

1 min
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Among other things, it contains a library of atomic fragments.
Click on trigonal planar sp2 hybridized carbon  from the
fragment library. The atom icon is shown in reverse video to
indicate that it is “active”. In addition, a model of the fragment
appears at the top of the model kit. Bring the cursor anywhere
on screen and click. Rotate the carbon fragment (drag the
mouse while holding down the left button) so that you can
clearly see both the double free valence (“=”) and the two single
free valences (“-”).

Spartan’04’s model kits connect atomic fragments (as well as
groups, rings and ligands) through free valences. Any remaining
free valences will automatically be converted to hydrogen atoms.

2. sp2 carbon is still selected. Click on the double free valence.
The two fragments are connected by a double bond, leaving
you with ethylene. If you make a mistake and click instead on
the single free valence, select Undo from the Edit menu. You
can also start over by selecting Clear from the Edit menu.

Spartan’04’s entry model kit allows only the same type of
free valences to be connected, e.g., single to single, double to
double, etc.

3. Click on Groups in the model kit, and then select Cyano from
among the functional groups available from the menu.
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Click on any of the four single free valences on ethylene (they
are all the same). This bonds the cyano group to ethylene,
leaving you with acrylonitrile.*

4. Select Minimize from the Build menu (or click on the  icon
in the Build toolbar).

The final molecular mechanics strain energy (8.65 kcal/mol)
and symmetry point group (Cs) are provided at the bottom right
of the screen.

5. Select View from the Build menu (or click on the  icon in
the Build toolbar). The model kit disappears, leaving only a
ball-and-spoke model of acrylonitrile on screen.

  

ball-and-spoke model

This model can be manipulated (rotated, translated and
zoomed) by using the mouse (if necessary, in conjunction with
keyboard functions). To rotate the model, drag the mouse while
holding down the left button; to rotate in the plane of the screen

* You could also have built acrylonitrile without using the Groups menu. Starting from scratch
(Clear from the Edit menu), first build ethylene as above, then select sp hybridized carbon

 from the model kit and then click on one of the free valences on ethylene. Next, select sp
hybridized nitrogen  from the model kit and click on the triple free valence on the sp
carbon. Alternatively, you could have built the molecule entirely from groups. Starting from
scratch, click on Groups, select Alkene from the menu and click anywhere on screen. Then
select Cyano from the menu of functional groups and click on one of the free valences on
ethylene. In general, molecules can be constructed in more than one way.
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also hold down the Shift key. To translate the model, drag the
mouse with the right button depressed. To zoom the model
(translation perpendicular to the screen), hold down the Shift
key in addition to the right button while dragging the mouse.

6. One after the other, select Wire, then Ball and Wire, then
Tube and finally Space Filling from the Model menu.

wire model ball-and-wire model tube model space-filling model

7. Return to a tube or ball-and-spoke model. Select Configure...
from the Model menu, and check Label under “Atom” in the
Configure dialog which appears.
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Click on OK to remove the dialog. Numbers will appear next
to the individual atoms together with atomic symbols. Remove
the atom labels by selecting Labels from the Model menu.*

8. Select Measure Distance from the Geometry menu (or click
on the  icon in the Geometry toolbar).

A message will appear at the bottom left of the screen.

Click on two atoms, e.g., the two carbons involved in the double
bond. Each atom will be colored gold, and the distance between
the two will be displayed at the bottom right of the screen.

Where the two atoms are bonded, an alternative is to click on
the bond. In this case, the bond will be colored gold. Another
distance may be obtained by selecting another pair of atoms (or
another bond), and so forth.

Measure Angle and Measure Dihedral from the Geometry
menu (  and  icons from the Geometry toolbar) operate in
a similar manner. In the former case, you will need to identify
three atoms or two bonds, and in the latter case, you will need
to identify four atoms or three bonds. When you are done,
click on .

* Labels from the Model menu was automatically selected (turned “on”) following exit from
the Configure dialog with OK or Apply.
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9. Select Calculations... from the Setup menu.

Perform the following operations in the Calculations dialog
which appears.

a. Select Equilibrium Geometry from the top menu to the
right of “Calculate”. This specifies optimization of
equilibrium geometry.

b. Select Hartree-Fock and then 3-21G(*) from the two
bottom menus to the right of “Calculate”. This specifies a
Hartree-Fock calculation using the 3-21G split-valence
basis set.*

When you finish, click on OK to remove the dialog.

10. Select Submit from the Setup menu.** A file browser appears.

* 3-21G(*) indicates that the 3-21G basis set is to include polarization type functions on second-
row and heavier, main-group elements. Polarization functions are not provided for hydrogen
or first-row elements. For a discussion of basis sets supported by Spartan’04, see “A Guide
to Molecular Mechanics and Quantum Chemical Calculations”.

** You could also have clicked on Submit inside the Calculations dialog.
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Type the name “acrylonitrile_3-21G” in the box to the right of
“File name”, and then click on Save.* You will be notified that
the calculation has been submitted.

Click on OK to remove the message from the screen.
  

After a molecule has been submitted, and until the calculation
has completed, you are not permitted to modify any dialogs
or other information associated with it.

11. You will be notified when the calculation has completed.

Click on OK to remove the message from the screen. Select
Output from the Display menu.

* You can use default names (spartan1, spartan2, . . .) simply by clicking on Save.
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A window containing “text output” for the job appears.

You can scan the output from the Hartree-Fock calculation by
using the scroll bar at the right of the window. The information
at the “top” of the dialog includes the task, basis set, number
of electrons, charge and multiplicity, as well as further details
of the calculation. Below this is the symmetry point group of
the molecule that was maintained during the optimization.

Eventually, a series of lines appear, each beginning with “Cycle
no:”. These tell the history of the optimization process. Each
line provides results for a particular geometry; “Energy” gives
the energy in atomic units (1 atomic unit = 627.5 kcal/mol =
2625 kJ/mol) for this geometry, “Max Grad.” gives the
maximum Cartesian gradient, and “Max Dist.” gives the
maximum displacement of atoms between cycles. “Neg.
Eigen.” reports the number of negative eigenvalues uncovered
in the optimization procedure. This column should be blank
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(0) at the end of a geometry optimization. Ideally, the energy
will monotonically approach a minimum value for an optimized
geometry, and Max Grad. and Max Dist. will each approach
zero. If the geometry was not optimized satisfactorily an error
message, such as: “Optimization has exceeded N steps – Stop”,
will be displayed following the last optimization cycle. You
would then have been notified that the job had failed.

Near the end of the output are the final total energy
(-168.82040 atomic units for acrylonitrile with the 3-21G basis
set), and the computation time. Click on  in the top right-
hand corner of the dialog to remove the dialog from the screen.

You may examine the final total energy and the dipole moment
(among other properties) without having to go through the text
output. Select Properties from the Display menu. The
Molecule Properties dialog appears.

To see the dipole moment vector (indicating the sign and
direction of the dipole moment), check the box to the left of
Dipole. (A tube model is best for this display.)

When you are done, turn “off” display of the dipole moment
vector by unchecking the box.
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Click on an atom. The (Molecule Properties) dialog will be
replaced by the Atom Properties dialog.

Among other things, this provides three different sets of atomic
charges: “Electrostatic”, “Mulliken” and “Natural”. To obtain
the charge on another atom, simply click on it. Inspect all the
atomic charges on acrylonitrile (by clicking on the appropriate
atoms). When you are done, click on  at the top right of the
Atom Properties dialog to remove it from the screen.

12. Select Surfaces from either the Setup or Display menu.

Click on Add... (at the bottom of the dialog) to bring up the
Add Surface dialog.
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Select density from the Surface menu and potential from the
Property menu.* This requests an electrostatic potential map
(an electron density surface onto which the value of the
electrostatic potential has been mapped). Click on OK. A line
“density potential . . .” appears at the top of the dialog. (If you
make a mistake, click on this line and then click on Delete at
the bottom of the dialog.)

13. Submit the job (Submit from the Setup menu). When complete,
click on the line “density potential . . .” inside the Surfaces dialog.
The surface itself corresponds to the electron density and
provides a measure of the overall size and shape of acrylonitrile.
The colors indicate values of the electrostatic potential on this
surface; colors toward red correspond to negative potential
(stabilizing interaction between the molecule and a positive
charge), while colors toward blue correspond to positive
potential. The nitrogen (the most electronegative atom) is red
and the hydrogens (the most electropositive atoms) are blue.

14. Select Close from the File menu (or click on the  icon from
the File toolbar) to remove acrylonitrile from the screen.** Also
close any dialogs which may still be open.

* In this and other tutorials, Resolution will be set to medium. Both lower and higher resolution
images can be obtained.

** While Spartan permits as many molecules as desired on screen at a given time, it will
generally be less confusing for first-time users to handle but a single molecule.
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Cyclohexanone

O

Cyclohexanone provides the opportunity to illustrate additional
building features as well as graphical models for investigation of the
stereoselectivity of an important class of organic reactions.

1. Click on . Click on Rings and select Cyclohexane from the
menu of rings.

Click anywhere on screen and cyclohexane will appear. Select
sp2 carbon  from the model kit. Double click on any carbon
(not free valence). The sp3 hybridized center will be replaced
by an sp2 hybridized carbon.

Spartan’04’s entry model kit allows replacement of fragments,
subject both to the usual valence rules and to the availability of
free valences. For example, replacement of an sp3 carbon by an
sp2 carbon requires that at least two free valences be available.
This is possible for cyclohexane (above), but would not have
been allowed for the substituted ring carbon in methylcyclohexane

•

•

Me

•

X

Select sp2 oxygen  from the model kit. Click on the double
free valence on the sp2 carbon. You have made cyclohexanone.
Click on  to produce a final structure with Cs symmetry, and
then on  to remove the model kit.

2 mins
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2. Select Calculations... from the Setup menu. Specify
Equilibrium Geometry from the top menu to the right of
“Calculate”, and Hartree Fock and 3-21G(*) from the two
bottom menus to the right of “Calculate”. Click on OK.

3. Cyclohexanone undergoes nucleophilic attack at the carbonyl
carbon, and it is reasonable to expect that the molecule’s lowest-
unoccupied molecular orbital (the LUMO) will be localized
here. To visualize the LUMO, enter the Surfaces dialog (Setup
or Display menu). Click on Add..., and select LUMO from
the Surface menu (none from the Property menu). Click on
OK. Also request an electron density surface onto which the
(absolute) value of the LUMO has been mapped in color (a
so-called LUMO map). Click on Add..., select density from
the Surface menu and |LUMO| from the Property menu. Click
on OK. Submit the job (Submit from the Setup menu) with
the name “cyclohexanone_3-21G”.

Calculation of geometry and of graphical displays may either be
completed in one submission (as in the present example), or in
two or more submissions (as in the previous example). Spartan’04
keeps track of what has been done and will not perform
unnecessary calculations.

4. After the calculations have completed, reenter the Surfaces
dialog and click on the line “LUMO . . .”. The LUMO of
cyclohexanone appears. As expected, this is a π* orbital
primarily localized on the carbonyl group.

5. Inside the Surfaces dialog, turn “off” the display of the LUMO
by clicking on the line “LUMO . . .”. Next, click on the line
“density |LUMO| . . .” to display the electron density surface
onto which the (absolute) value of the LUMO has been mapped.
Colors toward the red indicate small (absolute) values of the
LUMO (near zero), while colors toward the blue indicate large
(absolute) values of the LUMO. Note the “blue spot” directly
over the carbonyl carbon. This corresponds to the maximum
value of the LUMO and is where nucleophilic attack will occur.
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6. You will see that the “blue spot” over the axial face of the
carbonyl carbon is “bigger” than that over the equatorial face.
This indicates preferential attack by nucleophiles onto the axial
face. Quantify the difference by measuring the (absolute) value
of the LUMO on these two faces. Bring up the (Molecule)
Properties dialog (Display menu) and click anywhere on the
LUMO map. The Surface Properties dialog appears.

Turn the map such that you can clearly see the axial face of
the carbonyl carbon, and click two times* on the area of
maximum blue. The (absolute) Value of the LUMO at the
surface point you have selected is provided in the dialog. Note
the value, and then turn the map over such that you can now
see the equatorial face of the carbonyl carbon, and click on
the point of maximum blue on this face. Do these values support
your qualitative conclusions from viewing the image?

7. Remove cyclohexanone and any remaining dialogs from the
screen.

* All controls in the Properties dialogs operate in a “toggle” manner. Thus, the first click on
the surface “toggles” to the previous (molecule) mode and the second click back to the
surface mode.
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Camphor

O

CH3H3C

H3C

Camphor illustrates how one molecule may be used as the starting
point for another. It also illustrates a search on the Cambridge Structural
Database (CSD).* No calculations are involved in this example.

1. Bring “cyclohexanone_3-21G” (previous example) back onto
the screen. Select Open... from the File menu (or click on the

 icon from the File toolbar) and double click on
“cyclohexanone_3-21G” in the dialog which results. Next select
Save As... from the File menu (or click on the  icon from the
File toolbar), supply the name “camphor” and click on Save.

2. Select Add Fragment from the Build menu (or click on the
 icon from the Build toolbar) to bring up the entry model

kit. Click on sp3 carbon  from the model kit and then click
on the axial free valence two positions removed from the
carbonyl carbon. You have made axial 3-methylcyclohexanone.

3. Select Make Bond from the Build menu (or click on the 
icon from the Build toolbar). Click on one of the free valences
of the sp3 carbon which you have just added and then on the
equatorial free valence on the opposite side of the six-
membered ring (adjacent to the carbonyl group). A bond will
be drawn. Click on  to produce a refined (intermediate)
structure. Finish the structure by adding three methyl groups
(click on  from the model kit and, one after the other, click
on the three appropriate free valences). Finally, click on  to
give a minimized camphor geometry with C1 symmetry. Click
on  to remove the model kit.

* In order to complete this tutorial, CSD will need to be licensed and installed. For information
about a trial subscription, contact Wavefunction. For installation instructions, see Appendix G.
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4. Select Configure... from the Model menu. Check R/S under
“Atom” in the dialog which results, and click on OK. R/S labels
now appear (only) on the two bridgehead carbons. Both should
be R (or both S), depending on which enantiomer you have
built. You can if you wish turn “off” the labels by selecting
Labels from the Model menu.

5. Move the molecule to the far right of the screen. Then, select
Databases from the Search menu (or click on the  icon from
the Search toolbar).

Click on the CSD tab at the top of the Databases dialog which
results. This brings up the CSD dialog.

Click on one of the free valences on the “methyl group” which
you added to the bridgehead carbon adjacent to the carbonyl
group. The free valence is replaced by an orange cone. This
signifies that the search is to be restricted to molecules which
derive from substitution of camphor at this carbon.
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6. Click on the Search button at the bottom of the dialog. “Hits”
will appear in the text box at the right of the CSD dialog.

7. Wait for the search to complete, or terminate it at any time by
clicking on  to the right of the Search button. Hits for which
structural data are available are indicated by filled yellow
circles.* Click on any one of these. Its name will be highlighted
and a structure model will appear in the window at the top of
the dialog. This model can be manipulated in the usual way.**

(You need to position the cursor inside the window.)

8. When you are done, remove the CSD dialog (click on  at the
top right) and close “camphor.”

* Unfilled circles correspond to “hits” for which structural data are unavailable.
** One (or more) structures may be transfered to Spartan’s file system using the Retreive

button. Full discussion is provided in Chapter 15.
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Ethinamate

O

O

NH2

Acrylonitrile, cyclohexanone and camphor are examples of molecules
which can adopt only a single conformation. Much more common
are molecules which can adopt more than one conformation, usually
due to rotation about single bonds or puckering of rings. The sedative
ethinamate is not atypical, and presents an interesting question of
whether the alkyne or the carbamate occupies the “favored” equatorial
position on the six-membered ring.

This tutorial, as well as the one immediately following, illustrate the
simplest approach to dealing with conformationally-flexible
molecules, that is, finding the lowest-energy conformer (the global
minimum). Tutorials in later chapters address the more difficult
problem of identifying “all reasonable” low-energy conformers. The
present exercise is restricted to use of MMFF molecular mechanics.

1. Bring up the entry model kit ( ). Click on Rings, select
Cyclohexane from the menu and click anywhere on screen.
Click on sp3 oxygen ( ) in the model kit and add to either an
equatorial or axial free valence on cyclohexane. Click on
Groups and select Amide from the menu. Make certain that
free valence on the amide group to be used for bonding is
associated with carbon and not with nitrogen. This is indicated
by a “dot” on the icon at the top of the model kit.

C N

O

•

You can move the bonding position by repeatedly clicking on
the icon. When you are satisfied, add the amide to oxygen to
make the carbamate functionality. Finally, select Alkyne from
the Groups menu and add to the same carbon on the
cyclohexane ring as occupied by the carbamate group (using

1 min
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the remaining axial or equatorial free valence). Click on 
and then on  to remove the model kit.

2. Bring up the Calculations dialog (Setup menu). Select
Equilibrium Conformer from the top menu to the right of
“Calculate” and Molecular Mechanics and MMFF from the
two bottom menus. You have requested that Spartan’04
examine “all possible” conformers*, but then select only the
most stable conformer (according to the MMFF model). Click
on Submit at the bottom of the dialog. Name the molecule
“ethinamate_MMFF”.

3. When completed, the “preferred” conformer will replace the
initial conformer (just like a calculated equilibrium geometry
replaces a starting geometry). Which group, alkyne or
carbonate, occupies the equatorial position?

4. Note that the name “ethanimate” appears at the bottom of the
screen. This indicates that it is already available in the Spartan
Molecular Database (SMD) of molecular structures and
properties. Click on  immediately to the left of the name.
This brings up the SMD Preview dialog.

Listed at the right are theoretical models for which ethanimate
is available, while a ball-and-spoke model of the selected SMD
entry is displayed at the left. It can be manipulated using the
mouse. Is the conformation of ethanimate in the database entries
the same as you have found?

5. Close “ethinamate” as well as any open dialogs.

* This system is small, and the possible conformers will be systematically examined. This
will not be practical for molecules with a large number of degrees of conformational freedom.
Here Monte-Carlo methods need to be employed.
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3-Cyano-4-methylcyclohexenyl Radical

C N

CH3

This tutorial illustrates how different models may be combined to
achieve a desired result with minimum “cost”, both human and
machine. MMFF molecular mechanics will be employed to establish
equilibrium conformation, the semi-empirical AM1 model to establish
equilibrium geometry and the Hartree-Fock 3-21G model to provide
a basis for graphical calculations.

1. Build 3-cyano-4-methylcyclohexene. Start with Cyclohexane
from the Rings menu, click on , and then click on axial free
valences on any two adjacent carbons. Add Cyano from the
Groups menu to one of the equatorial free valences on a carbon
adjacent to the double bond. Finally, add a “methyl group”
(  from the model kit) to the appropriate ring position using
either the equatorial or axial free valence.

2. Select Delete from the Build menu (or click on the  icon
from the Build toolbar), and click on the (axial) free valence
on the carbon to which the cyano group is attached. Click on

 to produce a refined geometry with C1 symmetry. Click on
 to remove the model kit.

3. Select Calculations... (Setup menu). Specify Single Point
Energy from the top menu to the right of “Calculate” and
Hartree-Fock and 3-21G(*) from the two bottom menus. Next,
specify MMFF Conformer from the menu to the right of “Start
from”, and AM1 from the menu which then appears to the
right. You have requested that a Hartree-Fock energy is to be
based on an AM1 geometry, which in turn is to be based on the
best conformation according to MMFF.

This molecule has one unpaired electron. It is necessary to
change Multiplicity from Singlet to Doublet. Click on OK.

5 mins
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4. Select Surfaces (Setup or Display menu). Click on Add....
Select spin from Surface menu and none from the Property
menu, and click on OK. Again, click on Add..., and this time
select density from the Surface menu and spin from the
Property menu. Click on OK. You have requested two different
representations of spin distribution. The first presents spin
density as a surface of constant value, while the second color
maps the value of the spin density onto an electron density
surface. Also, request the singly-occupied molecular orbital
(SOMO). Click on Add.... Select SOMO from the Surface
menu (none from the Property menu) and click on OK.

5. Submit the job. Name it “3-cyano-4-methylcyclohexenyl
radical_3-21G” When completed, examine the conformation.
Is the methyl group equatorial or axial? Next, enter the
Surfaces dialog. Display the spin density surface by clicking
on the line “spin . . .”. Note that the spin density is delocalized
over two of the ring carbons and onto the cyano group.

6. Again enter the Surfaces dialog. First, remove the spin density
surface by clicking on the line “spin . . .”. Then, display the
spin density map. Click on the line “density spin . . .”. Note
that the areas of maximum spin (colored blue) exactly match
those where the surface is large in the previous image.

Select Properties (Display menu) and click anywhere on the
spin density map. This brings up the Surface Properties dialog.
Range provides the range of spin density values. Note, in
particular, that negative values of the spin density are possible.
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7. Enter the Surfaces dialog, and turn “off” display of the spin
density map (click on the line “density spin . . .”). Then turn
“on” display of the SOMO (click on the line “SOMO . . .”).
Note that the singly-occupied molecular orbital is nearly
identical to the previously-displayed image of the spin.

8. Turn “off” display of the SOMO by clicking on the line “SOMO
. . .” in the Surfaces dialog. Next, click on Add... at the bottom
of the (Surfaces) dialog, and select Slice from the Surfaces
menu and spin from the Properties menu. Click on OK. A
new line “Slice spin . . .” appears in the window at the top of
the dialog.* Click on it.

9. A plane (a “slice” of spin density) surrounded by a frame
appears in the middle of the model on screen. Click on the
frame (or inside of it) to select. It will now be surrounded by a
gold frame. Position the cursor outside the frame, then press
both the Shift key and right button and move the mouse up
and down. This will “zoom” the plane. You can also translate
and rotate the plane independently of the molecule using the
usual mouse operations. Alternatively, you can move the
molecule and plane together by first clicking on the molecule
(the frame will now turn white) and then using the mouse. For
all operations, be certain to keep the cursor positioned outside
of the frame. Size and orient the slice as you wish.**

10. Remove “3-cyano-4-methylcyclohexenyl radical” and any
remaining dialogs from the screen.

* No further calculations are involved as this is just another way of representing the spin density.
** You can change the display style from Contours to Solid or Transparent using the Style

menu at the bottom right of the screen. This will appear only when the slice is selected.
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 5 mins

Infrared Spectrum of Benzyne

Benzyne has long been implicated as an intermediate in nucleophilic
aromatic substitution, e.g.

–H2O
–Cl–

Cl

OH– OH–

–H2O

benzyne

OH

While the geometry of benzyne has yet to be conclusively established,
the results of a 13C labeling experiment leave little doubt that two
(adjacent) positions on the ring are equivalent.

Cl

*
KNH2

NH3

*

NH2

*

NH2

*
+

1 : 1

*  =  13C

There is a report, albeit controversial, that benzyne has been trapped
in a low-temperature matrix and its infrared spectrum recorded.
Furthermore, a line in the spectrum at 2085 cm-1 has been assigned to
the stretching mode of the incorporated "triple bond".

Here you will calculate the structure of benzyne using the Hartree-
Fock 3-21G model and, following this, obtain an infrared spectrum for
the molecule. Comparison with the experimental spectrum (specifically
the line at 2085 cm-1 attributed to the C≡C stretch) should allow you to
comment one way or another about the controversial report.

1. Bring up the entry model kit, select Benzene from the Rings
menu and click anywhere on screen. Click on  and click on
two adjacent free valences on benzene. (Alternatively, hold
down the Delete key while you click on the two free valences.)
Click on  and then on .

2. Enter the Calculations dialog (from the Setup menu). Select
Equilibrium Geometry from the top menu to the right of
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“Calculate” and Hartree-Fock and 3-21G(*) from the
two bottom menus. Check IR to the right of “Compute” in the
center of the dialog. You have requested that an infrared
spectrum be computed following optimization of geometry.
Click on Submit and provide the name “benzyne_3-21G”.

3. While you are waiting for the calculation to complete, build
2-butyne, optimize its geometry with the same Hartree-Fock
model and compute its infrared spectrum. Name the molecule
“2-butyne_3-21G”. 2-butyne will serve as a “standard” with
which to adjust the infrared spectrum of the benzyne.

4. When both calculations have completed, examine the geometry
of benzyne. Does it incorporate a “real” triple bond? Compare
the length with that in 2-butyne.

You should have two molecules on screen, benzyne and
2-butyne. Go between them by clicking on them in turn. All
manipulations (except scaling) pertain only to the selected
molecule as do all dialog operations.

5. Select (click on) benzyne and then select Spectra from the
Display menu. Click on the IR tab in the dialog which results
to bring up the IR Spectra dialog.

One after the other, check the yellow boxes to the left of the
frequencies in the dialog. In response, the vibrational motion
associated with this frequency will be animated. Find the

Chapter 3.2 12/30/03, 4:00 PM42



43

frequency which best fits the description of a C≡C stretch, and
record its value. Do not close the IR Spectra dialog.

6. Select 2-butyne and find and record the frequency
corresponding to the C≡C stretch. It should be on the order of
12% larger than the experimental frequency (2240 cm-1) at this
level of calculation.* Compute a “scaling factor” based on the
ratio of measured to calculated frequencies, and apply this to
the calculated frequency in benzyne. Is your (scaled) frequency
in reasonable accord with the reported experimental value of
2085cm-1?

7. Again, select benzyne and click on Draw IR Spectrum inside
the IR Spectra dialog.

The resulting spectrum is like any other graphical object in
that it can be translated and zoomed using the usual mouse
commands. (It cannot be rotated.) You need to click on the
spectrum to select it. Locate the line corresponding to the C≡C
stretch in the spectrum. Having done so, can you further
comment one way or the other about the validity of the
experimental result?

8. Close both molecules on screen together with any open dialogs.

* Rationalization of this behavior together with performance statistics for a number of
theoretical models available in Spartan’04 is found in “A Guide to Molecular Mechanics
and Quantum Chemical Calculations”.
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13C NMR of cis-1,2-Dimethylcyclohexane
(cannot be completed with the Essential Edition)

At normal temperatures, the NMR spectrum of a conformationally-
flexible molecule represents a (Boltzmann-weighted) average of
the NMR spectra of all accessible conformers. Only when the
temperature is lowered will the spectrum reveal its components, and
its “complexity”. A particularly simple example is cis-1,2-
dimethylcyclohexane, where there are only two “equivalent”
conformers.

Me

Me Me

Me

4

1
23

5
6

Me

Me

The room temperature 13C spectrum contains only four lines at 34.9,
31.9, 24.2 and 16.4 ppm relative to TMS, corresponding to an equal
weighting of C1 and C2, C3 and C6, and C4 and C5 and the two methyl
carbons, respectively. Only when the sample is cooled sufficiently
does the spectrum reveal eight distinct lines.

Here, you will calculate the (static) 13C NMR spectrum of cis-1,2-
dimethylcyclohexane, and then average chemical shifts for the three
pairs of “equivalent” ring carbons to yield the observed (room
temperature) spectrum. You will use the carbon shifts in cyclohexane
as a “standard” (instead of TMS). Optionally, you will obtain a 13C
spectrum for cis-decalin to see to what extent it serves a model for
“static” cis-1,2-dimethylcyclohexane. The Hartree-Fock 6-31G*
model will be employed.

1. Build and minimize cis-1,2-dimethylcyclohexane. Inside the
Calculations dialog, specify calculation of equilibrium
geometry using the Hartree-Fock 6-31G* model. Check NMR
to the right of “Compute”, and submit the job. Name it “cis-
1,2-dimethylcyclohexane_6-31Gs”.

2. Perform the same calculation (6-31G* equilibrium geometry
and NMR spectrum) on cyclohexane (name it “cyclohexane_

15 mins/45 mins
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6-31Gs”. This will be used (in place of TMS) as the reference
compound for the ring carbons in dimethylcyclohexane.

3. After the calculations have completed (several minutes),
record chemical shifts for all ring carbons in cis-1,2-
dimethylcyclohexane, either from the Atom Properties dialog
(select Properties from the Display menu and click on a
carbon) or by labeling the model (select Configure... from the
Model menu and check Chem Shift under “Atom” in the dialog
which results). In the latter case, you may want to remove the
hydrogens (select Hydrogens from the Model menu) to
simplify the display. Also, obtain the 13C shift in cyclohexane
and compute a “correction factor” based on its difference to
the measured shift (27.6 ppm) to be added to the cis-1,2-
dimethylcyclohexane shifts. Finally, average the calculated
chemical shifts to obtain a room temperature 13C spectrum.
How do the averaged 13C shifts compare with measured values?

4 to 6 optional

4. cis-Decalin is a reasonable model for “static” cis-1,2-
dimethylcyclohexane, in that it is unable to undergo (rapid)
ring inversion.

Build cis-decalin. Instead of calculating its equilibrium
geometry, get it from the Spartan Molecular Database (SMD).
Click on  to the right of the name (cis-decalin) at the bottom
of the screen to bring up the SMD Preview dialog. Check
6-31G* and click on the Replace button at the bottom of the
dialog. The SMD entry will replace the structure you built.
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5. Enter the Calculations dialog. It should be set up for a single-
point-energy calculation using the Hartree-Fock 6-31G* model.
Check NMR to the right of “Compute” and click on Submit.

6. The calculation will require several minutes. When completed,
select Spectra from the Display menu and click on the NMR
tab. Click on Draw 13C Spectrum.

Because of the (C2) symmetry of cis-decalin, your spectrum
will contain only five lines, all of equal intensity. Relate these
to the six lines corresponding to the ring carbons in “static”
cis-1,2-dimethylcyclohexane. Pay particular attention to the
differences in chemical shifts between carbons which average
in the equilibrating molecule. Is cis-decalin a good model?

7. Close all molecules and any open dialogs.
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Chapter 4
Groups of Organic Molecules

This chapter introduces and illustrates a number of basic operations
involved in processing groups of molecules, as well as the associated
spreadsheet for organizing and fitting data and facilities for making
plots.

Computational investigations like experimental investigations are
rarely restricted to single molecules, but rather may involve a series
of related molecules. Here, it may be of interest to compare
geometries, energies or other calculated properties, or to compare
trends in calculated and measured properties. Spartan’04 provides
facilities for these purposes. In particular, it allows molecules to be
grouped, either “manually”, or automatically as a result of a
conformational search, from following a particular vibrational motion,
or from a “scan” of one or more geometrical variables. Once put into
a group, molecules may be aligned based on their structures.
Calculations may be performed either on individual molecules or,
just as simply, on the complete group of molecules.

Associated with a group (including a group of one molecule) is a
spreadsheet. This allows convenient access to virtually any calculated
quantity. Additionally, data may be entered manually into the
spreadsheet. Data in the spreadsheet may be manipulated, linear
regression analyses performed and both 2D and 3D plots constructed.

The tutorials in this chapter introduce a number of the basic group
operations available in Spartan’04. These include building a group
“from scratch”, and processing groups resulting from a conformational
search and from varying a torsion angle. Also provided is a simple
example of fitting an experimental observable to one or more
calculated properties by way of linear regression.
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Dienophiles in Diels-Alder Cycloadditions

The most common Diels-Alder reactions involve electron-rich dienes
and electron-deficient dienophiles.

X

Y

X = R, OR

Y = CN, CHO, CO2H

X

Y

+

The rate of these reactions generally increases with increasing
π-donor ability of the diene substituent, and with increasing
π−acceptor ability of the dienophile substituent. This can be
rationalized by noting that donor groups raise the energy of the
highest-occupied molecular orbital (HOMO) on the diene, while
acceptor groups lower the energy of the lowest-unoccupied molecular
orbital (LUMO) on the dienophile. Thus, the HOMO-LUMO gap is
reduced, leading to enhanced stabilization.

HOMO

LUMO

Orbital 
Energy

diene dienophile

better acceptor groups

better donor groups

To test such an hypothesis, you will examine the extent to which
experimental relative rates of Diels-Alder cycloadditions involving
cyclopentadiene and a variety of cyanoethylenes correlate with
dienophile LUMO energies.

1. Bring acrylonitrile which you previously constructed onto the
screen. Select Open... from the File menu (or click on ),
and double click on “acrylonitrile_3-21G” in the file browser
which results.* Place acrylonitrile onto the clipboard, by first
drawing a “selection box”. Position the cursor slightly above
and slightly to the left of the molecule then, while holding

49

2 mins

* Make certain that the electrostatic potential map is not displayed. If it is, enter the Surfaces
dialog (Display menu) and click on the line “density potential ...” to turn it off.
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down on both left and right buttons, drag the mouse to a
position slightly below and slightly to the right of the molecule.
Finally, release both buttons. Acrylonitrile will be surrounded
by “dotted lines” (a “selection box”).

Select Copy from the Edit menu. Close acrylonitrile ( ).

2 Enter the builder ( ). Click on Clipboard at the bottom of
the model kit. Spartan’s clipboard will be accessed and the
structure of acrylonitrile will appear in a box at the top of the
model kit. (You can manipulate this structure by positioning
the cursor inside the box and using the usual mouse/keyboard
commands.) Click anywhere on screen and acrylonitrile (the
contents of the clipboard) will be drawn. Click on  to produce
a refined structure. Do not leave the builder.

3. Select New Molecule from the File menu. This requests that a
“new molecule” (one which has yet to be built) is to be
appended onto the end of a group in which the currently selected
molecule (acrylonitrile) is a member. The screen will be cleared.
Click on Clipboard at the bottom of the model kit and click
on screen. Acrylonitrile will appear. Click on Groups in the
model kit, select Cyano and add to the appropriate free valence
on acrylonitrile to make 1,1-dicyanoethylene. Click on .

4. Repeat this procedure (New Molecule, followed by Clipboard,
followed by Groups, followed by ) four more times to build
cis and trans-1,2-dicyanoethylene, tricyanoethylene and
tetracyanoethylene. When you are all done (six molecules in
total), click on  to remove the model kit.
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5. The molecules have been put into a single group, allowing
calculated properties to be accessed via a spreadsheet. Select
Spreadsheet from the Display menu.

To select individual molecules, click on their labels (“M001”,
. . .) in the left hand column, or use the  and  keys at the
bottom left of the screen. You may change the default names
(to “acrylonitrile”, . . .) by directly typing in new names. Press
the Enter key following each entry.

6. Enter the Calculations dialog (Setup menu), and specify a
single-point energy using the Hartree-Fock 3-21G model. Select
AM1 from the menu to the right of “Start from”. This indicates
that the 3-21G energy calculation is to be preceded by calculation
of geometry using the AM1 model. Make certain that Global
Calculations is checked to ensure that calculations are to be
applied to all group members (and not just the selected member).

7. Submit the job. Name it “Diels-Alder dienophiles_3-21G”.
While you are waiting for it to complete, enter the experimental
relative rates from the table below into the spreadsheet.

Experimental relative rates for
Diels-Alder cycloadditions of cyclopentadiene*

log10 log10

dienophile (relative rate) dienophile (relative rate)

acrylonitrile 0 1,1-dicyanoethylene 4.64
trans-1,2-dicyanoethylene 1.89 tricyanoethylene 5.66
cis-1,2-dicyanoethylene 1.94 tetracyanoethylene 7.61

*  J. Sauer, H. Weist and A. Mielert, Chem. Ber., 97, 3183 (1964).
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First, type a title “Log(rate)=” into the header cell at the top of
a “blank” column in the spreadsheet and press the Enter key.
Then enter the rate data in the appropriate cells. Press the Enter
key after each entry. Sort the group according to relative rate.
Click on the column header “Log(rate)”, and then click on Sort
at the bottom of the spreadsheet.

8. After all calculations are complete, click on a header cell at
the top of a blank column. Then, click on Add... at the bottom
of the spreadsheet. Alternatively, hold down the right mouse
button while the cursor is positioned inside the spreadsheet,
and select Add... from the menu which results.

Select E LUMO from the list in the dialog which results and
kcal/mol from the Energy menu. Click on OK.
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The spreadsheet has now served its purpose by collecting both
calculated (LUMO energy) and experimental (relative rate)
data for all six dienophiles. You can, if you wish, now remove
it from the screen (click on  at the top right).

9. Select Plots... from the Display menu. This leads to the Plots
dialog.

Make certain that the “XY Plot” tab at the top of the dialog is
selected. Select Log(rate) from the list of items in the X Axis
menu and E LUMO(eV) from the Y Axes list. Click on OK to
remove the dialog and show the plot.

The default curve, a so-called cubic spline, smoothly connects
the data points, but is of little value in establishing a correlation.
A better representation is provided by a simple linear least-
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squares fit. Select Properties from the Display menu and click
anywhere on the “curve” which you have just drawn. The
Curve Properties dialog appears.

Select Linear LSQ from the Fit menu. A new plot appears.

Is there a correlation between relative rates and LUMO energy?

10. Remove all molecules and any remaining dialogs from the
screen.
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Allyl Vinyl Ether

O

Allyl vinyl ether undergoes Claisen rearrangement, the mechanism
for which demands a chair arrangement of the reactant.

O O

O

‡

Is this the lowest-energy conformer (global minimum) or is additional
energy required to properly orient the molecule for reaction? To find
out, you need to locate all the conformers of allyl vinyl ether, identify
the best chair structure and evaluate its energy relative to that of the
actual global minimum. You will first carry out a conformational
search using the MMFF molecular mechanics model, and then obtain
relative conformer energies using single-point 6-31G* Hartree-Fock
calculations based on AM1 equilibrium geometries.

1. Bring up the entry model kit and construct allyl vinyl ether (in
any conformation) from a sequence of sp2 and sp3 carbons and
an sp3 oxygen. Click on  to produce a refined geometry.
Click on .

2. Bring up the Calculations dialog and select Conformer
Distribution from the top menu to the right of “Calculate”
and Molecular Mechanics and MMFF from the two bottom
menus. Click on OK.

3. Submit the job. Name it “allyl vinyl ether_MMFF”. When
completed, it will give rise to a series of low-energy
conformers* placed in a new file “allyl vinyl ether_
MMFF.Conformer1”. Open this file.** Select Spreadsheet from
the Display menu.

* By default, only conformers within 10 kcal/mol of the global minimum will be kept. This
can be changed (see Conformational Search in Appendix C).

** To avoid confusion, it is a good idea to close the original file “allyl vinyl ether_MMFF”.

5 mins
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Size the spreadsheet such that all rows (corresponding to
different conformers) are visible at one time. Click on Add...
at the bottom of the spreadsheet. Select E from the list at the
top of the dialog which appears, kcal/mol from the Energy
menu and click on OK. Energies for each of the different
conformers will be added to the spreadsheet. Examine the
lowest-energy conformer (the top entry). Is it in a “chair
conformation” suitable for Claisen rearrangement? If not,
identify the lowest-energy conformer which is suitable. You
can keep two or more conformers on screen at the same time
by checking the boxes immediately to the right of “Label” (the
leftmost column) in the spreadsheet. To get a clearer idea of
structural similarities and differences, align the conformers.
Select Align Molecules from the Geometry (or click on the

 icon in the Geometry toolbar). A message will appear at
the bottom left of the screen.

Click on three (or more) atoms to designate them as alignment
centers. Each will be marked by a red circle. If you make a
mistake, click again (two times) and the circle will disappear.
When you are done, press the Align button at the bottom right
of the screen. Click on .

4. To obtain a better estimate of conformational energy
differences, perform 6-31G* single-point energy calculations
using AM1 geometries. Make a copy of “allyl vinyl ether_
MMFF.Conformer1” ( ), and name it “allyl vinyl ether_
6-31Gs”. Using the copy, delete all conformers except the
global minimum and the lowest-energy conformer poised for
Claisen rearrangement. Select each conformer to be discarded,
and then select Delete Molecule from the File menu.
Alternatively, click on the cell in the spreadsheet containing
the “label” for the molecule to be deleted, and then click on
Delete at the bottom of the spreadsheet. When you are done,
the spreadsheet should contain only two entries.
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5. Enter the Calculations dialog, and specify calculation of a
single-point energy using the Hartree-Fock 6-31G* model.
Also, specify AM1 from the menu to the right of “Start from”.
Check Global Calculations at the bottom of the dialog to
specify that the dialog settings apply to both conformers.

6. Submit the job. When completed, examine the conformer
energies. How much energy is needed to go from the global
minimum to a conformer poised to undergo Claisen
rearrangement?

7. Remove all molecules and any remaining dialogs from the
screen.
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Internal Rotation in Dimethylperoxide

OO

CH3

CH3

Quantum chemical calculations, in particular, Hartree-Fock molecular
orbital calculations and density functional calculations, may be called
on to furnish data to parameterize empirical energy functions for use
in molecular mechanics and/or molecular dynamics calculations. Most
important are data relating to torsional motions, for these are the most
difficult to obtain experimentally. Here, the empirical energy function
needs to reflect the inherent periodicity. As an example, consider
rotation about the oxygen-oxygen bond in a molecule such as
dimethylperoxide. This may be described by a truncated Fourier series.

Etorsion (ω)  =  ktorsion1 (1 - cos(ω - ωeq))  + ktorsion2 (1 - cos2(ω - ωeq)) 

+  ktorsion3 (1 - cos3(ω - ωeq))

Here, ωeq is the ideal dihedral angle and ktorsion1, ktorsion2 and ktorsion3 are
parameters. The first (one-fold) term accounts for the difference in
energy between syn and anti conformers, the second (two-fold) term
for the difference in energy between planar and perpendicular
conformers, and the third (three-fold) term for the difference in energy
between eclipsed and staggered conformers.

In this tutorial, you will generate a potential energy function for
rotation in dimethylperoxide using 6-31G* Hartree-Fock calculations
(and optionally from B3LYP/6-31G* density functional calculations)
and then fit this potential to a truncated Fourier series.

1. Using the entry model kit, construct dimethylperoxide. If the
molecule is not already in an anti conformation, click on  and
set the COOC dihedral angle to 180 (180°). Do not minimize.

2. Select Constrain Dihedral from the Geometry menu (or click
on the  icon from the Geometry toolbar). Select the COOC
torsion, and then click on  at the bottom right of the screen.
The icon will change to  indicating that a dihedral constraint
is to be applied. Select Properties (Display menu) and click

30 mins/40 mins
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on the constraint marker on the model on screen. This leads to
the Constraint Properties dialog.

3. Check Dynamic inside the dialog. This leads to an extended
form of the Constraint Properties dialog which allows the
single (dihedral angle) constraint value to be replaced by a
sequence of constraint values.

Leave “180” (180°) in the box to the right of Value, but change
the contents of the box to the right of to to “0” (0°). You need
to press the Enter key after you type in the value. Steps should
be set to “10”. (If it does not, type “10” and press the Enter
key.) What you have specified is that the dihedral angle will
be constrained first to 180°, then to 160°*, etc. and finally to
0°. Click on  to dismiss the dialog.

4. Bring up the Calculations dialog and select Energy Profile
from the top menu to the right of “Calculate”, and Hartree-
Fock and 6-31G* from the two bottom menus. Click on OK
and submit the job. Name it “dimethylperoxide_6-31Gs”.

* The difference between constraint values is given by: (final-initial)/(steps-1).
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5. When the calculations have completed, they will go into a file
named “dimethylperoxide_6-31Gs.Profile1”. Open this file.
Align the conformers. Click on  and, one after the other,
click on both oxygens and one of the carbons. Then click on
the Align button at the bottom right of the screen. Bring up the
spreadsheet (Display menu), and enter both the energies
relative to the 180° conformer, and the COOC dihedral angles.
First click on the label (“M001”) for the top entry in the
spreadsheet (the 180° conformer), then click on the header cell
for the leftmost blank column, and finally, click on Add... at
the bottom of the spreadsheet. Select rel. E from among the
selections in the dialog which results, kJ/mol from the Energy
menu and click on OK. To enter the dihedral angle constraints,
click on , click on the constraint marker attached to
dimethylperoxide and click on  at the bottom of the screen
(to the right of the value of the dihedral angle). Click on .

6. Select Plots... (Display menu). Select Constraint(Con1) from
the X Axis menu and rel. E(kJ/mol) from the Y Axes list.
Click on OK.

The curve (a so-called cubic spline) smoothly connects the
data points. To fit the points to a Fourier series, bring up the
Properties dialog (Display menu) and click anywhere on the
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plot. Select Fourier LSQ from the Fit menu and click on  to
remove the dialog. A new plot appears.

The actual fit expression appears at the bottom of the plot.

7 and 8 optional (cannot be completed with the Essential Edition)

7. Use energies from B3LYP/6-31G* density functional
calculations, together with the Hartree-Fock geometries
to provide a better “fitting function”. First, make a copy
of “dimethylperoxide_6-31Gs.Profile1”. Name it
“dimethylperoxide_B3LYP_6-31Gs”. Next, enter the
Calculations dialog and specify calculation of single-point
energies using the B3LYP/6-31G* density functional model.
Make certain that Global Calculations (at the bottom of the
dialog) is checked to signify that energy calculations are to be
performed on all conformers.

8. Submit the job. It will require several minutes to complete.
When it is done, draw a new energy plot and compare it to the
energy plot produced earlier.

9. Remove all molecules and any remaining dialogs from the
screen.
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Hydration of Carbonyl Compounds

The hydration of carbonyl compounds has been extensively studied
primarily because it serves as a model for a number of important
reactions, nucleophilic addition to carbonyl compounds among them.

O

R

R‘
H2O

-H2O
R

R‘
OH

OH
Keq  =

[hydrate]

[H2O] [carbonyl]
=

[hydrate]

55.5 [carbonyl]

Experimental Keq for hydration of carbonyl compounds*

log(keq/55.5) log(keq/55.5)

PhCOCH3 -6.8 CF3COCH3 -0.2
CH3COCH3 -4.6 PhCOCF3 0.1
PhCHO -3.8 H2CO 1.6
t-BuCHO -2.4 CF3CHO 2.7
CH3CHO -1.7 CF3COCF3 4.3

* J.P. Guthrie, Can. J. Chem., 53, 898 (1975); 56, 962 (1978).

In this tutorial, you will correlate calculated properties with measured
equilibrium constants for carbonyl hydration. The purpose is to
illustrate the use of Spartan’s linear regression analysis tool.

1. Build the compounds* listed above. Use Carbonyl (Rings
menu) as a starting point for each to ensure consistent atom
numbering. Put all in the same list; select New Molecule
following construction of each molecule, i.e., build and
minimize acetophenone, select, New Molecule, build and
minimize acetone, select New Molecule, etc. Click on .

2. Enter the Calculations dialog and specify calculation of
equilibrium geometry using the Hartree-Fock 3-21G model.**

* Keep the phenyl ring and the carbonyl group coplanar for benzaldehyde, acetophenone and
trifluoroacetophenone.

* * You can save computer time by specifying calculation of single-point energy using the
Hartree-Fock 3-21G model, and then selecting AM1 from the menu to the right of “Start
from”. This requests a semi-empirical AM1 geometry in place of the 3-21G geometry. As
all of these molecules are in SMD, you can save even more time by bringing up the SMD
Preview dialog (click on  at the bottom right of the screen), clicking on the yellow square
to the left of 3-21G and then clicking on Replace All at the bottom of the dialog. In this
case, skip the calculation step as all the results you require are already available.

30 mins
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Make certain that Global Calculations is checked. Click on
Submit. Name the job “carbonyl compounds_3-21G”.

3. While you are waiting for the calculations to complete, bring
up the spreadsheet. Click inside the header cell of an empty
column, type “Log(Keq)” and press the Enter key. Then enter
the experimental equilibrium constants (see box on the previous
page) into the appropriate cells. You need to press the Enter
key following each data entry. Sort the list according to the
value of Log(Keq). Click inside the header cell “LogKeq” and
then click on Sort at the bottom of the spreadsheet. If you like,
replace the “labels” in the spreadsheet (“M001”, ...) by correct
names (“acetophenone”, ... ).

4. After the calculations have completed, click inside the header
cell for an empty column, and then click on Add... at the bottom
of the spreadsheet. Select (click on) the following “properties”
in the window at the top of the dialog: E LUMO, E HOMO,
Dipole, CPK Volume and Molecular Weight. Click on OK.

5. Select Properties (Display menu) and click on the oxygen
atom for whatever compound is displayed. Click on  to the
left of Electrostatic (under “Charges”) in the Atom Properties
dialog (which has replaced the Molecular Properties dialog),
to place oxygen charges into the spreadsheet.

6. Click on Add... at the bottom of the spreadsheet, and then click
on the Linear Regression tab at the top of the dialog which
results. This brings up the Add Regression dialog.
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Select Log(Keq) from the Fit menu and Electrostatic (O2)*

from the Using list. Click on OK. Two new rows will be added
at the bottom of the spreadsheet. With a Properties dialog on
screen, click anywhere on the row in the spreadsheet starting
with “Fit1”. The Regression Properties dialog appears.

This provides information about the fit of Log(Keq) to the
charge on oxygen, in particular, the value of R2. This will tend
to unity as the quality of the fit improves.

7. Inside the Regression Properties dialog, try fitting to different
(single) properties in the Using list. (The entries toggle “on”
and “off” with repeated clicking.) Maximize the value of R2.
Next, try all combinations of two properties. The combination
of E LUMO and Electrostatic (O2) should give the highest
value of R2. With this combination selected, bring up the Plots
dialog (Display menu) and select Log(Keq) from the X Axis
menu, and FitVals (Fit1) from the Y Axes list and click on
OK. Next, click on the curve (not on the axes) to bring up the
Curve Properties dialog (which replaces the Regression
Properties dialog). Select Linear LSQ (to replace Cubic
Spline) from the Fit menu. The resulting plot should show
good correlation.

8. Close “carbonyl compounds_3-21G” and remove any
remaining dialogs from the screen.

* Your atom numbering may be different, but the reference is to the carbonyl oxygen.
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Acidities of Carboxylic Acids

Acid strength is among the most catalogued of molecular properties.
It is readily available from calculation, either in terms of absolute
deprotonation energy,

AH A–  +  H+

or, more commonly, as the deprotonation energy relative to that of
some “standard” acid (A°H).

AH  +  A°– A–  +  A°H

A reasonable alternative measure of (relative) acid strength may be
the value of the electrostatic potential in the vicinity of the “acidic
hydrogen” in the neutral acid. This offers the advantage over a reaction
energy calculation of having to look at only one molecule. It is clear
that electrostatic potential maps uncover gross trends, for example,
the acidic hydrogen in a strong acid, such as nitric acid, is more
positive than that in a weak acid, such as acetic acid, which in turn is
more positive than that in a very weak acid, such as ethanol.

ethanol acetic acid nitric acid

In this tutorial, you will explore to what extent electrostatic potential
maps may be used to quantify changes in acid strength due to subtle
variations in structure. You will also use the tutorial to illustrate how
the Spartan Molecular Database of calculated structures, energies and
properties may be used to shorten the time required for an investigation.

1. One after the other, build trichloroacetic, dichloroacetic,
chloroacetic, formic, benzoic, acetic and pivalic acids. Put all
into the same list (New Molecule from the File menu following
the first molecule). Click on  when you are done.

10 mins
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2. All the molecules which you have built are available in the
Spartan Molecular Database. Click on  to the left of the
name of the presently selected molecule at the bottom of the
screen. The SMD Preview dialog will appear which displays
the structure of the selected molecule on the left and a list of
theoretical models for which calculated results are available
on the right. Check the yellow square to the left of “3-21G”
and click on Replace All at the bottom of the dialog.
Structures obtained from Hartree-Fock 3-21G calculations
will replace those you have built. You need to calculate a
wavefunction for each of the molecules in order to produce
electrostatic potential maps.

3. Enter the Calculations dialog (Setup menu). Check to make
certain that a single-point-energy, Hartree-Fock 3-21G
calculation has been requested. Also make certain that Global
Calculations at the bottom of the dialog is checked. Click on
OK to remove the dialog. Enter the Surfaces dialog (Setup
menu). First, make certain that Global Surfaces at the bottom
of the dialog is checked. Click on Add... at the bottom of the
dialog, select density from the Surface menu and potential
from the Property menu (medium from the Resolution menu)
in the Add Surface dialog which appears and then click on OK.
Leave the Surfaces dialog on screen. Submit the job (Submit
from the Setup menu). Name it “carboxylic acids_3-21G”.

4. While you are waiting for the calculations to complete (a few
minutes), bring up the spreadsheet (Spreadsheet from the
Display menu). Expand it so that you can see all seven
molecules, and that three data columns are available. Click
inside the header cell for a blank column. Click on Add... at the
bottom of the spreadsheet, select Name from the list of entries
and click on OK. The name of each molecule will appear. Next,
click inside the header cell of the next available data column,
type “pKa” and press the Enter key. Enter the individual
(experimental) pKa’s into the appropriate cells under this
column. You need to press the Enter key following each entry.
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acid pKa acid pKa

Cl3CCO2H 0.7 C6H5CO2H 4.19
Cl2CHCO2H 1.48 CH3CO2H 4.75
ClCH2CO2H 2.85 (CH3)3CCO2H 5.03
HCO2H 3.75

Experimental data from: E.P. Sargeant and B. Dempsey, Ionization Constants
of Organic Acids in Aqueous Solution, IUPAC no. 23, Permagon Press, 1979.

Finally, click inside the header cell of the next available data
column and type “potential”. Press the Enter key.

5. After all calculations have completed, arrange the seven
molecules on screen such that you can clearly see the “acidic
hydrogen” on each. To display all molecules at once, check
the box to the right of the “Label” column (in the spreadsheet)
for each entry. To manipulate them independently of each other,
select Coupled from the Model menu.

6. Click on the line “density . . .” inside the Surface dialog to
turn on the electrostatic potential map for each molecule. Bring
up the Properties dialog (Display menu) and click on the area
of “maximum blue” (most positive electrostatic potential) for
each molecule in turn. The value of the potential will be
displayed to the right of the Value in the Surface Properties
dialog. Enter this value into the appropriate cell of the
spreadsheet (in the column titled “potential”). You need to press
the Enter key following each data entry.

7. Plot experimental pKa vs. calculated potential. Bring up the
Plots dialog (Display menu), select pKa under the X Axis
menu and potential from the Y Axes list, and click on OK.
The data points are connected by a smooth curve (a so-called
cubic spline). To get a least squares fit, select Properties from
the Display menu, click on the curve, and select Linear LSQ
from the Fit menu in the Curve Properties dialog.

8. Close “carboxylic acids_3-21G” and remove any remaining
dialogs from the screen.
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30 mins

Stereochemical Assignments from 13C NMR
(cannot be completed with the Essential Edition)

NMR spectroscopy, in particular 13C spectroscopy, is without doubt
the method of choice to establish the three-dimensional structure of
organic molecules. Only X-ray diffraction provides more definitive
results, although the requirement of a crystalline sample severely
limits its application. It is now practical to calculate the NMR spectra
of “real” organic molecules. The availability of a “virtual NMR
spectrometer” will in time offer the organic chemist an entirely new
paradigm for structure determination, that is direct comparison of a
measured spectrum with calculated spectra for one or more chemically
reasonable candidates.

Here, you will obtain 13C chemical shifts for cis and trans stereoisomers
of 2-hexene and endo and exo stereoisomers of 2-methylnorbornane,
and compare these to experimental shifts. The Hartree-Fock 6-31G*
model will be employed, but you will get all structures from the Spartan
Molecular Database. You will establish the extent to which the
calculations are able to reproduce differences in chemical shifts as a
function of stereochemistry.

1. Build cis-2-hexene. Click on  at the bottom of the screen (to
the left of the molecule name), check the box to the left of the
“6-31G*” in the SMD Preview dialog which appears and click
on Replace. Do not minimize. Select New Molecule from the
File menu, build trans-2-hexene, check the box to the left of
“6-31G*” in the preview dialog and click on Replace. Do not
minimize. Click on .

2. Enter the Calculations dialog and specify a single-point
Hartree-Fock calculation using the 6-31G* basis set. Check
NMR to the right of “Compute”. Submit the job with the name
“2-hexene_6-31Gs”.

3. When completed, examine the 13C chemical shifts, either from
the Atom Properties dialog or as atom labels (Configure...
under the Model menu and check Chem Shift under “Atom”
in the dialog which results). Compare them to measured values
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with particular attention to the difference in shifts between cis
and trans stereoisomers.

cis trans ∆
C1 11.4 16.5 5.1
C2 122.8 123.9 1.1
C3 129.7 130.6 0.9
C4 28.2 34.1 5.9
C5 21.4 22.1 0.7
C6 12.5 12.5 0.0

Do the calculations distinguish between the two isomers?

4. Close “2-hexene_6-31Gs”.

5. Build endo-2-methylnorbornane. As you did for 2-hexene,
replace your structure with the (6-31G*) structure in the Spartan
Molecular Database. Select New Molecule (File menu) and
repeat the process for the exo isomer. Click on .

6. Inside the Calculations dialog, specify a single-point Hartree-
Fock 6-31G* calculation, and check NMR (to the right of
“Compute”). Submit the job with the name “2-methyl
norbornane_6-31Gs”.

7. When completed, compare the 13C chemical shifts with
experimental values with particular attention to differences
between endo and exo stereoisomers.

endo exo ∆
C1 43.5 42.2 -1.3
C2 36.8 34.6 -2.2
C3 40.2 40.7 0.5
C4 37.3 38.2 0.9
C5 30.3 30.6 0.3
C6 29.0 22.4 -6.6
C7 35.0 38.9 3.9
CH3 22.3 17.4 -4.9

Do the calculations distinguish between the two isomers?

8. Close “2-methylnorbornane_6-31Gs”.

CH3

4

1 2

35

6

7

CH3 CH CH

CH2CH2CH3
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Favoring One Tautomer Over Another

2-hydroxypyridine is in equilibrium with its tautomer, 2-pyridone.

NHO NO
H

2-hydroxypyridine 2-pyridone

The relative abundance of the two is given by the Boltzmann equation
and depends both on their relative energies and on the temperature.

A search of the Cambridge Structural Database uncovers fewer “hits”
for derivatives of 2-hydroxypyridine than for derivatives of 2-pyridone.
While this does not establish that the latter is a more stable tautomer, it
suggests that this is the case.

In this tutorial, you will use the Spartan Molecular Database first to
establish whether 2-hydroxypyridine or 2-pyridone is lower in energy
and then to look for substituents which reverses this preference. No
quantum chemical calculations are involved.

1. Build 2-hydroxypyridine. Click on  at the bottom of the screen
(to the left of the molecule name) to bring up the SMD Preview
dialog, check 3-21G and click on Replace. Select New
Molecule from the File menu, build 2-pyridone (start with
Amide from the Groups menu), check 3-21G in the preview
dialog and click on Replace. Dismiss the preview dialog (click
on ) and then click on .

2. Bring up the spreadsheet (which should contain entries for both
2-hydroxypyridine and 2-pyridone), click on an empty column
header and click on Add.... Select (click on) both Name
(molecule name) and rel.E from the list, choose an appropriate
set of units, and click on OK. Which molecule is lower in
energy according to the calculations? Is your result consistent
with or at odds with information in the Cambridge Structural
Database (see text box above)?
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3. Select 2-hydroxypyridine, click on  and then click on the
SMD tab in the Database dialog. The SMD dialog appears.

Click on  to the right of the Search button at the bottom of
the SMD dialog to bring up the Search Options dialog.

Check 3-21G (only) under “Method Filters” and click on OK.
Next, click on the free valence on the 4 position (across the
ring from nitrogen). An orange cone will cover the free valence.
(If you click on the wrong valence, click again and then click
on the correct valence.) What you have done is to request
Hartree-Fock 3-21G entries in the Spartan Molecular Database
for all 4-substituted 2-hydropyridines. Click on the Search
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button at the bottom of the dialog. “Hits” will begin to appear
at the right of the dialog. After the search has completed, click
on  to the right of the Retrieve button at the bottom of the
dialog to bring up the Retrieve Options dialog.

Click on New Document under “Retrieve to” and click on OK.
Next, select all entries in the list of hits in the SMD dialog by
first clicking on the top entry and, while holding down on the
Shift key, clicking on the bottom entry. Finally, click on the
Retrieve button.

Click on , and name the file where the hits are stored
“substituted 2-hydroxypyridines”. Bring up a spreadsheet for
this file and expand to include all of the entries and to have
room for one data column. Click on an empty column header,
click on Add... at the bottom of the spreadsheet, select E from
the list of quantities in the resulting dialog (au from the Energy
menu under “Units”) and click on OK.

4. Repeat the process for 2-pyridone, and title the file containing
the database hits “substituted 2-pyridones”. When you are done,
place both spreadsheets side-by-side on screen and look for
common (same substituent) entries. Can you identify
substituents which enhance the energetic preferences seen for
the parent compound? Can you identify substituents which
reverse this preference? Elaborate.

5. Close all molecules and any open dialogs.
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Chapter 5
Organic Reactions

This chapter outlines and illustrates “strategies” for locating and
verifying transition states for organic reactions as well as for
exploring changes in product distributions as a function of substituents
and reactant stereochemistry.

The treatment of chemical reactions adds an entirely new dimension
to the application of quantum chemical models. Whereas unique
valence structures may generally be written for “normal” molecules
and, based on these structures, reasonable guesses at bond lengths
and angles may be made, it is often difficult to designate appropriate
valence structures for transition states, let alone specify detailed
geometrical parameters. This is, for the most part, due to a complete
absence of experimental data on the structures of transition states.
However, calculated transition-state geometries are now
commonplace. Spartan’04 provides both an extensive library of
calculated transition states and a facility for matching as closely as
possible entries in the library with the reaction at hand.*

Spartan’04 also provides a procedure for “driving” user-defined
coordinates. Aside from conformational analysis (see discussion in
previous chapter), the major application of this is to “force” reactions,
thereby permitting identification of transition states.

The tutorials in this chapter illustrate procedures for “guessing”
transition states of organic reactions, and then actually locating and
verifying them. They also illustrate a procedure to “drive” a reaction
through a transition state. Finally, they address strategies for collecting
information on related reactions to assign kinetic product distributions.

* Where a reaction is unknown to Spartan’04’s library, a fallback technique which “averages” reactant
and product geometries (similar to the so-called linear synchronous transit method) is invoked.
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Ene Reaction of 1-Pentene

C

C
C

C

C C

C
H

H
C

C
HH

H
H

1-pentene ethylene propene

H

C

H

H

∆ +

H H

H H
H

H

H

H
H

H H

The proposed mechanism of the ene reaction involves simultaneous
transfer of a hydrogen atom along with CC bond cleavage. Here, you
will obtain the transition state for the ene reaction of 1-pentene from
3-21G Hartree Fock calculations, and you will examine the reaction
coordinate for evidence that hydrogen transfer and CC bond breaking
occur in concert. Optionally, you will perform B3LYP/6-31G* single-
point energy calculations, based on Hartree-Fock 3-21G geometries,
to obtain an estimate of the activation energy for the ene reaction.
Also, optionally you will produce an intrinsic reaction coordinate
which provides a smooth sequence of structures connecting reactant
and product through the transition state.

1. Bring up the entry model kit and build 1-pentene in a
conformation in which one of the terminal hydrogens on the
ethyl group is “poised” to transfer to the terminal methylene
group. Minimize (click on ) and click on .

2. First, save 1-pentene as “1-pentene_B3LYP_6-31Gs” for
possible use later ( ). Also make a copy for immediate
use; name it “ene reaction 1-pentene_3-21G”.

3. Select Transition States from the Search menu (or click on
the  icon from the Search toolbar). Click on bond “a” in the
figure on the following page and then click on bond “b”.

A curved arrow from bond “a” to bond “b” will be drawn (as
shown in the figure). Next, click on bond “c” and then on bond
“d”. A second curved arrow from bonds “c” to “d” will be drawn.
Finally, click on bond “e” and, while holding down the Shift
key, click on the (methyl) hydrogen to be transferred and on the
terminal (methylene) carbon to receive this hydrogen. A third

75
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curved arrow from bond “e” into the “space” between the
hydrogen and oxygen will be drawn.
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H
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H H

HH
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H H

a

bc

d

e

If you make a mistake, you can remove “arrows” using .
(You will need to select  to continue.) Alternatively, use the
Delete key. With all three arrows in place, click on  at the
bottom right of the screen. Your structure will be replaced by a
guess at the ene transition state. If the resulting structure is
“unreasonable”, then you have probably made an error in the
placement of the “arrows”. In this case, select Undo from the
Edit menu to return to the model with the “arrows” and modify
accordingly.

4. Enter the Calculations dialog (Setup menu), and specify
calculation of transition-state geometry using the 3-21G Hartree-
Fock model. Select Transition State Geometry from the top
menu to the right of “Calculate” and Hartree-Fock and
3-21G(*) from the two bottom menus. Also, check IR to the
right of “Compute”. This requests a vibrational analysis
following the optimization*, and is needed both to confirm that
you have found a transition state, and to ensure that this
transition state smoothly connects reactant and product.

5. Submit the job. When it has completed, animate the motion of
atoms along the reaction coordinate. Select Spectra from the
Display menu and click on the IR tab. Click on the top entry
in the list in the IR dialog which results. It corresponds to an
imaginary frequency, and will be designated with an “i” in
front of the number. Is the vibrational motion consistent with
the reaction of interest and not with some other process?

* Vibrational frequencies need to be calculated using optimized equilibrium or transition-
state geometries. Otherwise, their values are meaningless.
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6. Controls at the bottom of the IR dialog allow for changing
both the amplitude of vibration (Amp) and the number of steps
which make up the motion (Steps). The latter serves as a “speed
control”. Change the amplitude to “0.3” (type “0.3” in the box
to the right of Amp and press the Enter key). Next, click on
Make List at the bottom of the dialog. This will give rise to a
group of structures which follow the reaction coordinate down
from the transition state both toward reactant and product. To
avoid confusion, remove the original transition state from the
screen. Click on “ene reaction 1-pentene_3-21G” (the vibrating
molecule) and close it, along with the IR dialog.

7. Enter the Calculations dialog and specify a single-point energy
calculation using the 3-21G Hartree-Fock model (the same
level of calculation used to obtain the transition state and
calculate the frequencies). Make certain that Global
Calculations is checked before you exit the dialog. Next, enter
the Surfaces dialog and specify evaluation of two surfaces: a
bond density surface and a bond density surface onto which
the electrostatic potential has been mapped. Click on Add . . .,
select density (bond) for Surface and none for Property and
click on OK. Click on Add . . . again, select density (bond)
for surface and potential for Property and click on OK. Make
certain that Global Surfaces is checked.

8. Submit for calculation. Name it “ene reaction 1-pentene
sequence_3-21G”. Once the job has completed, enter the
Surfaces dialog and, one after the other, select the surfaces
which you have calculated. For each, step through the sequence
of structures (  and ) keys at the bottom of the screen) or
animate the reaction ( ). Note, in particular, the changes in
bonding revealed by the bond density surface. Also pay
attention to the “charge” on the migrating atom. Is it best
described as a “proton” (blue color), hydrogen atom (green
color) or “hydride anion” (red color)?

9. Close “ene reaction 1-pentene sequence_3-21G” as well as
any remaining dialogs.
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10 to 14 optional (cannot be completed with the Essential Edition)

Methods which account for electron correlation are generally needed
to furnish accurate estimates of absolute activation energies. Perform
single-point energy calculations using the B3LYP/6-31G* density
functional model on both 1-pentene and on the ene reaction transition
state (using the 3-21G geometries).

10. Open “ene reaction 1-pentene_3-21G” ( ) and make a copy
( ). Name it “ene reaction 1-pentene_B3LYP_6-31Gs”.

11. Enter the Calculations dialog, and specify a single-point energy
using the B3LYP/6-31G* density functional model. Remove
the checkmark from IR. Submit the job.

12. Open “1-pentene_ B3LYP_6-31Gs” ( ). Specify a single-
point energy calculation using the B3LYP/6-31G* model. Also
select 3-21G(*) from the menu to the right of “Start from”.
This designates that a 3-21G equilibrium structure is to be used.
Submit the job.

13. Obtain the activation energy (difference in total energies
between 1-pentene and the ene reaction transition state).

14. Remove any molecules and dialogs from the screen.

15 and 16 optional (cannot be completed with the Essential Edition)

To obtain a reaction coordinate smoothly connecting reactant and
product through the transition state, use Spartan’s intrinsic reaction
coordinate (IRC) procedure.

15. Open “ene reaction 1-pentene_3-21G” ( ). Enter the
Calculations dialog, and check IRC at the top right. Submit
the job. When completed, the results (a list of molecules) will
be placed in a file “ene reaction 1-pentene_3-21G.IRC1”. Bring
up the file. Using the step ( , ) and play ( ) keys at the
bottom left of the screen, show the motions of the atoms during
the course of reaction.

16. Remove any molecules and dialogs from the screen.
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Thermodynamic vs. Kinetic Control

Chemical reactions may yield different products depending on the
conditions under which they are carried out. High temperatures and
long reaction times favor the most stable (“thermodynamic”) products,
while low temperatures and short reaction times favor the most easily
formed (“kinetic”) products. For example, the kinetic product in Diels-
Alder cycloaddition of cyclopentadiene and maleic anhydride is the
endo adduct, whereas it seems likely that the less-crowded exo adduct
is the thermodynamic product.
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b b
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Here you will first obtain pathways for reactions leading to both endo
and exo adducts using the PM3 semi-empirical model and then
(optionally) follow these by single-energy 3-21G Hartree-Fock
calculations to get a better estimate of the difference in activation
energies.

1. Build the endo Diels-Alder adduct of cyclopentadiene and
maleic anhydride and minimize (to CS symmetry).

2. Select Constrain Distance from the Geometry menu (or click
on the  icon from the Geometry toolbar), and one after the
other, click on bonds “a” and “b” in the figure above. For each,
click on the icon  at the bottom right of the screen (it will
then turn to ).

3. Select Properties from the Display menu, and click on the
constraint marker for bond “a”. The Constraint Properties
dialog appears, with the value of the constraint for bond distance
“a” (1.54Å) given in a box to the right of Value. Change this to
1.5Å by typing “1.5” inside the box and then pressing the Enter
key. Check Dynamic inside the dialog. This leads to an

5 mins
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extended form of the Constraint Properties dialog, which
allows the single constraint value to be replaced by a sequence
of constraint values. Type “2.7” (2.7Å) into the box to the right
of to and press the Enter key. Steps should be set to “10”. (If
it is not, type “10” and press the Enter key.) What you have
now specified is that bond “a” will be constrained first to 1.5Å,
then to 1.633Å, then to 1.767Å, etc. and finally to 2.7Å.

You need to repeat the process for bond “b”. Click on this
bond (the Constraint Properties dialog will now refer to the
constraint on bond “b”), and type “1.5” and “2.7” for Value
and to, respectively. Be certain to press the Enter key following
each. What you have done is to request that bonds “a” and “b”
both be constrained from 1.5Å to 2.7Å in 10 equal steps. Close
the Constraint Properties dialog.

4. Bring up the Calculations dialog and select Energy Profile
from the top menu to the right of “Calculate”, and Semi-
Empirical and PM3 from the two bottom menus. Click on
Submit at the bottom of the dialog to submit the job. Name it
“cyclopentadiene+maleic anhydride endo_PM3”.

5. When completed the job will give rise to a new file
“cyclopentadiene+maleic anhydride endo_PM3.Profile1”
containing the 10 steps which make up the energy profile. Open
this file.*

6. Bring up the Spreadsheet, and click on Add... at the bottom.
Select E from among the entries, kcal/mol from the Energy
menu, and click on OK. Next, click on  and click on one of
the two CC bonds varied in the energy profile.** Click on  at
the bottom right of the screen. Click on . Finally, bring up
the Plots dialog, and select Length (Bond8)*** from among

* To avoid confusion, it is a good idea to close the original file “cyclopentadiene+maleic
anhydride endo_PM3”.

** Alternatively, you could have selected  (instead of ), clicked on one of the two constraint
markers, and then clicked on .

*** Most likely the bond you select will not be called “Bond8”.
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the items in the X Axis menu and E (kcal/mol) from the Y
Axes list. Click on OK.

Identify both the reactant and transition state from the plot and
estimate the activation energy for the cycloaddition reaction.

7. Repeat steps 1 to 6 for the exo adduct. Compare the activation
energy for exo addition to that for endo addition (above). What
should be the kinetic product?

8. Remove all molecules and dialogs from the screen.

9 to 11 optional

9. Open “cyclopentadiene+maleic anhydride endo_PM3.
Profile1” ( ) and make a copy ( ). Name it “cyclopentadiene
+maleic anhydride endo_3-21G”. Enter the Calculations
dialog and specify a single-point energy calculation using the
Hartree-Fock 3-21G model. Submit. When completed, perform
the same spreadsheet and plot operations you did for the PM3
calculations.

10. Repeat the above procedure for the exo adduct and compare
the two activation energies. What is the kinetic product?

11. Remove all molecules and dialogs from the screen.
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Stereospecific Diels-Alder Reactions
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Diels-Alder cycloaddition of 5-substituted cyclopentadienes with
acrylonitrile can lead to four stereoproducts, in which the X group is
syn or anti to the dienophile, and the nitrile is endo or exo. Anti products
are preferred when X is alkyl (in line with obvious steric dictates),
while syn products are favored when X is halogen or alkoxy.  In general,
endo adducts are kinetically favored over exo adducts (see previous
tutorial). In this tutorial, you will first use AM1 semi-empirical
calculations to obtain both syn and anti transition states for endo
addition of both 5-methylcyclopentadiene and 5-fluorocyclopentadiene
and acrylonitrile, and then use Hartree-Fock 3-21G calculations to
estimate relative activation energies. As the four transition states are
likely to be very similar to the transition state for the “parent”
cycloaddition (cyclopentadiene and acrylonitrile), you will first obtain
a transition state for the parent reaction, and then to use it as a starting
point for locating transition states for the substituted systems.

1. Construct the following substituted norbornene (the product
of endo addition of cyclopentadiene and acrylonitrile).

a

CN

b

cd

e

f

2. Click on . Click on bond “a” (see figure above) and then on
bond “b”. A curved arrow will be drawn from “a” to “b”. Next,
click on bond “c” and then on bond “d”; a second curved arrow
from “c” to “d” be drawn. Finally, click on bond “e” and then
on bond “f”, leading to a third curved arrow. The model on
screen should now appear as follows.

5 mins/10 mins
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CN

Click on  at the bottom right to produce a guess at the
transition state.

3. Inside the Calculations dialog, specify calculation of transition
state geometry using the semi-empirical AM1 model. Check
IR (to the right of “Compute”) to specify calculation of
vibrational frequencies. This will allow you to verify that you
have indeed located a “reasonable” transition state.

4. Submit the job. Name it “cyclopentadiene+acrylonitrile_
AM1”. When it has completed, examine the resulting structure
and calculated frequencies. Make certain that there is one and
only one imaginary frequency. Animate the motion associated
with the imaginary frequency (Spectra under the Display
menu, click on the IR tab and check the box to the left of the
imaginary frequency in the dialog which results) to verify that
it corresponds to motion along the reaction coordinate.

5. Place the transition-state structure onto the clipboard. Position
the cursor slightly above and slightly to the left of the model,
then, with both buttons depressed, drag the mouse to a position
slightly below and slightly to the right of the model, and finally
release both buttons. Dotted lines will enclose the model.
Select Copy from the Edit menu. Close “cyclopentadiene+
acrylonitrile_ AM1” ( ).

6. Enter the builder ( ). Click on Clipboard (at the bottom of
the model kit) and then click anywhere on screen. The
transition-state structure will appear. Add a fluorine to the
methylene group of the “cyclopentadiene fragment” of the
transition state either syn or anti. Do not minimize. Your starting
structure should provide an excellent guess at the transition
state for the substituted system.
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7. Select New Molecule from the File menu. The screen will
clear. Click on Clipboard and then click anywhere on screen.
Add fluorine to the other methylene group position.

Repeat the process two more times (starting with New
Molecule), to add methyl both syn and anti on the methylene
group. When you are done (four substituted transition states in
total), click on .

8. Enter the Calculations dialog and specify calculation of
transition state geometry using the semi-empirical AM1 model.
Check IR (to the right of “Compute”). Finally, make certain
that Global Calculations is checked before you exit the dialog.
Submit the job (name it Diels-Alder stereochemistry_AM1”.
When it has completed, verify that all four structures correspond
to transition states (using Spectra from the Display menu).

9. Make a copy of “Diels-Alder stereochemistry” ( ). Name it
“Diels-Alder stereochemistry_3-21G”. Enter the Calculations
dialog with this copy and specify a single-point energy
calculation using the 3-21G Hartree-Fock model. Make certain
that you remove the checkmark on IR and that Global
Calculations is checked before you exit the dialog.

10. Submit the job. When it completes, bring up the spreadsheet
(Display menu) and enter the total energies. Click on the header
cell of a blank column and then on Add . . . at the bottom of
the spreadsheet. Select E from the menu of available quantities
and au (atomic units) from the Energy menu. Click on OK.
Are your results consistent with the observed syn/anti
selectivity in these reactions?*

11. Remove all molecules and any remaining dialogs from the
screen.

* You might find it convenient to have the spreadsheet calculate relative energies. Select
(click on) the label for one of the fluorine substituted transition states in the spreadsheet,
then click on Add... and select rel. E from the menu of available quantities. Click on OK.
Repeat for the methyl substituted transition states.
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Carbene Additions to Alkenes

C C
HH

H H

C

C C

X

H H

X

H H

+  :CX2

Singlet carbenes add to alkenes to yield cyclopropanes. Since a singlet
carbene possesses both a high-energy filled molecular orbital in the
plane of the molecule, and a low-energy, out-of-plane unfilled
molecular orbital, this reaction presents an interesting dilemma.
Clearly it would be more advantageous for the low-lying vacant orbital
on the carbene, and not the high-lying filled orbital, to interact with
the olefin π system during its approach.

C

C C
HH

H H

However, this leads to a product with an incorrect geometry, and the
carbene must “twist” by 90° during the course of reaction.
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In this tutorial, you will use the Hartree-Fock 3-21G model to find
the transition state and to analyze the motion of the fragments.

1. Bring up the entry model kit and build ethylene.

2. Select  from the model kit. Click on the Insert button at the
bottom right of the screen (or press the Insert key) and then
click anywhere on screen. Next, select  from the model kit
and click on two of the free valences on the sp3 carbon. Next,

5 mins/15 mins
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click on  and, one after the other, click on the remaining two
free valences on the sp3 carbon. Finally, click on . You are
left with two fragments, ethylene and difluorocarbene. Orient
the two as to be poised for reaction.*

C

C C

F
F

Translations and rotations normally refer to the complete set
of fragments, but that they can be made to refer to an individual
fragment. Click on a fragment to identify it, and then hold down
the Ctrl key while manipulations are being carried out.

3. Click on . Click on the carbon on the CF2 fragment and then,
while holding down the Shift key, click first on the CF2 carbon
and then on one of the carbons on the ethylene fragment. A
curved arrow will be drawn.

C

C C

F
F

Next, click on the CC double bond and then, while holding
down the Shift key, click on the other ethylene carbon and
then on the CF2 carbon. A second arrow is added to the structure.

C

C C

F
F

With both arrows in place, click on  at the bottom right of
the screen. Your structure will be replaced by a guess at the
transition state.

* Proper orientation of the two fragments is not crucial in this case, but is primarily to allow
the user to associate the “arrows” with the intended reaction. Proper orientation is, however,
essential where different stereochemical outcomes are possible.
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4. Enter the Calculations dialog, and specify calculation of a
transition-state geometry using the 3-21G Hartree-Fock model.
Check IR to the right of “Compute”. This will allow you to
examine the motion along the reaction coordinate. Click on
Submit inside the dialog. Name the job “difluorocarbene+
ethylene_3-21G”.

5. When the job is complete, examine the geometry of the
transition structure. In light of considerations regarding the
orientation of filled and empty molecular orbitals on the carbene
and the π orbital on ethylene, would you describe your structure
as corresponding to an “early” or “late” transition state? Animate
the vibrational mode corresponding to the reaction coordinate.
Bring up the IR dialog (Spectra under the Display menu and
click on the IR tab). Click on the imaginary frequency at the
top of the list of frequencies (this corresponds to motion along
the reaction coordinate). Does the animation show reorientation
of the carbene as it approaches the double bond? When you are
finished, turn “off” the animation by again clicking on the
imaginary frequency.

6. Select Properties (Display menu) and, in turn, click on each
of the four hydrogens in the transition state. Change the value
in the Mass Number menu in the Atom Properties dialog
from “1” to “2 Deuterium”. When you are done, resubmit the
job. When complete, examine the new set of vibrational
frequencies. Note that they are uniformly smaller than those
for the undeuterated system, and that the largest changes are
for vibrational motions where hydrogens are involved.

7 to 10 optional

7. Make a copy of “difluorocarbene+ethylene_3-21G” name it
“difluorocarbene+cyclohexene_3-21G”.

8. Bring up the entry model kit with the copy (click on ). Select
Freeze Center from the Geometry menu (or click on the 
icon from the Geometry toolbar). One after the other, click on
all atoms and free valences in your transition state except two
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of the free valences on one side of the “ethylene fragment”.*

Each of the atoms on which you clicked will be given a magenta
colored marker, indicating that it is to be “frozen” (not moved
during optimization).** Using sp3 carbon  from the model kit
and then , connect the two free valences which you have not
“frozen” by a chain of four “methylene groups” to make a
cyclohexene ring. Click on . Note that the only four methylene
groups which you have just added “move” and not the
underlying transition state. You have produced an excellent guess
at the transition state for difluorocarbene addition to cyclohexene
based on your previous transition state for the simpler process.

9. Enter the Calculations dialog. It should already specify
calculation of transition-state geometry using the 3-21G
Hartree-Fock  model. Remove the checkmark on IR (to the
right of “Compute”). Click on Submit.

10. When completed, compare the geometries of the two transition
states (corresponding to addition of difluorocarbene to
ethylene and cyclohexene, respectively). To do this, first put
the two transition states into the same group. Select Append
Molecule(s)... from the File menu and double click on
“difluorocarbene+ethylene” in the browser which results. Then
bring up the spreadsheet (Spreadsheet from the Display menu)
and check each of the boxes to the right of the molecule names.
Click on  and, one after the other, click on the three carbons
which make up the “cyclopropane ring”. Finally, click on Align
at the bottom right of the screen, and then click on . Are the
two transition states very similar as expected?

11. Remove all molecules and any remaining dialogs from the
screen.

* You could do this more quickly by first clicking on , then drawing a selection box around
all atoms to be frozen, and then clicking inside this box.

** You can remove the “frozen atom” markers from the model by bringing up the Molecule
Properties dialog (Display menu), clicking on  at the bottom right of the dialog and then
removing the checkmark from Frozens in the Molecule Utilities dialog which results.
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SN2 Reaction of Bromide and Methyl Chloride

Br–  +  C Cl

H

H

H
+  Cl-CBr
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H H

ClBr

1. The SN2 reaction passes through a transition state in which
carbon is in a trigonal bipyramid geometry and the entering
and leaving groups are colinear. To build it, first construct methyl
chloride. Then click on the Insert button at the bottom right of
the screen (or press the Insert key), select bromine from the
palette of icons in the model kit and click anywhere on screen.
Two detached fragments, “methyl chloride” and “hydrogen
bromide”, appear on screen. Click on  and then click on the
free valence on bromine (immediately click on  to get out of
“delete mode”). Alternatively, hold down the Delete key and
click on the free valence on bromine. You are left with methyl
chloride and bromine atom (“bromide”). Manipulate the two
such that “bromide” is poised to “attack” methyl chloride from
the backside (as in the transition state above). (Recall that
translations and rotations normally refer to both fragments, but
can be made to refer to a single fragment by first clicking on the
fragment and then holding down on the Ctrl key while carrying
out the manipulations.) Do not minimize. Click on .

2. Click on . Click on “bromide” and, while holding down the
Shift key, click again on “bromide” and then on carbon. An
arrow will be drawn from “bromide” into the “space” between
bromine and carbon. Next, click on the CCl bond and then
click on the chlorine. A second arrow from the carbon-chlorine
bond to the chlorine will be drawn.

Br C Cl

Click on  at the bottom right of the screen. Your structure
will be replaced by a “guess” at the transition state.

2 mins/5 mins
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3. Click on  and then on the CBr bond. Replace the current
CBr distance in the box at the bottom right of the screen by 3.8
(3.8Å) and press the Enter key. You have now made a
“complex” representing the “reactant”.

4. Click on . Click on the CBr bond, and then click on  at the
bottom right of the screen. The icon will change to  indicating
a constraint is to be applied to this distance. Next, bring up the
Properties dialog and click on the constraint marker. The
Constraint Properties dialog appears. Click on Dynamic.
Leave the value “3.8” (3.8Å) in the box to the right of Value
alone, but change the number in the box to the right of to to
“1.9” (1.9Å) and press the Enter key. You have requested 10
(the default number) structures with CBr bond lengths from
3.8Å (the starting point) to 1.9Å (the ending point). These
should pass through the transition state. Dismiss the Constraint
Properties dialog.

5. Enter the Calculations dialog, and select Energy Profile, Semi-
Empirical and AM1 from the appropriate menus to the right
of “Calculate”. You need to change Total Charge to Anion.

6. Submit the job. Name it “bromide+methyl chloride_AM1”.
When completed, it will give rise to a sequence of calculations
placed in “bromide+methyl chloride_AM1.Profile1”. Open this
file, and align the molecules. Click on , then in turn on the
three hydrogens, and finally press the Align button at the
bottom right of the screen. Click on .

7. Bring up the Spreadsheet and click on Add.... Select E from
among the quantities listed at the top of the dialog, kcal/mol
from the Energy menu, and click on OK. Next, enter the CBr
distances and bromine charges in the spreadsheet. Click on

, select the CBr distance and click on  at the bottom right
of the screen. Click on . Bring up the Properties dialog.
Click on bromine and click on  to the left of “Electrostatic”
under “Charges” in the Properties dialog. Finally, bring up
the Plots dialog, and select Distance (C1,Br1) from the X
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Axis menu, and both E (kcal/mol) and Electrostatic (Br1)
from the Y Axes list. Click on OK.

One plot gives the energy as the reaction proceeds and the
other gives charge on bromine. Are the two related? Explain.

SN2 reactions involving charged species normally need to be
carried out in highly-polar media, e.g., water. Spartan provides
two different approaches to account for the solvent: the SM5.4
model of Cramer and Truhlar (see Appendix A) in which the
solvent is represented by a “reaction field”, and a mixed
quantum mechanics/molecular mechanics approach, in which
the solute is immersed in a “bath” of solvent and molecular
dynamics simulation performed. The first approach is
illustrated here while the second is  illustrated for zwitterionic
and non-zwitterionic forms of triglycine in the next chapter.

8. Add “aqueous phase” data to the spreadsheet. Click on an empty
column header, click on Add..., select E SM5.4 from the list
of available quantities (kcal/mol from the Energy menu), and
click on OK. Bring up the Plots dialog and select Distance
(C1,Br1) from the X Axis and E SM5.4 (kcal/mol) from the Y
Axes list. Click on OK.
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9 to 12 optional

9. With “bromide+methyl chloride_AM1_Profile1” enter the
Calculations dialog. Specify Single Point Energy (AM1
should be selected) and click on OK.

10. Enter the Surfaces dialog. Click on Add.... Select density
(bond) from the Surface menu and none from the Property
menu and click on OK. Again click on Add... and again select
density (bond) from the Surface menu, but this time potential
from the Property menu. Click on OK.

11. Submit the job. When completed, click on the line “density...”
inside the Surfaces dialog. Click on  at the bottom left of the
screen to animate the display. Note, the smooth way in which
bonds are broken and formed during the course of reaction.
Click on  at the bottom of the screen when you are done.

12. Reenter the Surfaces dialog. Turn “off” display of the bond
density (click on the line “density...”), and turn “on” display of
the electrostatic potential mapped onto the bond density (click
on the line “density potential...”). Click on . Relate the
migration of negative charge during reaction as indicated by
colors in the electrostatic potential map to the “charge” plot
you constructed in step 5 above. Recall, that colors near red
indicate maximum negative potential.

13. Remove all molecules and any remaining dialogs from the
screen.
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Chapter 6
Biologically Interesting

Molecules
This chapter illustrates applications involving “biologically
interesting” molecules, introduces the peptide model kit and shows
how a structure from the Protein Data Bank (PDB) may be brought
into Spartan’04 for further analysis.

At present time, calculations on “real” biopolymers (proteins and
RNA/DNA strands) are limited to molecular mechanics models.
However, large classes of organic molecules of biological interest,
among them steroids, prostaglandins and vitamins, are amendable to
investigation using quantum chemical models. The first three tutorials
give examples of such applications, and the last of these also provides
a bridge between small molecules and biopolymers.

Polypeptides and polynucleotides are considered in the last two
tutorials. The peptide model kit, intended primarily to construct small
polypeptide strands in “idealized” geometries, is used to build helical
polyglycine, and comparisons are made between zwitterionic and
non-zwitterionic forms both in and out of water. The structures of a
small molecule - DNA complex and a protein-RNA complex, obtained
from the protein databank (PDB), are used in the two final tutorials,
the first as the basis of a graphical modeling study, and the second to
illustrate display of hydrogen bonds.
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Vitamin E

HO

O

Vitamin E may play an active role in defending cells from attack by
reacting quickly with oxidizing agents to give stable products that can
then be safely excreted. While the mechanism of the vitamin’s action
is not completely certain, it seems likely that it might directly transfer
a hydrogen to another free radical leading to its “destruction” and to
the formation of a stable “Vitamin E radical”. Graphical models can
help to account for this biological function, as well as suggest why
Vitamin E incorporates a long hydrocarbon chain.

1. Build vitamin E. Start with Benzene from the Rings menu. Add
a sequence of three sp3 carbons ( ) and an sp3 oxygen ( ) to
the ring and then join them ( ) to form the bicyclic skeleton.
Click on  to produce a refined (intermediate) structure.

2. Add the saturated carbon chain (the “•” is a free valence).*

Don’t worry about its conformation.

•

Finally, add the four methyl groups and the hydroxy group at
the appropriate ring positions. Click on  to produce a final
structure.

3. Enter the Calculations dialog (Setup menu) and specify
calculation of equilibrium geometry using the AM1 semi-
empirical model. Click on OK. Next, enter the Surfaces dialog

* You could save time by first building the five-carbon fragment (the “•’s” are free valences),

•
•

then placing it on the clipboard, and finally using this fragment (instead of sp3 carbon) as
the building block. You need to add one sp3 carbon at the end.

95

15 mins
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(Setup menu). Click on Add... and select density from the
Surface menu and potential from the Property menu. Submit
the job; name it “vitamin E_AM1”.

4. When completed, examine the electrostatic potential map.
Inside the Surfaces dialog, click on the line “density potential
. . .”. Note that the potential map suggests that the greater
portion of the molecule (the hydrocarbon chain) is non polar.
This facilitates its incorporation  into lipids.

5. Make a copy of “vitamin E_AM1” (click on ). Name it
“vitamin E radical_AM1”. Select Delete from the Build menu
(or click on ), and click on the hydroxyl hydrogen. Do not
minimize. You already have an excellent starting structure.

6. Enter the Calculations dialog and change Multiplicity from
Singlet to Doublet. Click on OK. Enter the Surfaces dialog.
First, remove the request for the electrostatic potential map
(click on the line: “density potential . . .” and then click on
Delete at the bottom of the dialog). Next, make a request for a
spin density surface. Click on Add..., select spin from the
Surface menu and none from the Property menu, and click
on OK. Submit the job.

7. When completed, enter the Surfaces dialog and click on the
line: “spin . . .”. Note that the unpaired electron is not localized
on oxygen, but rather is delocalized over the benzene π system.
This is why vitamin E forms a stable radical and is able to act
as an effective “radical scavenger”.

8. Remove all molecules and any remaining dialogs from the
screen.
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Androsterone
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Androsterone illustrates the steps involved in building a complex
organic molecule with fused rings and several stereocenters. It also
provides a good opportunity to compare space-filling models and
electron density surfaces as measures of molecular size and shape.

1. Click on . Select Cyclohexane from the Rings menu, and
click anywhere on screen.

2. Cyclohexane is still selected in the Rings  menu. Make certain
that the associated icon (at the top of the model kit) indicates
“eq” rather than “ax” (meaning that attachment is to be made
using an equatorial ring position). If not, click on the icon and
it will switch from “ax” to “eq”. Click on one of the equatorial
free valences of the cyclohexane ring on screen. The two six-
membered rings will be joined through their equatorial valences.

3. Rotate around the bond connecting the two cyclohexane rings
such that the axial free valences on the connecting carbons are
antito each other . This bond was the last bond formed and
should be encircled by a red marker. (If it is not, click on the
bond.) Then drag the mouse up and down while holding down
both the Alt key and the left button). Orient the molecule such
that the equatorial free valences on the cyclohexane carbons
one position removed from those which are already bonded
are in front of you and “poised” to form a third cyclohexane
ring (in a chair geometry).

4. Select sp3 carbon  from the model kit and, click on equatorial
free valences facing each other on both of the six-membered
rings you have just joined. The resulting structure should be
as follows.

  1 min/2 mins
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CH3

CH3

H

H

Click on  and, one after the other, click on free valences on
the two methyl groups you have just added which are in closest
proximity. This will lead to a third six-membered ring. Click
on . All three six-membered rings should now be in chair
geometries and the stereochemistry should be as in the figure
above. If not, you need to start over (select Clear from the
Edit menu), or “undo” the last operation (select Undo from
the Edit menu).

5. Click on C(sp3)  in the model kit. Click on equatorial free
valences on two appropriate positions of one of the external
six-membered rings (the “C ring”). Two methyl groups will
be added, from which the “D ring” is to be formed.

6. sp3 carbon is still selected. Click on a free valence on one of the
methyl groups added in the previous step to make it an ethyl
group. By appropriate bond rotations, position the “methyl”
and “ethyl” groups such that two free valences are in proximity.

7. Click on . One after the other, click on the two free valences
which have been made nearly coincident in the previous step.
A bond will be drawn forming a five-membered ring. Click on

; another refined (intermediate) structure will appear. All
that now remains is to add a carbonyl group on the “D ring”,
and to place the hydroxy and methyl substituents.

8. Click on C(sp3)  in the model kit. Click on the appropriate
axial free valence involving the “C” and “D” rings, and then on
the proper axial free valence involving the “A” and “B” rings.

9. Click on the O(sp3)  in the model kit. Add hydroxy to the
appropriate equatorial position on the “A ring”, and to the
carbon on the “D ring” which is to become the carbonyl carbon.
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Click on . Click on free valences on carbon and on oxygen
associated with the hydroxy group just added to the “D ring”.
A (distorted) carbonyl group will be formed. Click on  and
then on .

10. Androsterone incorporates several chiral centers. To assign
them as R or S, select Configure... (Model menu) and check
R/S under “Atom” in the dialog which appears. Click on OK.
R/S labels are attached to each of the chiral centers. (You can
remove them by selecting Labels from the Model menu.)

11. Select Calculations... from the Setup menu. Inside the dialog,
specify calculation of an equilibrium geometry at the AM1
semi-empirical level. Exit the dialog and submit the job. Name
it “androsterone_AM1”. Once completed, examine the output.
Note the large number of geometrical variables and the small
number of optimization cycles required.

12 to 14 optional

Compare the volume of a space-filling model to that obtained from
an electron density surface.

12. Select Properties (Display menu). This leads to the Molecule
Properties dialog. Note the surface area and the volume of a
space-filling (CPK) model.

13. Select Surfaces (Setup or Display menu). Click on Add....
Select density from the Surface menu and none from the
Property menu, and click on OK

14. Submit the job. When it has completed, enter the Surfaces
dialog and click the line “density . . .”. Enter the Properties
dialog, and click on any portion of the density surface. Both
the surface area and the volume of the electron density surface
appear. How do these compare with the corresponding
quantities based on the CPK model?

15. Remove androsterone and any remaining dialogs from the
screen.
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Tautomers of Nucleotide Bases

Protons bound to heteroatoms in heterocyclic compounds are likely
to be very mobile in solution and, where two or more heteroatoms
are present in a structure, different isomers (tautomers) may be in
equilibrium. As a case in point, consider the nucleotide base cytosine
(where a methyl group has replaced the sugar-phosphate backbone).

N

N

O

CH3

NH2

N

NH

O

CH3

NH

N

N

OH

CH3

NH

The existence of a low-energy tautomer could have far-reaching
consequences, given that cytosine is one of the nucleotide bases and
its valence structure is key to hydrogen bonding in DNA. In this
tutorial, you will examine the possible tautomers of 1-methylcytosine
for evidence of low-energy structures.*

1. Bring up the entry model kit ( ) and build 1-methylcytosine.
Start with Amide from the Groups menu. Select planar trigonal
nitrogen (instead of pyramidal nitrogen) for the external amino
group. Minimize and click on .

2. Note that the word “Tautomer” appears at the bottom right of
the screen. This indicates that tautomers exist for the structure
you have built. Select Tautomers from the Search menu (or
click on the  icon in the Search toolbar). Step through the
tautomers using the  and  keys at the bottom right of the
screen. To put the tautomers in a group, click on  to the right
of the step keys, and then click on OK in the dialog which results.

3. Enter the Calculations dialog with this group.** Specify a
single-point energy calculation using the 3-21G Hartree-Fock

* Note, however, that were the energy of an alternative tautomer only 3 kcal/mol higher than
that for the “normal” structure, this would translate into a relative abundance of only about
1% at room temperature. Thus, any alternative tautomers would need to be very close in
energy to the lowest-energy tautomer to have noticeable effect.

** 1-cytosine which you built remains on screen. Close it.

5 mins/30 mins
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model. Also, select AM1 from the menu to the right  of “Start
from” to indicate that semi-empirical geometries will be
employed.* Make certain that Global Calculations is checked
before you click on Submit at the bottom of the dialog. Name
the job “1-methylcytosine tautomers_3-21G”.

4. After the three calculations have completed, bring up the
spreadsheet and click on the line corresponding to the “normal”
structure for 1-methylcytosine (the one that you originally built).
Next, click on the header cell corresponding to the leftmost
blank column, then click on Add..., then select rel. E from the
available properties and kcal/mol from the Energy menu, and
finally, click on OK. Tautomer energies (relative to the “normal”
form) appear in the spreadsheet. Are either of the alternatives
close in energy to the normal form of 1-methylcytosine?

5 and 6 optional (cannot be completed with the Essential Edition)

To get a better estimate of relative tautomer energies, perform single-
point calculations using the localized MP2 (LMP2) model.

5. Make a copy of “1-methylcytosine tautomers_3-21G” ( ).
Name it “1-methylcytosine tautomers_LMP2_6-31Gs”. Enter
the Calculations dialog with this copy and specify Single Point
Energy from the menu to the right of “Calculate” and Møller
Plesset, MP2 and 6-31G* from the three bottom menus. Check
Localized to the far right of “Calculate”. Also, reset the menu
to the right of “Start from” to Initial. Finally, make certain
that Global Calculations is checked. Submit the job.

6. When it completes, bring up the spreadsheet (it should contain
the relative tautomer energies). Does the use of the correlated
LMP2 model change any of the earlier conclusions regarding
the likelihood of alternative tautomers?

7. Close whatever molecules and dialogs that remain on screen.

* This is done to save computer time. If you wish to use 3-21G geometries instead, select
Equilibrium Geometry (instead of Single Point Energy) from the menu to the immediate
right of “Calculate” and Initial (instead of AM1) from the menu to the right of “Start from”.
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Polyglycine

Triglycine and (optionally) decaglycine will be used to illustrate
construction of simple amino acid sequences using Spartan’04’s
peptide model kit, as well as to investigate the role of aqueous media
in altering the equilibrium between “neutral” and zwitterionic forms
and to show the utility of electrostatic potential maps in conveying
information about overall charge distribution.

1. Bring up the peptide model kit by clicking on , and then
clicking on the Peptide tab at the top of the entry model kit.

2. Make certain that Sequence is checked, and then click three
times on “gly” (glycine) from the selection of amino acid codes.
The sequence “gly-gly-gly” will appear in the box at the top
of the model kit.

3. α α α α α Helix near the bottom of the model kit should be selected. If
it is not, click on it. The backbone ψ and φ angles which define
an α helix will appear at the right. Click anywhere on screen.
Triglycine will appear, although it will not be properly
terminated.

5 mins/10 mins
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4. First consider the non-zwitterionic structure. Click on
Terminate in the model kit. The Terminate dialog will appear
allowing you to specify “C” and “N” terminating groups.

Select CO2H for the C terminating group (click on the icon to
cycle between groups), and NH2 for the N terminating group.
Click on OK.

Amino acids replace atomic fragments, functional groups, rings
and ligands as the basic building blocks in the peptide model kit,
and these other building blocks are missing. Therefore, most
modifications of peptides, aside from modifications in sequence
of amino acids and in overall conformation, need to be carried
out using either the entry or expert model kits.

5. Select Freeze Center from the Geometry menu (or click on
). Click on Freeze Heavy at the bottom right of the screen.

This indicates that all heavy (non-hydrogen) atoms are not to
be moved during molecular mechanics minimization.* Click
on  to produce a refined structure (subject to the restriction
that heavy atoms are kept in place).

6. Select New Molecule from the File menu. Click anywhere on
screen. Click on Terminate inside the model kit and this time
select CO2

– and NH3
+ for “C” and “N” terminating groups,

respectively. Click on OK. Click on  and then click on Freeze
Heavy at the bottom of the screen. Finally, click on .

7. Dismiss the model kit by clicking on . Both forms of
triglycine now occupy the same group. Enter the Calculations
dialog and specify a single-point energy calculation using the

* This is necessary to maintain the idealized helix structure.
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Hartree-Fock 3-21G model. Do not change Total Charge (from
Neutral) for the zwitterionic form of triglycine. Even though
its Lewis structure incorporates formal “+” and “-” charges,
the molecule is neutral. Also make certain that Global
Calculations is checked. Click on Submit at the bottom of the
dialog. Name the job “triglycine_3-21G”.

8. After the calculations complete, bring up the spreadsheet, click
on the header cell of an empty column, and click on Add... at
the bottom of the spreadsheet. Select E from the list of available
properties at the top of the dialog which appears, and kcal/
mol from the Energy menu, and then click on OK.

Which form of triglycine, zwitterion or non-zwitterion, is
favored in the gas phase?

9 to 10 optional (cannot be completed with the Essential Edition)

9. Make a copy of “triglycine_3-21G” ( ). Name it “triglycine
in water_3-21G”. Enter the Calculations dialog with this copy,
and again specify a single-point energy calculation using the
Hartree-Fock 3-21G model. Select Water for Solvent (to the
right of “Compute”). Submit the job. When completed (two
calculations), bring up a spreadsheet and enter the energies of
the two forms.

Which form of triglycine, zwitterion or non-zwitterion, is
favored in water? Rationalize any changes in relative energies
over the gas-phase results.

10. Remove “triglycine in water_3-21G” and remaining dialogs
from the screen.

11 to 15 optional

An electrostatic potential map for the zwitterionic form of a bigger
polypeptide, decaglycine, clearly shows charge separation to
“explain” why such a structure is not favored in the gas phase.
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11. Bring up the peptide model kit.* Click seven times on “gly”
(glycine) from the selection of amino acid codes. A sequence
of ten glycines has now been requested. Click anywhere on
screen. Click on Terminate in the model kit and select CO2

–

and NH3
+ for “C” and “N” terminating groups, respectively,

and then click on OK. Click on  and then click on Freeze
Heavy at the bottom of the screen. Click on , and then click
on  to dismiss the model kit.

12. Enter the Calculations dialog and specify a single-point energy
AM1 calculation. Check Converge (near the bottom right of
the dialog). Semi-empirical calculations on molecules of this
complexity often have trouble converging and this option
invokes a number of special convergence techniques.

13. Bring up the Surfaces dialog and request calculation of an
electrostatic potential map. Click on Add..., select density from
the Surface menu and potential from the Property menu, and
click on OK.

14. Submit the job. Name it “decaglycine zwitterion_AM1”.
Execution will take several minutes due primarily to calculation
of the graphic. When completed, again enter the Surfaces
dialog. Click on the line “density potential . . .”. Examine the
electrostatic potential map. Recall that colors near red
correspond to areas on the surface which are negatively charged
(attracted to a point-positive charge), while colors toward blue
designate regions of positive charge. Intermediate colors
(greens) represent neutral regions. What do you conclude about
the environment in which decaglycine wishes to exist?

15. Remove decaglycine and any remaining dialogs from the
screen.

* The following instructions assume that this section follows the building of triglycine, i.e.,
that the box at the top of the peptide model kit already contains a sequence of three glycines.
If you are starting from scratch, first make certain that Sequence is checked, then click ten
times on “gly”, then click on ααααα Helix and finally click anywhere on screen.
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Propamidine DNA Complex

Small molecules are known to be able to insert themselves into the
grooves of DNA. Binding may lead to changes in the structure of the
DNA strand (for example, changes in the spacing and orientation of
base pairs) and may act to inhibit DNA replication.

This tutorial serves to illustrate how “small molecules” may be
manipulated and examined in the presence of “big molecules”. You
will first examine the structure of a known complex, specifically that
of propamidine binding in the “minor groove” of a dodecamer. This
complex originates from the Protein Data Bank (PDB)*, but the PDB
file originally brought into Spartan’04 has been parsed into two
components of a list (the short strand of DNA and propamidine).
Additionally, water molecules have been eliminated. Finally, an
electrostatic potential map has been obtained for propamidine. The
parsed file (read only) has been written on the distribution media
under the name “propamidine DNA complex”.**

1. Locate and open “propamidine DNA complex” and make a
copy with the same name in your working directory. Then, bring
up the spreadsheet and reduce it to minimal size in order to see
only the names of the individual molecules “DNA strand” and
“propamidine”. Check both boxes to the right of the molecule
names such that both are simultaneously displayed on screen.

2. At the outset, both molecules are displayed as ball-and-spoke
models, and it is difficult to locate propamidine inside the DNA
strand. Select propamidine (click on its name in the spreadsheet)
and then select Space Filling from the Model menu. The two
components are now clearly distinguished and you can see
how closely they interlock.

Experiment with different model styles for each of these models.
To see how tight the fit really is, display both as space-filling
models. Another interesting display is to represent propamidine

* PDB designation 102D. C.M. Nunn and S. Neidle, to be published.
** Under the directory: Program Files/Wavefunction/Spartan04vXYZ/Tutorials
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as a space-filling model and the DNA strand using “ribbons”.
Select Hide and then Ribbons from the Model menu.

3. Another way to differentiate the components is by color. Bring
up both as space-filling models and, while holding down the
Alt key, click on any portion of the propamidine model. The
whole model will be selected (indicated by all atoms being
tinted “gold”). Select Properties from the Display menu,
giving rise to the “Selected” Style   dialog.

“Paint” propamidine such that it can be easily distinguished
from the DNA strand and click anywhere on the (propamidine)
model to lose the gold tint. Experiment with different
colorations. When you are done, reselect propamidine, and click
on Reset inside the “Selected” Style   dialog.

4. Display the DNA strand as a space-filling model and
propamidine as a tube or ball-and-spoke model. Select
propamidine and then bring up the Surfaces dialog (Setup or
Display menu). Note that an electrostatic potential map has
been requested but is marked “Pending” (meaning that it has
yet to be calculated). Make certain that Global Surfaces at
the bottom of the dialog is unchecked. Submit the job. When
completed, turn “on” the electrostatic potential map by
checking the yellow box in the dialog. These kinds of displays
may be used to supplement conventional models and provide
insight into the possible relevance of charge-charge interactions
on binding.

5. Remove “propamidine DNA complex” and any remaining
dialogs from the screen.
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* PDB designation 1A1T. R.N. de Guzman, Z.R. Wu, C.C. Stalling, L. Pappalardo, P.N. Borer
and M.F. Summers, Science, 279, 384 (1998).

** Under the directory: Program Files/Wavefunction/Spartan04vXYZ/Tutorials

Hydrogen Bonding in Biopolymers

Hydrogen bonding is known to be a decisive factor in determining
the three-dimensional structures of biopolymers. The base pairs in
complementary strands which make up DNA are “held together” by
hydrogen bonds. Helical structures in proteins are also maintained
by hydrogen bonds  as are neighboring strands in so-called β sheets.

This tutorial shows how different molecular models may be employed
to visualize an unusual protein-RNA complex*. In particular, it
illustrates the display of hydrogen bonds. No calculations are involved.

1. Locate and open “protein RNA complex”** and make a copy.
The structure, which comes up as a ribbon display (only),
determined from NMR, and several “alternative” conformers
have been provided. Step through them (  and ) to see where
they are similar and where they differ.

2. Select Configure... from the Model menu and click on the
Ribbons tab. Select By Residue under “Coloring” in the
Configure Ribbons dialog and click on OK. The model is
now colored according to amino acid/nucleotide base. Click
on the various “color bands” to see what they are.

3. Select Hydrogen Bonds (Model menu). Single “dotted lines”
represent hydrogen bonds throughout the “protein part” of the
complex, and “sets” of dotted lines in the “RNA” part. The
latter form the connections between nucleotide bases and the
number of lines in each set actually allows you to identify what
the bases are.

4. Select Tube (Model menu). Also, uncheck Hydrogens from
this menu. You can now see in greater detail the structure of
the complex and the positions of the hydrogen bonds.

5. Close “protein RNA complex”.
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Chapter 7
Inorganic and

Organometallic Molecules
This chapter shows how to construct inorganic and organometallic
molecules using Spartan’04’s expert model kit. It also describes
quantum chemical models suitable for use where transition metals
are involved.

The majority of organic molecules are made up of a relatively few
elements and obey conventional valence rules. They may be easily
built using the entry model kit. However, many molecules incorporate
other elements, or do not conform to normal valence rules, or involve
ligands. Most important among them are inorganic and organometallic
compounds involving transition metals. These need to be constructed
using the expert model kit.

Transition-metal inorganic and organometallic compounds may also
require different quantum chemical methods from those which are
satisfactory for organic molecules. In particular, Hartree-Fock models
have proven not to be suitable where transition metals are involved.
The PM3 semi-empirical model, which has been parameterized for
most transition metals, generally provides a good account of
equilibrium geometries, as do density functional models. The latter
are also believed to provide a satisfactory account of the
thermochemistry of reactions involving transition-metal systems,
although there is very little experimental data with which to compare.

The tutorials in this chapter illustrate construction of inorganic and
organometallic molecules, as well as the selection of suitable quantum
chemical models.
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Sulfur Tetrafluoride

S
F

F

F

F

Sulfur tetrafluoride cannot be constructed using Spartan’04’s entry
model kit. This is because sulfur is not in its “normal” bent dicoordinate
geometry, but rather in a trigonal bipyramid geometry with one of the
equatorial positions vacant. However, the molecule can easily be made
using the expert model kit.

1. Bring up the expert model kit by clicking on  and then
clicking on the Expert tab at the top of the model kit.

The expert model kit comprises a Periodic Table* followed by
a selection of “atomic hybrids”, then bond types, and finally

* Not all methods are available for all elements listed. Elements for which a specific method
(selected in the Calculations dialog) are available will be highlighted in the Periodic Table
if Element Overlay in the Miscellaneous Preferences dialog (Preferences... under the
Options menu; see Chapter 16) is turned “on”. Note also that elements beyond those listed
in the Periodic Table may be specified. For a discussion, see Atom Properties under the
Display menu (Chapter 14).

111
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Rings, Groups and Ligands menus (the first two of which
are the same as found in the entry model kit).

2. Select (click on) S in the Periodic Table and the five coordinate
trigonal bipyramid structure  from the list of atomic hybrids.
Click on screen. A trigonal bipyramid sulfur will appear.

3. Select F in the Periodic Table and the one-coordinate entry
 from the list of atomic hybrids. One after the other, click

on both axial free valences of sulfur, and two of the three
equatorial free valences.

4. It is necessary to delete the remaining free valence (on an
equatorial position); otherwise it will become a hydrogen. Click
on  and then click on the remaining equatorial free valence.

5. Click on . Click on  to remove the model kit.

6. Select Calculations... from the Setup menu. Specify
calculation of equilibrium geometry* using the Hartree-Fock
3-21G model.**

7. Submit the job. Name it “sulfur tetrafluoride_3-21G”.When
completed, select Properties (Display menu) and click on an
atom, e.g., sulfur. The charge on that atom will appear in the
(Atom Properties) dialog. Are the charges consistent with
covalent or ionic bonding?

8. Remove sulfur tetrafluoride and any remaining dialogs from
the screen.

* It should be noted that were an “incorrect geometry” specified at the outset, optimization
would lead to the correct structure, as long as the starting geometry possessed no symmetry
(C1 point group). Thus, square planar SF4 in D4h symmetry would remain square planar,
while an “almost” square planar structure (distorted only slightly from D4h symmetry to C1

symmetry) would “collapse” to the proper structure.
** The 3-21G(*) basis set, which incorporates a set of unoccupied d-type functions, is used in

place of 3-21G for the sulfur atom.
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Benzene Chromium Tricarbonyl

Cr
OC CO

CO

Comparison of electrostatic potential maps for this system and that
of free benzene will allow you to classify Cr(CO)3 as an electron
donor or an electron acceptor “substituent”.

1. Click on  and bring up the expert model kit. Select Cr from
the Periodic Table and the four-coordinate tetrahedral structure

 from the list of atomic hybrids. Click anywhere on screen.

2. Click on Ligands in the model kit, select Benzene from the
menu of available ligands.

Click on one of the free valences on the four-coordinate
chromium center.

3. Select Carbon Monoxide from the Ligands menu, and click
on the remaining (three) free valences on chromium. Click on

 to produce a refined structure.

4. Select New Molecule from the File menu. The screen will
blank. Build benzene and click on . Click on .

5. Select Calculations... (Setup menu). Specify calculation of
equilibrium geometry with the semi-empirical PM3 model.
Make certain that Global Calculations (at the bottom of the
dialog) is checked. You want the calculations to apply to both
benzene chromium tricarbonyl and benzene. Click on OK.

2 mins/30 mins
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6. Select Surfaces (Setup or Display menu). Click on Add....
Specify density from the Surface menu, and potential from
the Property menu, and click on OK. Make certain that Global
Surfaces is checked.

7. Submit the job (two separate calculations). Name it “benzene
chromium tricarbonyl_PM3”. When completed bring up the
spreadsheet (Spreadsheet from the Display menu), and check
the box to the right of the label for both entries. This allows
the two molecules to be displayed simultaneously on screen.
If Coupled (Model menu) is checked, remove the checkmark
by selecting it. This allows the two molecules to be moved
independently. Orient each molecule so that you can clearly
see the benzene face (exposed face in the case of the
organometallic).

8. Inside the Surfaces dialog, click on the line “density potential
. . .”. Compare electrostatic potential maps for both free and
complexed benzene, with attention to the “exposed face” on
benzene.* Is the effect of the Cr(CO)3 group to donate or to
withdraw electrons from the ring? Would you expect the
aromatic ring in benzene chromium tricarbonyl to be more or
less susceptible to electrophilic attack than free benzene? More
or less susceptible to nucleophilic attack?

9 optional (cannot be completed with the Essential Edition)

9. Repeat the two calculations using density functional theory.
Make a copy of “benzene chromium tricarbonyl_PM3” ( );
name it “benzene chromium tricarbonyl_BP_6-31Gs”. Inside
the Calculations dialog, specify a single-point energy
calculation using the BP/6-31G* model. Submit. When
completed, examine the electrostatic potential maps. Are they
qualitatively similar to those from the PM3 calculations?

10. Remove all molecules and any remaining dialogs from the
screen.

* Electrostatic potential maps (as well as other maps) for molecules in a group will be put onto the same
(color) scale. This allows comparisons to be made among different members.
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Ziegler-Natta Polymerization of Ethylene

Ziegler-Natta polymerization involves a metallocene. This first
complexes an olefin, which then inserts into the metal-alkyl bond.

Cp2Zr+R Cp2Zr+R
H2C CH2 Cp2Zr+CH2CH2R

H2C CH2 H2C CH2

RCp2Zr+

In this tutorial, you will use PM3 calculations to obtain a transition
state for insertion of ethylene into Cp2ZrCH3

+ and, (optionally),
estimate the activation energy using density functional calculations.

1. Bring up the expert model kit. Select Zr and , and click on
screen. Select C (  is still selected), and click on one of the
free valences on zirconium. Select Cyclopentadienyl from the
Ligands menu and, one after the other, click on two of the free
valences on zirconium. Select Ethylene (Ligands menu) and
click on the remaining free valence on zirconium.

2. Orient the methyl and ethylene as shown below.

Zr

C

C

C
Cp
Cp

d

c
b

a

3. Constrain the four distances a, b, c, d to 2.35Å, 2.05Å, 2.60Å
and 2.35Å, respectively. Click on , and repeat the following
steps for each of the four “bonds”. Click on the bond (or pair
of atoms) and then click on  at the bottom right of the screen.
The icon will change to . Type in the appropriate distance
and press the Enter key. When you are done, click on .

4. Bring up the Calculations dialog, and specify calculation of
equilibrium geometry using the PM3 model. You will need to
change Total Charge to Cation. Check Constraints to the
right of “Subject to”. Click on Submit at the bottom of the
dialog and name the job “Cp2ZrMe cation+ ethylene_PM3”.

5 mins/90 mins
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5. When the job has completed, again bring up the Calculations
dialog. Change Equilibrium Geometry to Transition State
Geometry. Remove the checkmark on Constraints and check
IR to the right of “Compute”. Click on Submit.

6. When the job has completed, bring up the IR dialog (Spectra
from the Properties menu and click on the IR tab) and click
on the imaginary frequency. Would you describe the process
as “concerted” or occurring in discrete steps?

7 to 9 optional (cannot be completed with the Essential Edition)

7. Perform single-point BP/6-31G* density functional
calculations to obtain an estimate for the energy barrier for
ethylene insertion. Make a copy of “Cp2ZrMe cation+
ethylene_PM3” ( ); name it “Cp2ZrMe cation+ethylene_
BP_6-31Gs”. Enter the Calculations dialog with this copy,
and specify calculation of a single-point energy using the
BP/6-31G* density functional model. Check Pseudopotential
at the far lower right of “Calculate” to specify use of a
pseudopotential for Zr associated with the 6-31G* basis set.
Remove the checkmark on IR (to the right of “Compute”).
Total Charge should still be set to Cation. Click on Submit.

8. Build both ethylene and Cp2ZrCH3
+ (name them “ethylene_BP_

6-31Gs” and “Cp2ZrMe cation_BP_6-31Gs”, respectively).
For Cp2ZrCH3

+, start with three-coordinate trigonal Zr, and
then add two cyclopentadienyl ligands and a four-coordinate
tetrahedral carbon. For each, enter the Calculations dialog,
and specify a single-point energy with the BP/6-31G* density
functional model. Select PM3 from the menu to the right of
“Start From”. For “Cp2ZrMe cation_ BP_6-31Gs” (only) check
Pseudopotential, and set Total Charge to Cation.

9. Submit both jobs. When they (and the transition-state
calculation) have completed, calculate an activation energy for
the insertion reaction.

10. Remove all molecules and any remaining dialogs from the
screen.
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Section III
Features and Functions

This section describes the functions available under the menus
incorporated into Spartan’04, and is intended to serve as a general
reference to the program. Available molecular mechanics and quantum
chemical methods are enumerated, but no commentary is provided
as to their performance or computational requirements. Similarly,
available graphical displays are enumerated but no description of
their use is provided. These issues are treated in detail in “A Guide
to Molecular Mechanics and Quantum Chemical Calculations”.
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The File Menu
This section describes operations under the File menu. This provides
model kits for building new molecules as well as access to the file
system to read and write Spartan files. It also provides input and
output of a variety of commonly-employed “external” file types,
including input of 2D structures (drawings). Operations under this
menu also allow construction of custom databases and provide
printing of text and on-screen graphics.

The File menu controls reading and writing of the file system, provides
initial access to model kits for molecule building, and allows for
printing of text and graphical displays.

New ( )

Brings up the entry model kit and clears the screen. Use of the entry
and other model kits is discussed in Chapter 12.

Open... ( )

Opens a file which contains all information associated with a particular
molecule (or list of molecules). Displays the molecular structure(s),
as well as any graphical surfaces and/or plots which were displayed

Chapter 8
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prior to the last save operation. Open... leads to a file browser from
which a single molecule (or list of molecules) needs to be selected.

Spartan can read several different types of files. These include several
file types which are “native” to Spartan.

.spartan Spartan’04 document

.spinput Spartan input (included in .spartan)

.sparchive Spartan archive (included in .spartan)

.spproparc Spartan property archive (included in .spartan)

.sxf Spartan exchange (use with molecule viewers)

.col Spartan collection (use with molecule viewers)

It can also read several “non-native” files containing 3D structure
information,

.mac MacroModel

.mol SYBYL Mol

.mol2 SYBYL Mol2

.pdb PDB

files containing 2D information (chemical structures),

.sdf MDL SDF

.skc MDL SKC

.tgf MDL TGF

and files containing 1D information.

.smi SMILES

Note that the Cartesian coordinates from any of these files may be
replaced by coordinates generated on the basis of atomic connectivity
alone. This is especially useful for “2D” input (structure drawing),
where the Z coordinate in the original file may be zero. Coordinate
replacement is accomplished using the Replace Coords. button in
the Molecule Properties dialog (Display menu; see Chapter 14).

Chapter 8 12/31/03, 8:07 AM120



121

In addition, several graphics file formats are supported.

.bmp bitmap

.jpg JPEG

.avi AVI

.png PNG

Except for .spartan files, these are all normally hidden from view,
and may be seen by selecting “All Files” under the Files of type
menu at the bottom of the browser.

Close ( )

Closes the selected molecule (or list of molecules to which the selected
molecule belongs), as well as the spreadsheet and any associated
graphical surfaces and/or plots and molecule specific dialogs. A prompt
for a name is provided if the molecule has not previously been saved.
Notification is also provided if a previously-saved molecule has been
altered and verification requested that any changes are to be saved.

Save

Saves the selected molecule (or list of molecules to which the selected
molecule belongs) exactly as it appears on screen, that is, rendered in
terms of a specific structure model and optionally with one or more
graphical surfaces, spectra and/or plots displayed. Opening the molecule
will bring it on screen exactly as it was last saved. If the molecule has
previously been named, Save does not lead to any further requests or
informative dialogs. Otherwise, Save behaves as Save As... (see below).

Save As... ( )

Saves the selected molecule (or list of molecules to which the selected
molecule belongs) exactly as it appears on screen, that is, rendered
in terms of a specific structure model and optionally with one or
more graphical surfaces, spectra and/or plots displayed under a user-
specified name. Files may be either be saved in “native” Spartan’04
format (the default) or in any of the formats listed under Open.
Selection is made under the Save as type menu in the Save As dialog.
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Save As can also be used to create custom databases of molecular
structures, energies and properties, supplementing the Spartan
Molecular Database provided with Spartan’04 (see Chapter 15).
In this case, the “.spentry” suffix needs to be specified. Full details
relating to database preparation are provided in Appendix H.

New Molecule

Brings up the entry model kit and clears the screen. This function is
identical to New, except that the resulting molecule is appended to the
end of the list associated with the molecule which is presently selected.*

Delete Molecule

Deletes from a list of molecules the molecule (or molecules) which
is (are) presently selected.

* Examples are provided in the tutorials Dienophiles in Diels-Alder Cycloadditions and
Hydration of Carbonyl Compounds in Chapter 4, Stereospecific Diels-Alder Reactions in
Chapter 5, Polyglycine in Chapter 6 and Benzene Chromium Tricarbonyl in Chapter 7.
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Append Molecule(s)...

Appends a file which contains all information associated with a
particular molecule (or list of molecules) onto the end of a list of
molecules associated with the molecule which is presently selected.*

Append Molecule(s)... leads to a file browser from which one or
more molecules (or lists of molecules) needs to be selected.**

Print...

Causes whatever is presently displayed on screen to be printed
(according to the specifications made in the Print Setup dialog; see
below). An output file as well as the contents of a spreadsheet may
also be printed. To print output, bring up and select an output window
(Output under the Display menu) and select Print Output... (which
has replaced Print...) from the File menu. To print the contents of
the spreadsheet, bring up and select a spreadsheet (Spreadsheet under
the Display menu) and select Print Spreadsheet... (which has
replaced Print...) from the File menu.

* An example is provided in the tutorial Carbene Additions to Alkenes in Chapter 5.
** Alternatively, molecules may be appended onto existing lists either by copy/paste operations

using the clipboard or by dragging from an external (to Spartan’04) window. Both require
that the destination list and its associated spreadsheet be open on screen.

Copy a molecule open on screen into the clipboard by first selecting (clicking on) it, and
then selecting Copy from the Edit menu. Alternatively, click on its entry (“molecule name”)
in its spreadsheet, and then select Copy from the Edit menu. The latter permits several
molecules to be selected (and copied) at once using the Shift and Ctrl keys in the usual
manner. (Note, however, that the clipboard holds only a single “copy”, and that any
subsequent copy operation overwrites the first.) Once on the clipboard, the molecule or
molecules may be moved to the destination list by clicking on an empty row header in the
spreadsheet (for the destination list), and then selecting Paste from the Edit menu.

Copy a molecule from an external (to Spartan’04) window, by first selecting the molecule,
and then dragging it from the external window onto the open spreadsheet (associated with
the destination list) inside of Spartan’04. Several molecules can be selected (and dragged)
at once using the Shift and Ctrl keys in the usual manner.
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Print Setup...

Results in a dialog specific to the available printer.

Specification usually involves designation of paper size, layout and
orientation, in addition to degree of enlargement. Color printers may
require additional information.

Exit

Exits Spartan’04, i.e., clears the screen and closes all molecules in
the window. A prompt for a name is provided for each molecule which
has not previously been saved.
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The Edit Menu
This section describes operations under the Edit menu. These provide
for “undoing” commands, copying screen images to and from the
clipboard, finding text and graphics, centering molecules on screen
and clearing the screen of the selected molecule.

Entries under the Edit menu serve a variety of functions.

Undo

This function “undoes” the last operation (only) from the Build menu:
Add Fragment, Delete, Make Bond, Break Bond, Minimize. Also,
“undoes” Clear from the Edit menu and  from Transition States
(Search menu). Undo may also be used to undo replacement of a
molecule or a set of molecules from the Spartan Molecular Database
(see Chapter 15). Otherwise, Undo is unavailable (dehighlighted).

Cut, Copy, Paste

These three functions transfer items to and from the clipboard. Cut
moves the selected item to the clipboard. The selected item is deleted.
Copy copies the selected item to the clipboard. The selected item is
unaffected. Paste transfers the contents of the clipboard to the
designated location. The contents of the clipboard are unaffected.
Only one snapshot at a time may be placed in the clipboard; selecting
Cut or Copy again will replace a previous snapshot with a new image.

Chapter 9
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There are four important uses of the clipboard within Spartan’04.

(i) Transferring on-screen graphics into other applications such
as Microsoft Word® and PowerPoint®.

(ii) Transferring data from a spreadsheet into other applications
such as Microsoft Excel®.

(iii) Temporary storage of a molecular structure for use in
molecule building. This is illustrated in the tutorial Vitamin
E in Chapter 6.

(iv) Making lists and/or transferring molecules between lists.

Cut and Copy operations for the first three require drawing a “selection
box”. To do this, first position the cursor slightly above and slightly
to the left of the item to be transferred. Then, while holding down
both buttons, drag the mouse to a location slightly below and slightly
to the right of the item to be transferred. Finally, release both buttons.

Further discussions relating to use of the clipboard in molecule building
is provided in Chapter 12 and for list operations in Chapter 14.

Find..., Find Next

Find locates a text string defined in the Find dialog if an Output
window is selected, or a structure sequence defined on the clipboard
if an on-screen model is selected. Find Next locates the next
occurrence of a text string or a structure sequence.

Center

Centers the selected molecule on screen, i.e., places the center of
geometry at the center of the screen.

Clear

Clears (deletes) all structures and other information for the selected
molecule, and brings up a model kit (if one is not already present). If
the molecule had previously been saved, no information is actually
removed from the file system until the molecule is again saved.
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The Model Menu
This section describes structure models available under the Model
menu: wire, ball-and-wire, tube, ball-and-spoke and space-filling
(CPK) models, with or without hydrogens, with or without hydrogen
bonds indicated and with or without atom labels, as well as ribbon
displays for polypeptides and polynucleotides, with or without labels
and with or without hydrogen bonds indicated. It also describes
functions for configuring atom labels to display element name, R/S
chirality, mass number, charge or chemical shift, and for specifying
color coding and display style for ribbon labels, as well as for turning
“on” and “off” a variety of other labels. Finally, it describes functions
which allow model style to be applied globally (to all members in a
list) and for models to be manipulated in concert.

Designation of model display style and model attributes are by way
of the Model menu.

Only one model style Wire, Ball and Wire, Tube, Ball and Spoke,
Space Filling or Hide) may be selected. The selected model is
designated by a “•” in front of its entry in the menu. Global Model,
Coupled, Hydrogens, Labels, Ribbons and Hydrogen Bonds
operate as “toggle” switches. A “ ” in front of the entry in the menu
indicates that it is turned “on”.

Chapter 10
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All of the available structure models, as well as any graphical surfaces,
may be displayed either in orthogonal or perspective projections. The
latter may be valuable in helping to visualize large molecules. Selection
is done in the Miscellaneous Preferences dialog under Preferences...
in the Options menu (see Chapter 16). Both structure models and
graphical displays may be presented in 3D stereo. This is also controlled
from the Miscellaneous Preferences dialog, or from the keyboard (see
Keyboard Functions in Chapter 2).

Wire

This display represents the molecule as a wire model where the
vertices represent the atoms.

The bonds are drawn in two colors, one for each of the atoms making
up the bond. Default atom colors are given in Table 10-1. These
apply globally (to all atoms of given type), and may be changed using
Colors under the Options menu (see Chapter 16). Colors of
individually selected atoms may be set using the Atom Style dialog
(under Properties in the Display menu; see Chapter 14). All models
use the same color scheme for atoms, and provide for the same
mechanism of changing colors globally or individually.

Ball and Wire

This display represents atoms by small balls and bonds by wires.

Ball-and-Wire Model

Wire Model
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Scandium-Zinc green
Yttrium-Cadnium green
Lanthanum-Mercury green

Helium orange
Neon orange
Argon orange
Krypton orange
Xenon yellow

main group main group (con’t)

Hydrogen white Bromine orange
Lithium tan Rubidium red
Beryllium green Strontium red
Boron tan Indium tan
Carbon gray Tin gray
Nitrogen blue-gray Antimony tan
Oxygen red Tellurium tan
Fluorine green Iodine tan
Sodium yellow
Magnesium blue transition metals
Aluminum purple
Silicon gray
Phosphorus tan
Sulfur sky blue
Chlorine tan noble gases
Potassium red
Calcium red
Gallium orange
Germanium gray
Arsenic orange
Selenium orange

Table 10-1: Default Atom Colors
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Tube Model

The balls are color coded according to atom type, and the wires
representing bonds are drawn in two colors (as in wire models).

Tube

This display is similar to the wire model, except that tubes instead of
wires are used to represent bonds.

Tubes may either be cylinders or be “split” to represent multiple bonds
depending on whether Split Tubes in the Miscellaneous Preferences
dialog (Preferences... under the Options menu; see Chapter 16) is
“off” or “on”. As in the wire representations, the bonds are drawn in
two colors.

Ball and Spoke

In this display, atoms are represented by balls (the size and color of
which depends on atom type), and bonds by spokes.

Spokes may either be cylinders or be “split” to represent multiple bonds
depending on whether Split Tubes in the Miscellaneous Preferences
dialog (Preferences... under the Options menu; see Chapter 16) is
“off” or “on”. Bond (spoke) color is gray by default but it may be
changed using Colors under the Options menu (see Chapter 16).
Colors of individually selected bonds may be set using the Bond Style
dialog (under Properties in the Display menu; see Chapter 14).

Ball-and-Spoke Model
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Space Filling

This represents the molecule as a composite of spheres, the size and
color of which depend on the atom type. Also known as CPK models,
space-filling models portray overall molecular size, the sphere radii
being chosen as approximating van der Waals contact distances. These
radii may be changed in the VDW Radii Preferences dialog under
Preferences... in the Options menu (see Chapter 16).

The volume and surface area displayed in the Molecule Properties
dialog (available under Properties in the Display menu; see Chapter
14) correspond to a space-filling model.

Hide

This removes the structure model from the screen where its display
may lead to unnecessary crowding, e.g., proteins. A model may be
restored by selecting it from the Model menu. Caution: Hide may
result in “loss of a molecule”. It can be “recovered” using the Page Up
or Page Down keys (see Keyboard Functions in Chapter 2) until its
name appears in the window title bar, followed by switching on a model.

Spartan’04 allows different parts of a molecule to be rendered in terms
of different model styles and colors. This is useful as a means to focus
attention on specific “interesting” regions while drawing attention away
from “less-interesting” regions. Regions may be individual atoms and/
or bonds or any collection of atoms and/or bonds connected or not. They
are selected in the usual manner, either by clicking on an individual atom
or bond or, with the aid of the Shift, Ctrl and Alt keys, by clicking on a
set of atoms and/or bonds, or by defining a selection box. Discussion has
already been provided in Chapter 2.

Space-Filling Model
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Once a region has been defined, control of model style and color is by way
of the “Selected” Style dialog under Properties in the Display menu.
This is described in Chapter 14, and an example is provided in the tutorial
Propamidine DNA Complex in Chapter 6.

Global Model

If checked, this signifies that all molecules in a list will share attributes.
These include presentation of hydrogens, atom and other labels,
hydrogen bonds and ribbon displays. Global model style is controlled
from the Molecule Preferences dialog (Preferences... under the
Options menu; Chapter 16) Global Model acts in a toggle manner,
i.e., repeated selection switches between “global” and “local” display.

Coupled

If checked, this signifies that all molecules in a list selected for
simultaneous display will be moved together. Coupled is turned “on”
following molecule alignment (see Align Molecules under the
Geometry menu; Chapter 11). Coupled acts in a toggle manner,
i.e., repeated selection couples and decouples the molecules.

Hydrogens

If checked, this signifies that hydrogens are to be included in the
model. Hydrogen removal is useful to simplify the displays of large
molecules e.g., polypeptides. Note that some structures, e.g., from
the Cambridge Structural Database or from PDB files, may lack
hydrogens. These then need to be “grown” before they can be
displayed (see discussion under Molecule Properties in Chapter
14). Hydrogens acts in a toggle manner, i.e., repeated selection turns
“on” and “off” the display of hydrogens.

Labels

If checked, this signifies that labels associated with atoms, ribbons
and bonds as well as with other attributes (points, planes, constraints
and frozen markers) specified in Configure... (see below) are to be
displayed in the model. Labels acts in a toggle manner, i.e., repeated
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selection turns “on” and “off” display of labels. Labels is
automatically turned “on” following selection of Apply or OK in the
Configure dialog (see below).

Ribbons

If checked, this signifies that ribbons are to be displayed along with
the selected model. (If only ribbons are desired, e.g., in proteins,
select Hide for the model.) Ribbons acts in a toggle manner, i.e.,
repeated selection turns “on” and “off” display of ribbons.

Hydrogen Bonds

If checked, this signifies that hydrogen bonds are to be drawn as part
of the model. Hydrogen bonds are defined as non-bonded contacts
between a  nitrogen, oxygen, phosphorous or sulfur and a hydrogen
attached to nitrogen, oxygen, phosphorous or sulfur separated by a
distance ranging from 1.6 to 2.1Å and making an X–H--Y (X,Y = N,
O, P, S) angle of >120°. Hydrogen Bonds  acts in a toggle manner,
i.e., repeated selection turns “on” and “off” display of hydrogen bonds.

Configure...

This selects the types of labels attached to atoms and ribbons, as well
as turns “on” and “off” labels on bonds, points, planes and constraint
markers. (Atom and ribbon labels are turned “on” and “off” using
Labels and Ribbons controls, respectively; see above.) Upon initial
entry, the Configure Labels dialog will appear.
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Atom labels may be selected from among the following (only one
selection is allowed): Labels (the default, a unique element/number
combination, may be changed; see Atom Properties in Chapter 14),
Element, Mass Number, R/S (chirality), Mulliken Charge,
Electrostatic Charge, Natural Charge, Chem Shift, or
Strand:Residue:Label (polypeptides and polynucleotides).

Check boxes allow turning “on” Bond Labels, Point Labels, Plane
Labels, Constraint Labels and Residue Labels.

Clicking on the Ribbons tab leads to the Configure Ribbons dialog.

Ribbon coloring may be selected from among the following (only one
selection is allowed): Monochrome, By Secondary Structure, By
Strand or By Residue. Ribbon style may be selected from among the
following (only one selection is allowed): Ribbons, Beads or Lines.

The dialog is removed from the screen with all selections maintained
by clicking on OK. Clicking on Cancel or on  removes the dialog
but selections are lost. Clicking on Apply maintains the selections
and leaves the dialog on screen. Note, that Labels (from the Model
menu) will be turned “on” following either clicking on OK or on Apply.
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The Geometry Menu
This section describes functions available under the Geometry menu.
These provide information about geometrical parameters (bond
lengths, angles and dihedral angles), as well as provision for defining
points and planes, for setting geometrical constraints, for freezing
atomic centers, for altering default bond and ring assignments and
introducing NOEs in conformational searching and for aligning
molecules in a list.

Information about the geometry of the selected molecule, as well as
provision for setting geometrical parameters, is available under the
Geometry menu. Functions under this menu also provide for defining
points and planes, for setting up geometrical constraints, for altering
default bond and ring assignments for conformational searching as
well as incorporating NOE data, and for aligning molecules in a list.

All functions under the Geometry menu require selection of one or
more atoms, points, or bonds, or a previously-defined constraint. This
is accomplished by clicking on the atom or bond or constraint. As
atoms are selected, each will be identified by a small gold sphere. As
bonds are selected, the two atoms connected by the bond will be
identified by small gold spheres. Selection of a distance constraint

Chapter 11
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results in two atoms being identified by gold spheres, an angle
constraint in three atoms identified, and a dihedral constraint in four
atoms being identified.

Measure Distance ( )

This obtains and displays the distance (in Ångstroms) between two
atoms, whether or not they are bonded, or the length of a bond (in
Ångstroms). Selection results in a message at the bottom left of the
screen.

Clicking on two atoms (points) displays the distance.

Alternatively, clicking on a bond or on a distance constraint displays
the bond or constraint length.

Measure Distance may also be used for distances involving user-
defined points (see Define Point in this chapter) and/or user-defined
planes (see Define Plane in this chapter). In addition, it may be used
to alter the distance between atoms (as long as both atoms are not
incorporated into the same ring), by altering the contents of the box
to the right of Distance (A,B) = or Length (A)=, and then pressing
the Enter key. The distance (length) may be entered into the
spreadsheet by clicking on  to the right of its display.

Note that the altered distance will not be maintained during
optimization. If this is what is desired, Constrain Distance should
be used (see discussion following).

Measure Angle ( )

This obtains and displays the angle (in degrees) involving three atoms,
or two connected bonds or a constraint. Selection results in a message
at the bottom left of the screen.
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Clicking on three atoms, or on two adjacent bonds, or on an angle
constraint, displays the angle at the bottom right of the screen.

Measure Angle may also be used for angles involving user-defined
points (see Define Point in this chapter) and/or user-defined planes
(see Define Plane in this chapter). In addition, it may be used to alter
an angle. This applies only where all three atoms are contiguous and
are not incorporated into the same ring. The angle may be changed
by altering the contents of the box to the right of Angle (A,B,C) =,
and then pressing the Enter key. The angle may be entered into the
spreadsheet by clicking on  to its right.

Note that the altered angle will not be maintained during
optimization. If this is what is desired, Constrain Angle should
be used (see discussion following).

Measure Dihedral ( )

This obtains and displays the dihedral angle (in degrees) involving
four atoms, three connected bonds or a dihedral constraint. Note that
the dihedral angle is defined as the angle between the plane made by
the first three atoms (or the first two bonds) specified, and the plane
made by the last three atoms (or the second two bonds) specified.
Selection results in a message below the menu bar at the bottom left
of the screen.

Clicking on four atoms, or on three adjacent bonds, or on a constraint,
displays the dihedral angle at the bottom right of the screen.

Measure Dihedral may also be used for dihedral angles involving
user-defined points (see Define Point in this chapter) and/or user-
defined planes (see Define Plane in this chapter). In addition, it may
be used to alter a dihedral angle. This applies only where no more
than two atoms are incorporated into a single ring. The dihedral angle
may be changed by altering the value inside the box to the right of
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Dihedral (A,B,C,D) = , and then pressing the Enter key. The dihedral
angle may be entered into the spreadsheet by clicking on  to its right.

Note that the altered dihedral angle will not be maintained during
optimization. If this is what is desired, Constrain Dihedral should
be used (see discussion following).

Freeze Center ( )

This allows “freezing” of one or more atoms during structure
minimization (in build mode) or (optionally) during equilibrium or
transition-state geometry optimization, or during a conformational
search, or generation of an energy profile using methods under the
Calculations dialog. Freezing inside the Calculations dialog needs
to be explicitly indicated (see Chapter 13).

Atom freezing is especially useful in a number of situations, among
them “guessing” transition-state geometries for reactions which are
closely related to those for which transition states are already available.
For example, a good guess at the transition state for pyrolysis of
cyclohexyl formate might be obtained by modifying the transition
state for pyrolysis of ethyl formate, freezing all but the modified
sections (designated in bold in the figure below) and then minimizing.*
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transition structure 
for ethyl formate

approximate 
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structure for 
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Selection of Freeze Center leads to a message at the bottom left of
the screen.

Clicking on an atom, or on a free valence**, “freezes” it; clicking
again “thaws” the atom (or free valence). Buttons at the bottom right

* An example of this is presented in the tutorial Carbene Additions to Alkenes in Chapter 5.
** The bond distance in this case is that appropriate for hydrogen being added to the free valence.
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of the screen allow for freezing all atoms (Freeze All), freezing all
heavy (non-hydrogen) atoms (Freeze Heavy) and for thawing all
atoms (Thaw All).

Another important use of frozen atoms is in conjunction with data resulting
from a search of the Cambridge Structural Database (see Databases under
the Search menu; Chapter 15). Hydrogen positions are more often than
not poorly located in X-ray structures, and X–H bond lengths are
commonly as much as 0.1 to 0.2Å shorter than they should be. Structures
incorporating such bond lengths are clearly inappropriate for energy and
property calculations and may also be problematic as starting geometries
in quantum chemical calculations. One solution is to “freeze” all heavy
(non-hydrogen) atoms (Freeze Heavy) and then to carry out molecular
mechanics minimization using either Minimize from the Build menu
(see discussion in Chapter 12) or from the Calculations dialog under
the Setup menu (see discussion in Chapter 13).

Frozen atoms are indicated by magenta colored markers ( ). Whether
or not these are included with the model (outside of “Freeze Center”
mode) for an individual molecule is controlled from the Molecule
Utilities dialog available under the Display menu (see Chapter 14).
Global settings are controlled from the Molecule Preferences dialog
under Preferences... in the Options menu (see Chapter 16).

Set Torsions ( )

Spartan’04 automatically identifies bonds and rings for
conformational searching and specifies default step sizes. Set
Torsions allows these defaults to be altered. Selection results in
flexible bonds each being marked by a gold cylinder, and flexible
rings each being marked by a gold circle around one or more atoms,
and a message appears at the bottom left of the screen.

Clicking on a bond or an atom contained in a ring selects it for rotation.
In the case of a ring, “rotation” means that the atom is to be “puckered-
up” and “puckered-down” (restricted rotation). The default rotation
is provided in a box to the right of Fold at the bottom right of the
screen. This is typically 2 or 3 for a single bond (step size of 180°
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and 120°, respectively) and 3 for a flexible ring. A value of “1”
indicates that the bond (ring) is not to be rotated (rotation by 360°).
Other integer values may be entered into the box, followed by pressing
the Enter key. The original (default) settings may be retrieved by
clicking on Defaults at the bottom right of the screen.

Six-membered rings are treated as special cases with only the
two “chair” conformers examined. This is indicated by two circles
on opposite atoms. Other conformers can be generated by
selecting additional ring atoms.

 and  buttons at the bottom right of the screen are available to
“step through” the possible single-bond conformers. Any conformer
can be selected in lieu of the initial structure. Alternatively, the full
set of conformers may be generated by clicking on  (to the right of
the step keys), and then clicking OK in the dialog which results.
Note, that duplicate conformers have not been removed.

Set Torsions is also used to specify non-bonded distances which need
to be kept below a threshold value. These follow for NOE (Nuclear
Overhauser Effect) measurements and may be referred to as NOE
conditions or simply NOEs. NOEs are specified by clicking on two
(non-bonded) atoms while holding down the Shift key. In response,
a message appears at the bottom of the screen.

Clicking on  changes it to  and enters the default value for the
NOE threshold into the box. This value can be changed. A line is
drawn between atoms which are to be kept within the threshold value.
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Once set, NOEs are used in conformational searching without further
user intervention.

Constrain Distance ( )

Constrain Angle ( )

Constrain Dihedral ( )

These allow introduction of one or more geometrical constraints
during structure minimization (in “build mode”), and (optionally)
during equilibrium or transition-state geometry optimization using
any of the available methods under the Calculations dialog (Chapter
13). The introduction of constraints is useful in a number of situations:

(i) constructing conformational energy profiles where one or more
dihedral angles need to be fixed while other geometrical
variables are optimized,

(ii) optimizing molecular structures where the values of certain
key parameters are known, for example, optimizing the
geometry of a molecule with an intramolecular hydrogen bond
or a disulfide linkage, and

(iii) building molecules with “unusual” geometrical parameters,
e.g., very long bonds, as for example required in the
construction of transition states* and intermolecular complexes.

Selecting Constrain Distance results in a message at the bottom left
of the screen.

Clicking on two atoms, or a bond results in a message at the bottom
right of the screen.

Clicking on  changes it to  and shows the current distance.

* An example of this is provided in the tutorial Ziegler-Natta Polymerization of Ethylene in
Chapter 7.
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This (constraint) distance can now be changed by altering the contents
of the box and then pressing the Enter key. Alternatively, the existing
distance may be used as the constraint distance. If the selected distance
had previously been constrained, the icon  would have been initially
displayed. In this case, clicking on  turns “off” the constraint and
returns the icon to the . Finally, the value of the constraint, which
may be different from the value of the current distance, may be entered
into the spreadsheet by clicking on  to its right.

This sequence of operations (bond identification followed by turning
“on” and “off” the constraint) can be repeated as many times as
necessary. Any bonds or non-bonded distances on which constraints
are to be imposed are indicated by magenta colored markers. Any
constraints introduced are automatically enforced only upon energy
minimization in build mode ( ), but are optional using methods under
the Calculations dialog (Chapter 13).

Angle and dihedral angle constraints are handled in a similar manner.
Note that points and planes may not be used to define constraints.

Constraints may also be modified as well as posted to the spreadsheet
from the Constraint Properties dialog (available under Properties
in the Display menu; see Chapter 14). In addition, a sequence of
constraints may be defined (from some initial value to some final
value in a given number of steps). This allows generation of an energy
profile along a predefined set of coordinates* (see Calculations in
Chapter 13).

Whether or not constraint markers are included with the model (outside
of “Constraint Distance, etc. mode”) for an individual molecule is
controlled from the Molecule Utilities dialog available under the
Display menu (see Chapter 14). Global settings are controlled from
the Molecule Preferences dialog (Preferences... under the Options
menu; see Chapter 16).

* Examples of this are provided in the tutorial Internal Rotation in Dimethylperoxide in
Chapter 5, and the tutorials Thermodynamic vs. Kinetic Control and SN2 Reaction of Bromide
and Methyl Chloride in Chapter 6.
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Define Point, Define Ligand Point ( )

This defines a point as the geometric (unweighted) center of selected
atoms (or points) previously defined. Selection results in display of a
message at the bottom left of the screen.

Clicking on atoms (or points) in any order, and clicking a second
time on any one of the atoms (or points) defines a point (small sphere).
As many points as desired can be defined and these are treated as any
other “atom” in defining distances, angles, etc. Points “move” with
the molecule as its geometry is altered.

Selecting Define Point (or clicking on ) while holding down on
the Shift key, followed by clicking on the appropriate atoms, leads to
a “ligand point”. This shares all the characteristics of a “normal”
point, but may also be used to bond to atomic fragments, functional
groups, etc. See Make Bond under the Build menu (Chapter 12)
for a discussion.

Delete from the Build menu ( ) or the Delete key may be
used to remove a point or ligand point.

Whether or not points are included with the model for an individual
molecule is controlled from the Molecule Utilities dialog available
under the Display menu (see Chapter 14). Global settings are
controlled from the Molecule Preferences dialog (Preferences...
under the Options menu; see Chapter 16).

Define Plane ( )

This defines and displays a reference plane. Selection results in display
of a message at the bottom left of the screen.

Clicking on three atoms or points defines a plane. As many planes as
desired may be defined, and these may be used in defining distances,
angles, etc. Planes “move” with the molecule as its geometry changes.
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Delete from the Build menu ( ) or the Delete key may be
used to remove a point.

Whether or not planes are included with the model for an individual
molecule is controlled from the Molecule Utilities dialog available
under the Display menu (see Chapter 14). Global settings are
controlled from the Molecule Preferences (Preferences... under the
Options menu; see Chapter 16).

Align Molecules ( )

This allows for alignment of molecules in a list by best matching the
coordinates (and optionally atom type) of selected atoms. Selection
results in a message at the bottom left of the screen.

Atoms may be selected by clicking on them, at which time they are
marked by a red circle. Clicking a second time also selects the atom
(marking them with two concentric circles) but instructs the alignment
procedure to ignore the atom type (atomic number). Clicking a third
time deselects (and unmarks) the atom. Selected atoms are marked
by a single red circle if atom type is to be considered, and by two
concentric red circles if atom type is to be ignored. At least three
(non-colinear) atoms need to be selected for alignment to be
meaningful, and it is recommended that no more than five atoms be
selected. Following selection of atoms, clicking on the Align button
at the bottom right of the screen aligns the molecules. Note that atom
selection is not lost, and molecules can be “realigned” by again
selecting Align Molecules and clicking on Align.

Note that the motions of different molecules in a list are automatically
coupled following molecule alignment. They can be decoupled by
selecting Coupled from the Model menu (see Chapter 10).
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The Build Menu
This section describes functions available under the Build menu.
These include model kits and associated tools for building organic,
inorganic and organometallic molecules as well as polypeptides and
polynucleotides, in addition to a molecular mechanics procedure for
preliminary structure refinement.

Functions required for building and refining molecules are collected
under the Build menu.

Selection of Add Fragment results in display of one of four model
kits: an entry model kit for most organic molecules, an expert model
kit for organic molecules not easily represented in terms of classical
valence structures, as well as inorganic and organometallic molecules,
and specialized model kits for polypeptides and polynucleotides. The
entry and expert model kits utilize “atomic fragments”, functional
groups and rings (and ligands in the expert model kit), while the
peptide model kit uses the set of natural amino acids as building
blocks, and the nucleotide model kit the set of nucleotide bases. Once
selected, a model kit remains on screen until View is selected.

Molecule construction in all four model kits proceeds much in the
same manner as a chemist would assemble a structure from a model
kit, i.e., pieces are taken from the “kit” one at a time and added
sequentially to the molecule under construction.

Chapter 12
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Entry Model Kit

Spartan’04’s entry model kit contains a suite of molecule building/
editing tools specifically designed to construct most organic molecules.

In the center of the model kit are a selection of “atomic fragments”
displayed as icons.

From left to right and then top to bottom, these correspond to:

C(sp3) N(sp3) P(sp3) H
C(sp2) N(sp2) O(sp3) F
C(sp) N(sp) O(sp2) Cl
C(aromatic) N(aromatic) S(sp3) Br
Si(sp3) N(planar) S(sp2) I
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An “atomic fragment” is chosen by clicking on its icon, following
which this icon is displayed at the top of the dialog. Once selected, the
atomic fragment can be used to initiate building, to add alongside of
an existing structure or appended onto an existing molecular fragment.
To initiate building, click anywhere on screen. To add alongside of an
existing structure, first click on Insert at the bottom right of the screen
(or press the Insert key), and then click anywhere on screen. To bond
to an existing fragment, click on a free valence. Selection of bond
type, i.e., single, double, triple or aromatic, in the case of atomic
fragments with multiple bond types, e.g., sp2 carbon, occurs
automatically depending on the nature of the free valence selected.

Three menus inside the entry model kit provide access to a number
of pre-built fragments corresponding to common functional groups
(Groups) and rings (Rings), and to additional libraries of functional
groups, rings and ligands (as well as any user-defined structures)
stored in the file system (Custom). The entry model kit also has
access to the clipboard (Clipboard).

(i) Groups
Clicking on Groups brings up a menu of available
functional groups, and results in an icon of one
group from this menu being displayed at the top of the
model kit.

A different group may be selected from the menu (its
icon will be displayed). Once selected, a functional group
may then be used to initiate building by clicking anywhere
on screen, to add alongside of an existing structure on
screen by clicking on Insert at the bottom right of the
screen (or pressing the Insert key), and then clicking
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anywhere on screen, or to add to an existing structure by
clicking on the appropriate free valence.

The amide and carboxylic acid groups have two different
types of atoms with free valences. The amide group
actually has three different free valences, one on carbon
and two on nitrogen. The free valence which will be
used to connect these groups to a molecule under
construction is marked with a “•” (in the icon). The
marked position circulates among the possible positions
with repeated clicking on the icon.

C N

O
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C N

O •

C N
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Additional functional groups are found in a library
accessible from Custom (see discussion following).

(ii) Rings
Clicking on Rings brings up a menu of available rings,
and results in an icon of one ring from this menu being
displayed at the top of the model kit.

A different ring may be selected from the menu (and its
icon displayed). Once selected, a ring may then be used
to initiate building by clicking anywhere on screen, to
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add alongside of an existing structure on screen by
clicking on Insert at the bottom right of the screen (or
pressing the Insert key), and then clicking anywhere
on screen, or to add to an existing structure by clicking
on the appropriate free valence.

Cyclohexane, napthalene, anthracene and phenanthrene
rings have more than one kind of free valence. The free
valence which is used to connect these rings to the
molecule under construction is marked with a “•” (in
the icon). As with groups, the marked position circulates
among the available positions with repeated clicking on
the icon. Selection of an axial or equatorial free valence
in the cyclohexane ring is indicated by the label “ax” or
“eq” appearing alongside the icon.
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Note that all rings in this menu are hydrocarbons.
Heteroatoms may be substituted using the atom
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replacement feature available in conjunction with the
entry and expert model kits (see discussion of General
Molecule Building Functionality following).

Additional rings are found in a library accessible from
Custom (see discussion following).

(iii) Custom
Custom is used to select any molecule or molecular
fragment which has been previously saved in
Spartan’04’s file system for use in molecule building.
To access the file system, click on the rightmost down
arrow key to the right of the Custom menu. This gives
rise to the usual file browser. Select (click on) an entry
and click on Open (or double click on the entry). The
selected molecule is identified by its name (or by
“M001”, etc. if no name has previously been supplied)
in the menu immediately to the right of Custom. Select
it and a ball-and-wire model will appear at the top of
the model kit. This may be manipulated (rotated,
translated, zoomed) using the usual mouse/keyboard
commands (you need to position the cursor inside the
box containing the model). Once selected, the molecule
or molecular fragment may be used to initiate building
by clicking anywhere on screen, to add alongside of an
existing structure by clicking on Insert at the bottom
right of the screen (or pressing the Insert key), and then
clicking anywhere on screen, or to add to an existing
structure by clicking on the appropriate free valence. In
the latter case, the attachment point (on the molecule in
the clipboard) needs to be identified by clicking on the
appropriate free valence.

Only one entry from the file system is allowed, and
selection of a new entry will overwrite the previous entry.
However, in the event that the selected entry is a list of
molecules, each of the individual members (as identified
by their names or by “M001”, “M002”, etc.), may be
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selected in turn (by selecting different entries from the
menu to the right of Custom).

Upon installation, Spartan’04 is setup for Custom to
point to a directory “Program Files/Wavefunction/
Spartan04vXYZ/Library”. This contains (among other
things) a selection of “rings” and “ligands”.

(iv) Clipboard
Clicking on Clipboard accesses the clipboard (see Cut
and Copy under the Edit menu in Chapter 9 for
discussion of adding to the clipboard). A ball-and-wire
model of whatever is on the clipboard is displayed at
the top of the model kit. This may be manipulated using
the usual mouse/keyboard commands (you need to
position the cursor inside the box containing the model).
Once selected, the molecule or molecular fragment may
be used to initiate building by clicking anywhere on
screen, to add alongside of an existing structure by
clicking on Insert at the bottom right of the screen (or
pressing the Insert key), and then clicking anywhere
on screen, or to add to an existing structure by clicking
on the appropriate free valence. In the latter case, the
attachment point needs to be identified by clicking on
the appropriate free valence in the clipboard.

An “empty” clipboard will be signaled by:

Expert Model Kit

Spartan’04’s expert model kit allows construction of a much wider
class of molecules (including inorganic and organometallic species)
than permitted using the entry model kit. Structures which violate
conventional bonding rules may also be constructed, as this model kit
purposefully provides no checking. The expert model kit is reached
by clicking on the tab marked Expert which is located at the top of the
entry (or peptide or nucleotide) model kit. (Return to the entry, peptide
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or nucleotides model kit is accomplished by clicking on the Entry,
Peptide or Nucleotide tab, respectively,  in the expert model kit).

 

At the top of the model kit is a Periodic Table covering the first four
rows of main-group elements, and all three rows of transition metals.*

Main-group elements appear at the top and transition metals at the
bottom.

If Element Overlay (Miscellaneous Preferences dialog under
Preferences... in the Options menu; see Chapter 16) is checked,
elements which are available for the selected level of calculation
(Calculations dialog under the Setup menu; see Chapter 13) will
be highlighted. Immediately below is a selection of atomic hybrids.

* The remaining elements may be specified using the Atom Properties dialog under the
Display menu (see Chapter 14) although computational models may not be available.

Chapter 12 12/31/03, 8:14 AM152



153

Following this, is a selection of bond types.

Further down the model kit below the buttons marked Groups, Rings
and Ligands (the first two of which are the same as found in the entry
model kit).

Selection of atom type is effected by clicking on the appropriate
element in the Periodic Table. The entry will be highlighted.

Selection of an atomic hybrid follows by clicking on the appropriate
icon which will then be highlighted. Once fully specified, the “atom”
(atom type + atomic hybrid) can be used to initiate building, to add
alongside of an existing structure or to append onto an existing
molecular fragment. To initiate building, click anywhere on screen.
To add alongside of an existing structure, first click on Insert at the
bottom right of the screen (or press the Insert key), and then click
anywhere on screen. To bond to an existing fragment, click on the
appropriate free valence.

Two of the hybrids (trigonal bipyramidal and square-based pyramidal)
may bond either axially or equatorially. Selection of the appropriate
bonding point, marked by a “•”, is effected by repeatedly clicking on
the icon; the bonding point alternates between the two sites.

• X
click

X

•

X

•

X
•click

click

click

All atoms are initially connected with single linkages. Bond types
(partial single, single, aromatic, double, triple or quadruple) may be
changed by first selecting the appropriate bond type from those
available, then clicking on the bond to be changed, and then clicking
again to institute the change, i.e., double clicking on the bond. Bond
types have no impact on quantum chemical calculations, but do affect
molecular mechanics calculations (including structure minimization
in the builder; see discussion following).
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Unlike the entry model kit, no valence checking is performed in the
expert model kit. The user is free to construct any arrangement of
atoms. Note, that molecular mechanics parameters may be poor, and
“unreasonable” minimized geometries may result.

Three fragment collections are located inside the expert model kit:

(i) Groups
This contains the same groups as in the entry model kit.

(ii) Rings
This contains the same rings as in the entry model kit.

(iii) Ligands
This provides access to a number of pre-built ligands, useful
in the construction of inorganic and organometallic molecules.
Its operation is analogous to that for the Groups and Rings
menus. Clicking on Ligands brings up a menu of available
ligands, and results in an icon of one ligand from this menu
being displayed at the top of the model kit.

A different ligand may be selected from the menu (and its icon
displayed), and then used to initiate building by clicking anywhere on
screen, to add alongside an existing structure on screen, by clicking
on Insert at the bottom right of the screen (or pressing the Insert
key), followed by clicking anywhere on screen, or may be added to an
existing structure by clicking on the appropriate free valence.

Additional ligands are found in a library accessible from Custom in
the entry model kit. Ligands may also be built with the help of Define
Point under the Geometry menu (Chapter 11).
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Peptide Model Kit

Spartan’04 provides a model kit for construction of polypeptides. It is
reached by clicking on the tab marked Peptide which is located at the
top of the entry, expert and nucleotide model kits. (Return to the entry,
expert or nucleotide model kit is accomplished by clicking on the Entry,
Expert or Nucleotide tab, respectively,  in the peptide model kit.)

At the middle of the peptide model kit are icons designating the amino
acids (specified by their usual three-letter codes).

An amino acid is selected by clicking on its three-letter code, following
which either an icon of the amino acid is displayed in the box at the
top of the model kit, or the three-letter code for the amino acid is
appended to the sequence of codes in the box. Amino acids replace
“atoms”, functional groups, rings and ligands as the building blocks
in the peptide model kit. Because these other building blocks are
missing, modifications of  peptides, aside from modifications in
sequence and in overall conformation, need to be carried out using
the entry or expert model kits.

Chapter 12 12/31/03, 8:14 AM155



156

There are two different modes of operation: single amino acid mode
and polypeptide mode. The former is used to initiate building with a
single amino acid, to add a single amino acid alongside of an existing
structure or to add a single amino acid to an existing structure, while
the latter is used to construct amino acid sequences (polypeptides).
Sequence “off” (unchecked) corresponds to single amino acid mode,
and “on” (checked) corresponds to polypeptide mode.

Peptide construction (Sequence “on”) is accomplished in three steps:

(i) Specification of an amino acid sequence. This is
accomplished by clicking in the desired order on the
amino acid codes. Building occurs from the “N” end  to
the “C” end of the peptide. In response to each selection,
the three-letter code is appended to the sequence of codes
in the box at the top of the model kit. The stereochemical
configuration of the amino acid is by default the l
configuration; this can be changed to the d configuration
prior to selection of the amino acid, by checking d to the
right of “stereoisomer” in the model kit. (It can be
changed back to l by checking l). d amino acids are
indicated by “.d” following the code in the box.

The sequence can be altered by changing the text in the
box. Existing amino acid codes can be deleted or
changed or new codes can be added. The entire sequence
can be specified in this way if desired. Specification of
a non-existent code will result in an error message. The
sequence can be cleared by clicking on Clear.

(ii) Specification of macroscopic structure. Once sequencing
is complete, macroscopic structure (ψ and φ angles), is
specified by clicking  on one of α α α α α Helix, β β β β β Sheet or
Other. In the case of the first two, preset angle values
are displayed on the right. In the case of specification of
Other, boxes appear, into which the desired dihedral
angles need to be entered.
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(iii) Termination. The peptide is not yet terminated, and the
two ends are still set up for addition of further amino
acids, i.e.,

O

C

*

C end

N

H

*

N end

where the “*” indicates a free valence. Clicking on
Terminate at the bottom of the model kit leads to the
Terminate dialog.

C and N terminating groups may be selected by repeated
clicking on the C and N icons, respectively. Selection
will rotate among the available terminating groups.
Clicking on OK removes the dialog and terminates the
polypeptide. Clicking on Cancel or on  removes the
dialog but does not terminate the polypeptide.

The peptide (or single amino acid) may now be used either to initiate
building, by clicking anywhere on screen or added alongside of an
existing structure, by first clicking on Insert at the bottom right of
the screen (or pressing the Insert key), followed by clicking anywhere
on screen. If unterminated, it may also be joined onto an existing
structure by clicking on a free valence. In the latter case, attachment
is made from the “N end”, unless the free valence corresponds to an
“unterminated” peptide fragment, in which case the appropriate end
required to make an amide bond is used.
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Nucleotide Model Kit

Finally, Spartan’04 provides a model kit for construction of
polynucleotides. It is reached by clicking on the tab marked Nucleotide
which is located at the top of the entry, expert and peptide model
kits. (Return to the entry, expert or peptide model kit is accomplished
by clicking on the Entry, Expert or Peptide tab, respectively, in the
nucleotide model kit.)

At the middle of the model kit is a menu designating the type of
polynucleotide.

DNA
DNA (single strand)
DNA-RNA
RNA
RNA (double strand)
RNA-DNA

Immediately below this menu are icons, designating the nucleotide
bases. Selection of DNA, DNA (single strand) or DNA-RNA from
the menu leads to one set of icons.
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Selection of RNA, RNA (double strand) or RNA-DNA leads to a
second set, the only difference is that uracil (U) has been substituted
for thymine (T).

A nucleotide base is selected by clicking on its letter, following which
either an icon of the base is displayed in the box at the top of the
model kit, or the letter for the base is appended to the sequence of
letters in the box. Nucleotide bases replace “atoms”, functional groups,
rings and ligands as the building blocks in the nucleotide model kit.
Because these other building blocks are missing, modifications of
nucleotides, aside from modifications in sequence and helical structure,
need to be carried out using either the entry or expert model kits.

There are two different modes of operation: single base mode and
polynucleotide mode. The former is used to place a single base or base
pair on screen, to add a single base or base pair alongside of an existing
structure, or to add a single base or base pair to an existing structure,
while the latter is used to construct strands of DNA or RNA (or mixed
strands). Sequence “off” (unchecked) corresponds to single base (base
pair) mode and “on” (checked) corresponds to polynucleotide mode.

Polynucleotide construction (Sequence “on”) is accomplished in two
steps:

i) Specification of base sequence. This is accomplished by
clicking in order on the base codes. In response to each
selection, the letter code is appended to the sequence of codes
in the box at the top of the model kit. The sequence can be
altered by editing the contents of the box. Existing base codes
can be deleted or changed or new codes added. The entire
sequence can be specified in this way if desired. The sequence
can be cleared, by clicking on Clear.

ii) Specification of helical structure. Once sequencing is complete,
a helical structure may be specified by clicking on A, B or Z.
These correspond to “standard” A, B and Z helices, respectively.
Selecting Other allows user modification of  the rise (in Å) per
base (Rise/Base) and twist (in degrees) per base (Twist/Base).
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Note that the polynucleotide is not yet terminated, and the two ends
are still set up for addition of further bases or base pairs.

O

O

CH2OPO2Base *

“*” indicates a free valence. Hydrogens occupy all free valences
(except the *’ed positions at the two ends of the chain).

The polynucleotide (or single base pair) can now be used to either
initiate building, by clicking anywhere on screen, added alongside of
an existing structure, by first clicking on Insert at the bottom right of
the screen (or pressing the Insert key) followed by clicking on screen,
or joined onto an existing structure by clicking on a free valence. In
the latter case, attachment is made from the “phosphate” end.

General Molecule Building Functionality

Bond Rotation/Bond Stretching

In addition to molecule rotation, translation and scaling, the mouse
is used to rotate about and stretch bonds not incorporated into rings.
This is accomplished via the following sequence of operations:

(i) Clicking on the desired bond. The selected bond is marked by
a red cylinder. (The bond connecting the last “atom”, functional
group or ring  added to the molecule is automatically selected.)

(ii) Simultaneously pressing the Alt key and the left mouse button
while dragging the mouse, for bond rotation, or the Alt key and
the right mouse button for bond stretching.

Atom/Fragment Replacement

Another function of the mouse is atom replacement. Double clicking
on an atom (not a free valence) while an atomic fragment in the entry
model kit or an atom icon in the expert model kit is highlighted,
replaces this atom by the selected atom icon. Atom replacement
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functions differently in the entry and expert model kits. In the entry
model kit, free valences are adjusted to accommodate the replacement,
e.g., replacement of sp3 carbon by sp3 oxygen results in two free
valences being removed. Atom replacements which violate valence
rules or which would disrupt substituents are not permitted. In the
expert model kit, atom replacement merely changes the atomic
number. No changes in the number or arrangement of free valences
is made, and no checking is done. Atom replacement is not presently
available in the peptide and nucleotide model kits.

Chirality Inversion

Finally, double clicking on a  chiral atom with the Ctrl key depressed
inverts the chirality of the atom (R→S or S→R). This function is
available in all four model kits, but may not be used in some ring
systems where its use might lead to unacceptable structures. Where
there is only a single chiral center, chirality inversion has the effect
of changing enantiomer.

View ( )

This exits build mode, and removes the model kit from the screen (if
it was previously displayed). Selection permits display of more than
a single molecule on screen. Features available in build mode which
actually alter molecular geometry are unavailable.

Initial entry into build mode is by way of New under the File
menu (see Chapter 8). Add Fragment, Delete, Make Bond,
Break Bond and Minimize are for modifying existing structures.

Add Fragment ( )

This allows access to the libraries of atomic fragments, functional
groups, rings and ligands* as well as the clipboard. If a model kit is
already on screen, clicking on an atomic fragment, atom, etc., icon,
or on the Groups, Rings, Ligands, Custom or Clipboard button

* Replaced by amino acids in the peptide model kit and nucleotide bases in the nucleotide
model kit.
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leads to “add fragment” mode. If a model kit is not on screen, selection
of Add Fragment results in a model kit being placed on screen. This
accomplished, a fragment may be used to initiate building by clicking
anywhere on screen, to add alongside an existing structure on screen
by clicking on Insert at the bottom right of the screen (or pressing
the Insert key) followed by clicking anywhere on screen, or be added
to an existing structure by clicking on the appropriate free valence.

Fragment addition can be terminated by selection of any other function.

Delete ( )

This allows both atom and/or free valence removal from a structure,
as well as deletion of points, planes and/or constraints.* Selection
results in a message at the bottom left of the screen.

Subsequent clicking on an atom, free valence, a point, a plane or a
constraint results in its deletion. Deletion of an atom results in deletion
of all of its associated free valences. Free valences for any atoms to
which the deleted atom was previously connected are restored. Note
that atom deletion may result in one or more detached fragments.
See Using the Mouse in Chapter 2 for a discussion of how to
manipulate detached fragments independently or in concert.

Selection of Delete does not bring up a model kit nor does it remove
a model kit which is present on screen.

Atom deletion can be terminated by selection of any other function.

Deletion may also be accomplished by holding down on the Delete
key while clicking on the atom, free valence, etc.

* Delete is also used to delete spectral plots (see Spectra under the Display menu, Chapter
14) as well as individual curves in a plot or entire plots (see Plots under the Display menu,
Chapter 14).
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Make Bond ( )

This allows bonding between free valences and/or atoms on different
centers. Selection results in a message at the bottom left of the screen.

Subsequent clicking on two free valences (on two different atoms)
will cause these atoms to be linked by a single bond. Alternatively,
double clicking on each of two atoms will bond them, and clicking
on a free valence on one atom and double clicking on a different
atom will bond the two atoms. If the two atoms involved in the
selection are already bonded, this will result in the bond order being
increased by one, i.e., single → double, double → triple. An atom
cannot be bonded to itself, and any attempt to do so will lead to an
error message.

Where available, free valences are consumed as a result of bond
formation, irrespective of whether free valences or atoms are selected.

• •

Note, however, that in the absence of available free valences a bond
will still be made between atoms.

•
•F F

FF
F

F

F

F

F

F F

F F
FF

FF
FF

• •
F F F F

This is particularly useful for constructing hypervalent arrangements.
Note that free valences can be “protected” without altering the
molecule by adding hydrogens to them (  from the entry model kit).

Selection of Make Bond does not bring up a model kit nor does it
remove a model kit which is already present on screen.

Bond creation can be terminated by selection of any other function.
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Break Bond ( )

This allows breaking an existing bond resulting in free valences.
Selection results in a message at the bottom left of the screen.

Subsequent clicking on a bond will result in its breaking; the free
valences on the respective atoms will automatically be restored. Note
that bond breaking may result in detached fragments. See Using the
Mouse in Chapter 2 for a discussion of how to manipulate detached
fragments independently or in concert.

Selection of Break Bond does not bring up a model kit nor does it
remove a model kit which is present on screen.

Bond deletion can be terminated by selection of any other function.

Minimize ( )

The molecular geometry resulting from building may be refined using
molecular mechanics based on the MMFF force field. Selection results
in a message at the bottom left of the screen.*

The strain energy as it is commonly known, displayed at the bottom
right of the screen, is continually updated during the minimization
process. At any time, minimization may be stopped by clicking on
the  icon at the bottom right of the screen.

Any geometrical constraints imposed on the structure (see Constrain
Distance, Constrain Angle, Constrain Dihedral in Chapter 11)
are enforced during minimization. Also, any frozen atoms (see Freeze
Center in Chapter 11) remain “frozen”. NOEs are not taken into
account.

With a model kit already on screen, Minimize reverts back to Add
Fragment following completion. With no model kit on screen,
Minimize does not revert to Add Fragment.

* Outside of “build mode”, and if there are results which will be destroyed as a result of
structure minimization, selection leads to a warning message.
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Chapter 13
The Setup Menu

This chapter describes functions available under the Setup menu.
These specify molecular mechanics calculations, semi-empirical
calculations, Hartree-Fock molecular orbital calculations, and
correlated calculations, including local density calculations, density
functional calculations, Møller-Plesset calculations and coupled
cluster calculations for ground-state species, and configuration
interaction calculations, local density calculations and (time
dependent) density functional calculations for excited-state species.
Tasks include calculation of energy, equilibrium structure and
conformation, transition-state structure and constructing energy
profiles, although not all tasks are available for some methods. A
wide variety of all-electron Gaussian basis sets are supported for
Hartree-Fock and correlated calculations as are pseudopotentials
for calculations on molecules incorporating heavy elements.

Functions under the Setup menu also permit inclusion of solvent by
way of molecular dynamics, specify calculation of IR, NMR and UV/
visible spectra, calculation and printing of a variety of molecular
properties, and designation of graphical surfaces, including electron
and spin densities, electrostatic potentials, local ionization potentials
and molecular orbitals, for later display as surfaces, property maps
and contour plots. Also provided under the Setup menu is a facility
for submitting jobs for calculation.

The Setup menu provides access to dialogs for specifying molecular
mechanics and quantum chemical calculations, as well as specifying
graphical displays and for submitting jobs for calculation.
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Calculations...

Calculations modules perform: molecular mechanics calculations
using the SYBYL and MMFF force fields; MNDO (MNDO/d where
second-row and heavier elements are involved), AM1 and PM3 semi-
empirical calculations, including PM3 calculations on transition-metal
inorganic and organometallic systems; Hartree-Fock molecular orbital
calculations; local density calculations; BP, BLYP, EDF1 and B3LYP
density functional calculations; Møller-Plesset calculations through
fourth order and localized MP2 (LMP2) calculations; coupled cluster
calculations; configuration interaction calculations (for excited-state
species). A wide selection of basis sets is available, ranging from the
STO-3G minimal basis set (Hartree-Fock models only), to the 3-21G
split-valence basis set (Hartree-Fock models only), to 6-31G*,
6-31G** and cc-pVDZ polarization basis sets to the more extensive
6-311G*, 6-311G**, cc-pVTZ and cc-pVQZ basis sets. In addition,
pseudopotentials for “heavy elements” are available. All basis sets,
except for STO-3G and 3-21G may be supplemented with additional
polarization functions and/or diffuse functions.

The “Essential Edition” of Spartan’04 for Windows permits
calculations on ground-state species only, and with molecular
mechanics, semi-empirical and Hartree-Fock models only.
STO-3G, 3-21G, 6-31G* and 6-311G* basis sets only, with
extensions for additional polarization functions and/or diffuse
functions are supported. These and other differences are dealt
with at the end of this section.

Discussion of molecular mechanics and quantum chemical methods
in general, and of the specific methods available in Spartan’04 is
provided in “A Guide to Molecular Mechanics and Quantum
Chemical Calculations”. This guide also provides a brief discussion
of ways in which the different methods may be effectively and
efficiently combined, and a description of graphical models and
modeling techniques.
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Quantum chemical calculations, in particular, also result in a variety
of atomic and molecular properties as well as infrared, UV/visible
and NMR spectra. These are available for selected models. Finally,
solvent effects on molecular energies and properties may be obtained
by way of a procedure in which the system is “immersed” in a box of
solvent and a molecular dynamics simulation performed.

Selection of Calculations... results in the Calculations dialog.

This contains a number of pull-down menus, buttons and text boxes:

(i) Calculate
This section contains a series of menus and check boxes
which, taken together, specify the task to be
accomplished, the electronic state (“ground” or “excited”)
the type of calculation, method and basis set to be
employed and details specific to each calculation type.

Specification of Task is by way of a pull-down menu:
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Single Point Energy applies to all methods. Equilibrium
Geometry, Equilibrium Conformer, Conformer
Distribution and Energy Profile apply to all methods
except MP3, MP4, CCSD, CCSD(T), G3(MP2), G3,
CIS(D) and excited-state density functional methods.
Transition State Geometry applies to all methods except
molecular mechanics methods and MP3, MP4, CCSD,
CCSD(T), G3(MP2), G3, CIS(D) and excited-state
density functional methods. Additionally, MP2 methods
based on localized orbitals are available for single-point
energy calculations only. Finally, note that Equilibrium
Conformer and Conformer Distribution revert to
Equilibrium Geometry in the event that the molecule
has only a single conformer.

Specification of State (electronic state) is by way of a
pull-down menu. The default setting Ground may be
changed to Excited by clicking on  to the right of the
box and back again to Ground by clicking on . Different
methods are available to handle ground and excited state
species. Hartree-Fock, Møller-Plesset as well as a variety
of advanced correlated methods are available only for
ground-state species, while configuration interaction
methods are available only for excited-state species.
Density functional methods are available for both ground
and excited state species. State is ignored for molecular
mechanics and semi-empirical calculations.

Specification of Type of Calculation is by way of a
pull-down menu. Selections in the menu depend on
electronic state. For ground-state species:

For excited-state species:
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All calculation types except for Hartree-Fock require
specification of additional information:

Molecular Mechanics

Semi-Empirical

Density Functional

Møller-Plesset

Advanced Correlated*

Configuration Interaction

Except for molecular mechanics and semi-empirical
methods, either restricted or unrestricted methods can
be used. By default, singlets are described using
restricted methods and non-singlets are described using
unrestricted methods. The default selections may be
overridden using the Scf keyword (see Appendix C).

Except for molecular mechanics and semi-empirical
methods, a basis set needs to be specified.** For Hartree-
Fock methods:

* A number of other advanced correlated methods are available, and may be entered directly
into the Options box: CCSD(2), OD, OD(T), QCCD, QCCD(2), QCISD, QCISD (T) and G2.

** A number of other basis sets are available, and may be entered directly into the Options
box: 6-31G or 6-311G followed by: (d), (d,p), (2d), (2d,2p), (2df, 2pd), (3d, 3p), (3df, 3pd);
6-31G or 6-311G with “++” inserted before G; cc-pVDZ and cc-pVQZ.

Chapter 13 12/31/03, 8:16 AM169



170

3-21G refers to use of the 3-21G representation for first row,
main-group elements as well as for transition metals, but use
of the 3-21G(*) basis set which incorporates a set of d-type
functions for second-row and heavier main-group elements.

For all other methods:

                     
The combination of a method, e.g., B3LYP, and a basis set,
e.g., 6-31G*, constitutes a theoretical model or more simply
a model. The nomenclature is to separate method and basis
set by a “/”, e.g., B3LYP/6-31G*. By convention, specification
of Hartree-Fock (HF) as a method is optional and specification
of basis set alone refers to Hartree-Fock models, e.g., both
HF/6-31G* and 6-31G* refer to combination of the Hartree-
Fock method and the 6-31G* basis set. Methods without basis
sets, e.g., MMFF (molecular mechanics) and PM3 (semi-
empirical) are themselves models.

An additional control, Localized, appears only where a
single-point energy using the MP2 model has been
requested. If checked, Localized signifies that an MP2
calculation is to be based on Hartree-Fock orbitals that
have been localized. This reduces computation time by
a small amount (the reduction becomes greater with
increasing molecular size), but leads to significant
reduction in required memory and disk. The resulting
method is referred to as localized MP2 or LMP2.

An additional control, Density, appears only where a
single-point energy using either MP2 or CIS models has
been requested. If checked, Density signifies that the
post-Hartree-Fock density matrix is to be evaluated (in
addition to the energy). This leads to a significant
increase in computation time, but is required if properties
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(dipole moments, charges, etc.) or graphical surfaces
are to be based on the post-Hartree-Fock wavefunction
(rather than on the Hartree-Fock wavefunction). Post-
Hartree-Fock density matrix evaluation is required (and
is performed automatically) for equilibrium and
transition-state geometry determination. The control is
not available for localized MP2 models.

If checked, Pseudopotential signifies that a
pseudopotential is to replace the all-electron basis set for
heavy elements. In effect, this limits description of heavy
elements to valence electrons only.* Pertains to Hartree-
Fock, density functional, Møller-Plesset and advanced
correlated (except G3(MP2) and G3) calculations only,
and only for third-row and heavier elements. Does not
pertain to STO-3G and 3-21G basis sets. For availability
and description of pseudopotentials in Spartan’04, consult
the on-line help facility (Chapter 17).

An additional control, IRC (Intrinsic Reaction
Coordinate), appears when a transition-state geometry
has been requested using Hartree-Fock, density
functional or MP2 models. If checked, IRC signifies that
the resulting transition state will be used to generate a
pathway (an intrinsic reaction coordinate) leading first
to reactant and then to product. (It is advisable, although
not necessary, to compute the IR spectrum prior to
calculation of an intrinsic reaction coordinate.) The full
sequence of steps: reactant → transition state → product,
will be placed in a file “xxx.IRCn” where “xxx” is the
name given to the molecule and “n” is a number (1, 2...).
The default number of steps in the sequence (40) may be
changed using the keyword “IRCSteps” (see Appendix
C). IRC is not presently available for semi-empirical
models. IRC is not available in the Essential Edition.

* Some pseudopotentials also take account of electrons occupying the shell immediately below
the valence shell.
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(ii) Start from
Spartan’04 allows calculations from one model to be
preceded by equilibrium geometry calculations at
another (simpler) model, for example, Hartree-Fock
calculations to be preceded by semi-empirical geometry
calculations. (This feature does not apply to transition-
state geometry calculations.) Available choices depend
on the method selected:

molecular mechanics not available

semi-empirical

Hartree-Fock

density functional, Møller-Plesset,
advanced correlated

In addition, geometry optimization may be preceded by
a search for the lowest-energy MMFF conformer. In this
case, selection leads to an additional menu specifying
the level of calculation to be employed for geometry
optimization. The contents of this menu depend on the
method selected:

molecular mechanics not available

semi-empirical not available

Hartree-Fock

density functional, Møller-Plesset,
advanced correlated
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(iii) Subject to

Spartan’04 allows calculations to be carried out in the
presence of geometrical constraints or with atoms which
have been frozen in place. In addition, Spartan’04
attempts to make full use of symmetry.

If checked, Constraints signifies use of any previously
defined constraints on distances, angles and dihedral
angles into equilibrium and transition-state geometry
optimization, conformation searching and generation of
energy profiles. Does not apply to single-point energy
calculations. See Chapter 11 for information about
constraining geometrical parameters.

NOE data are not treated as constraints by Spartan, but rather
as “post-calculation filters” in establishing conformer
distributions.

If checked, Frozen Atoms signifies that the coordinates
of any atoms that have previously been “frozen” will
not be moved during equilibrium and transition-state
geometry optimization, conformation searching and
generation of energy profiles. Does not apply to single-
point energy calculations. See Chapter 11 for
information about freezing atoms. See also discussion
in Chapter 15 regarding the freezing of heavy atoms in
structures resulting from a search of the Cambridge
Structural database.

If checked, Symmetry signifies that molecular symmetry
is to be employed wherever possible to simplify the
calculation. By default Symmetry is checked.

(iv) Compute

Entries under this section request calculation of a number
of “important” spectral quantities, as well as solvent
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effects using a molecular dynamics model*. Other
quantities such as the dipole moment and LogP** which
are “less costly” are calculated automatically, whereas
calculation of still others may be requested from the
Options box (see discussion following).

Solvent (not yet implemented as of version 1.01)

This accesses a menu which either specifies none (gas-
phase calculation) or the name of a solvent into which
the system is to be immersed, in preface to a molecular
dynamics calculation.

The mixed mechanics/quantum mechanics molecular dynamics
procedure employed by Spartan’04 to estimate solvent effects
on energies and properties comprises the following steps:

1. “Immerse” the system (“substrate”) in a box of the selected
solvent such as to maintain the normal density (of the
solvent) at room temperature. The box typically contains
on the order of 200-300 solvent molecules.

2. Perform a “preliminary” molecular dynamics simulation
using “gas-phase” substrate charges, dipole moment, etc.
This simulation, as well as the “full” simulation performed
in step 4, assumes that both the substrate and the solvent
are rigid, and that only intermolecular geometrical variables
are explored. Solvents with two or more conformers are
treated as (Boltzmann-weighted) collections of the different
conformers.

3. Calculate a solvent term to be added to the one-electron
Hamiltonian (of the substrate) based on electrostatic

* For gas-phase calculations, the aqueous solvation energy is estimated using the SM5.4
procedure of Cramer, Truhlar and co-workers (C.C. Chambers, G.D. Hawkins, C.J. Cramer
and D.G. Truhlar, J. Phys. Chem., 100, 16385 (1996)). This is added to the “gas phase”
total energy and written to the output. This sum is also available in the spreadsheet (see
Chapter 14).

** LogP is estimated both according to the method of Ghose, Pritchett and Crippen (J.
Computational Chem., 9, 80 (1988)), and of Villar (J. Computational Chem., 6, 681 (1991);
Int. J. Quantum Chem., 44, 203 (1992)), and written to the output. Both Ghose-Crippen and
Villar LogP values may also be brought into the spreadsheet (see Chapter 14).
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interactions involving the solvent charges and averaged
over 20-50 molecular dynamics configurations. Perform a
quantum chemical calculation one the substrate using this
additional term and obtain a new set of atomic charges, a
new dipole moment, etc.

4. Perform a “full” simulation using the new set of charges, etc.

5. As in step 3, calculate a solvent term to be added to the
one-electron Hamiltonian and, using this term, perform a
quantum chemical calculation on the substrate.

The result is a wavefunction appropriate for the substrate
immersed in solvent, from which a total energy* as well
as molecular properties and graphical surfaces may be
obtained. These take the place of the corresponding gas-
phase quantities in the molecule archives, and all
references to these archive (from dialogs, the
spreadsheet, etc.) refer to the “solvated” system.

Solvent calculations are presently restricted to water and
are applicable to all calculation methods which produce
a wavefunction. Molecular mechanics calculations, in
particular, are excluded.

UV/vis

If checked, specifies that a single-point excited-state
calculation will be performed (following a ground-state
calculation) and that state-to-state energy differences will
be reported.

UV/vis calculations are presently restricted to Hartree-
Fock models (when the CIS model is used for the excited
state) and to local density and density functional models
(where the corresponding time-dependent density
functional models are used for the excited state).

* The total energy also includes a van der Waals term to account for direct solute-solvent
interactions. This is based on an average of representative molecular dynamics configurations.

Chapter 13 12/31/03, 8:16 AM175



176

IR

If checked, calculates vibrational frequencies and
corresponding normal modes of vibration. These are then
available in the output (Output under the Display menu,
see Chapter 14) along with selected thermodynamic
properties (entropies* and free energies). Vibrational
modes may be animated and an IR spectrum displayed
from the IR dialog accessible from Spectra under the
Display menu (see Chapter 14).

Second derivatives required for frequency calculation
are evaluated analytically for molecular mechanics,
semi-empirical, Hartree-Fock, local density and density
functional models. Other models involve numerical
differentiation of analytical first derivatives.

NMR

If checked, specifies that NMR chemical shifts will be
calculated. These are then available in the output
(Output under the Display menu, see Chapter 14) as
well as from the Atom Properties dialog (Display
menu). 13C (proton decoupled) and 1H (shifts only)
spectra may be displayed from the NMR dialog
accessible from Spectra under the Display menu (see
Chapter 14). In both cases, line intensities are assumed
to be proportional to the number of equivalent carbons
or hydrogens. Coupling constants are not presently
available and only Hartree-Fock models are supported.

(v) Total Charge
Total charge. The default setting Neutral may be
changed either by clicking on  to the right of the box,
and selecting Anion, Dianion, -3, etc. from the menu
which appears, or by replacing any menu entry by a

* Note that the vibrational contribution to the entropy goes to ∞ as frequency goes to 0. This is
a consequence of the linear harmonic oscillator approximation and is incorrect. Vibrational
entropy contributions from frequencies below 300 cm-1 should be treated with caution.
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numerical value. Total Charge is ignored for molecular
mechanics calculations.

(vi) Multiplicity
Spin multiplicity. The default setting Singlet may be
changed either by clicking on  to the right of the box,
and selecting instead Doublet or Triplet from the menu
which appears, or by replacing any menu entry by a
numerical value. Multiplicity is 1 for singlets, 2 for
doublets, 3 for triplets, 4 for quartets, etc. Multiplicity
is ignored for molecular mechanics calculations.

(vii) Print
Entries under this section, request printing of a number
of common quantities. Printing of additional quantities
may be requested from the Options box (see below).

Orbitals & Energies
If checked, writes the molecular orbitals and orbital
energies to the output. HOMO and LUMO energies are
also available from the Molecule Properties dialog
under the Display menu (see Chapter 14), as well as in
the spreadsheet (Chapter 14).

Thermodynamics
If checked, writes thermodynamic quantities to
the output. Requires that vibrational frequencies (IR
under “Compute”) have been calculated. Selected
thermodynamic quantities are also available in the
spreadsheet (Chapter 14).

Vibrational Modes
If checked, writes vibrational frequencies and normal
modes to the output. Requires that vibrational
frequencies (IR under “Compute”) have been calculated.

Atomic Charges
If checked, writes Mulliken, natural and electrostatic-fit
charges to the output. Atomic charges are also available
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from the Atom Properties dialog (Display menu;
Chapter 14) and in the spreadsheet (Chapter 14).

(viii) Options
Additional features affecting calculations are invoked
using keywords entered into the box to the right of
Options. Keywords may be either single words or
expressions. Keyword=N indicates an integer argument,
and keyword=F indicates a real argument. Appendix C
contains a listing of commonly-used keywords. A more
complete up-to-date listing is found under on-line help.

(ix) Converge
If checked, invokes procedures to assist in convergence.
Use of Converge will generally increase computation
time. Converge does not apply to molecular mechanics
calculations.

(x) Global Calculations
If checked, signifies that settings in the Calculations
dialog are to be applied to all members of the list.

The Calculations dialog may be exited by clicking on Submit,
Cancel or OK at the bottom right of the dialog, or on  at the top
right. (Submit and OK will be deactivated if the job is already
executing.) Clicking on OK or on Submit overwrites any previous
information. Additionally, Submit enters the job in the execution
queue (see discussion later this chapter). Clicking on Cancel or on

 exits the Calculations dialog without saving any changes.

The Calculations dialog in the Essential Edition of Spartan’04
for Windows differs primarily in the “Calculate” section.

The Task menu is the same but the Type of Calculation menu is
restricted to molecular mechanics, semi-empirical and Hartree-
Fock models.
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The Basis Set menu (Hartree-Fock models only) is identical
except that pseudopotentials are not available.

Additionally, intrinsic reaction coordinate (IRC) calculations,
molecular dynamics solvent calculations (Solvent under
“Compute”) and UV/visible and NMR spectra (UV/vis and NMR
under “Compute”) are not available in the Essential Edition. IR
spectra (IR under “Compute”) are available, but the required
second-derivative calculations are performed numerically rather
than analytically and are significantly slower.

Surfaces

Spartan’04 provides for graphical display of the molecular orbitals, the
electron density, the spin density for open-shell systems (the difference
in electron densities arising from the α and β spin manifolds), the
electrostatic potential (the energy of interaction of a point positive charge
with the nuclei and electrons of a molecule), and the local ionization
potential (a measure of the ease with which electrons are detached from
a region of space). These may be represented as a surface of constant
value (an isosurface), and displayed as an “arrangement of dots”, a mesh,
or a fully-lighted opaque or translucent solid. Some examples of graphical
output in orthogonal projection are reproduced in grayscale in Figure
13-1. Surfaces (like other graphical objects) may also be rendered in
perspective (see Chapter 10) and in stereo (see Chapter 2).

Additionally, any one of the quantities listed above (except the electron
density) may be mapped onto any surface (except a molecular orbital
surface). In practice, the only maps which have received widespread
attention are those based on the electron density surface (depicting
overall molecular size and shape). For example, the electrostatic
potential may be mapped onto a surface of electron density, yielding
an electrostatic potential map, which portrays both steric and
electrostatic characteristics. Mapping is via the use of color; colors
toward blue represent one extreme value of a property and colors
toward red represent the other extreme.
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showing the lone pairs on nitrogen and
oxygen, respectively.

showing bonding in the transition state.

showing hydrogen bonding. showing accessibility for nucleophilic attack.

showing interaction of the HOMO of
1,3-butadiene and the LUMO of ethylene.

showing overall molecular size and shape.

Frontier orbitals for a symmetry-allowed
Diels-Alder reaction,

Space-filling model and electron density
surface (0.002 electrons/au3) of cyclohex-
anone,

Electron density surface (0.08 electrons/au3)
of transition structure for pyrolysis of ethyl
formate,

Electrostatic potential surfaces (-10 kcal/mol)
of trimethylamine (left) and dimethyl ether
(right),

Electron density slice for acetic acid dimer, Simultaneous display of the LUMO and the
electron density surfaces of cyclohexanone,

Figure 13-1: Examples of Graphical Displays Available in Spartan’04
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Finally, calculated quantities may also be displayed as two dimensional
contour plots (“slices”). Unlike surfaces and maps, these can be
manipulated (translated and rotated) independently of the molecular
skeleton. An example of a slice display is provided in Figure 13-1.

Several different surfaces, maps and slices may be simultaneously
displayed. This allows visual comparison of different surfaces, of
different properties or both. In addition, any of the usual structure
representations (skeletal, ball-and-wire, tube, ball-and-spoke and
space-filling models) may be displayed along with the encoded
surfaces. The total graphical display can become very complex, and
selective use of meshes and/or translucent solids (as opposed to
opaque solids) may be needed to facilitate visualization.

Discussion of the utility of graphical models for describing molecular
structure and chemical reactivity, including numerous examples, is
provided in “A Guide to Molecular Mechanics and Quantum
Chemical Calculations”.

The following are among the most useful graphical surfaces and
property maps:

HOMO demarks electron-rich areas such as lone pairs

LUMO demarks regions susceptible to nucleophilic attack

density demarks chemical bonds and indicates overall
molecular size and shape

spin density demarks location of unpaired electrons (radical sites)

electrostatic quantifies electron-rich/electron-poor regions, for
potential map example, as related to acid and base sites

LUMO map quantifies regions accessible to nucleophilic attack,
for example, regio and stereochemical differences

local ionization quantifies regions accessible to electrophilic attack,
potential map for example, regio and stereochemical differences

Selection of Surfaces from the Setup menu results in display of the
Surfaces dialog.
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The box at the top of the dialog identifies graphical surfaces for later
calculation and display. The Add... button at the bottom of the dialog
is used to specify new graphical surfaces. Clicking on it leads to the
Add Surface dialog which contains three menus and a check box:

(i) Surface

Available surface types appear in a menu to the right of
Surface.

Available surfaces are the electron density at isosurface
values which provide indication of overall molecular
size (density) and of location of chemical bonds (density
(bond)), the molecular orbitals (HOMO{-}, HOMO,
LUMO, LUMO{+}, SOMO), the electrostatic potential
(potential), the local ionization potential (ionization)
and the spin density (spin).
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The local ionization potential does not go to zero far
removed from the molecule. This makes its use as a surface
problematic, although it does not affect its value as a
property mapped onto a density surface.

Selection of “HOMO{-}” and “LUMO{+}” results in
display of a box alongside of the entry, e.g.

This contains a decrement value from the HOMO and
increment value from the LUMO, allowing any
molecular orbital to be specified.

Selection of Slice designates that the surface will be a
2D plane (a slice) cut through the graphic defined by
Property (see below).

(ii) Property

Properties available for mapping onto surfaces appear
in a menu to the right of Property.

Available properties are the electron density (density),
the molecular orbitals (HOMO{-}, HOMO, LUMO,
LUMO{+}, SOMO), the electrostatic potential
(potential), the local ionization potential (ionization)
and the spin density (spin). none indicates that no
property is to be mapped onto the surface). As with
Surface above, selection of “HOMO{-}” and
“LUMO{+}” leads to a decrement (increment) box.

In addition, a “spin button” will be displayed in the event
that Multiplicity (in the Calculations dialog) is set to a
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value other than Singlet, or if “Scf=unrestricted” has
been specified under Options in the Calculations
dialog. Then it will be available (highlighted) only if
HOMO{-}, HOMO, LUMO or LUMO{+} has been
selected for Surface or for Property. Clicking on the
button toggles it between Alpha and Beta. Alpha
designates that the molecular orbital either to be
displayed as a surface or mapped as a property onto a
surface will come from the α spin manifold; Beta
designates that the molecular orbital will come from the
β spin manifold.

(iii) Resolution
Selection of surface resolution is from the menu to the
right of Resolution.

Medium resolution generally is of sufficient quality for
routine work, low resolution is used to get rough images
very quickly, while intermediate and high resolution may
be employed to obtain graphics suitable for publication.
Both calculation time and disk storage requirements
increase significantly with increasing resolution.

(iv) IsoValue

This allows a fixed (single-valued) isosurface to be
generated in place of a three-dimensional grid of points
(from which different isosurfaces, slices and/or property
maps can be constructed). While this is less flexible, it
is entirely sufficient in the majority of cases, in particular,
in dealing with property maps which are nearly always
based on a density surface representing overall molecular
size and shape. Fixed isosurfaces and property maps
based on fixed isosurfaces are much less costly than non-
fixed isosurfaces (maps), both in terms of computer time
and disk space.
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* Actually, the job is submitted to a job queue and will be submitted for execution only when
released from this queue. See Monitor under the Options menu (Chapter 16) for discussion.

Checking the box to the left of Fixed leads to display of
the isovalue (0.002 in the case of density). This value
may be changed. Fixed may not be specified in
conjunction with Slice as a Surface.

Following Surface, Property, Resolution and
(optionally) spin selection, clicking on OK adds the
requested graphic to the list and removes the (Add
Surface) dialog. Clicking on Cancel does not add a
graphic to the list but removes the (Add Surface) dialog.

The process (clicking on Add..., surface and property
selection, clicking on OK) may be repeated as required.

An existing graphic may be deleted from the list by first
highlighting (clicking on) it and then clicking on Delete.

Global Surfaces, if checked, signifies that the requested
surfaces will be calculated for all members of the list.

Only one copy of the Surfaces dialog may appear on screen, and any
actions relate to the currently selected molecule. The dialog may be
removed by clicking on .

Submit

Following setup of a molecular mechanics or quantum chemical
calculation, and/or request for generation of graphics files, the required
calculations are actually performed using Submit under the Setup
menu. If the job has not previously been named, selection of Submit
triggers a request for a name (see Save As...; Chapter 8). After a
name has been provided (or if a name already exists) a dialog appears
indicating that the job has actually been submitted.*
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Click on OK to remove it. After a job has started, and until it has
completed, all associated files will be designated “read only”.

Another dialog appears following completion of a calculation.

Click on OK to remove it.
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Chapter 14
The Display Menu

This chapter describes functions available under the Display
menu. These provide for text, dialog, spreadsheet and graphical
displays following molecular mechanics or quantum chemical
calculations. Functions are also available to query a variety of on-
screen objects (molecules, atoms, surfaces, etc.), to display infrared
and NMR spectra, to animate vibrational motions and to prepare 2D
and 3D plots from spreadsheet data.

A variety of output from molecular mechanics and quantum chemical
calculations is accessible by way of the Display menu.

Output

Selection of Output opens a window.
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A menu at the top left of the window selects the type of output for
display.

Output provides normal output, Verbose Output provides extended
output, Archive and Property Archive provide the contents of
Spartan’04’s archive and properly archive files*, respectively, CSD
Data provides the literature reference and other information for data
in the Cambridge Structural Database (CSD), and Error Log
documents execution errors.

The contents of the window may be scrolled in the usual manner and
may be “paged up” or “paged down” by clicking above or below the
scroll bar. The contents may be printed by selecting Print Output...
from the File menu (which has replaced Print... when an output
window is selected), or copied to the clipboard by selecting Copy
from the Edit menu when an output is selected. Find... and Find
Next functions from the Edit menu are also available.

An output window is associated with each molecule (or each list of
molecules), and as many output windows as desired may be
simultaneously open on screen (although only one may be selected).
The selected window may be closed by clicking on  at the top right.

Except for CSD data, output from jobs which are currently
executing is unavailable from the Display menu. The content of
the normal output window (“Output”) can be viewed using the
Monitor under the Options menu (see Chapter 16).

* Entries from the property archive may be brought into the spreadsheet using @prop (property
name), where “ property name” is the name of the property in the archive. See Spreadsheet
in this chapter.
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Properties

Spartan’04 provides specialized dialogs for reporting and (in some
cases) changing the properties of molecules, atoms, bonds, graphical
surfaces and geometrical constraints. They also allow for changing
default plot styles and limits, as well as for altering the nature of
“fitting functions”. Only one Properties dialog is permitted on screen,
and this dialog refers either to the selected molecule (Molecule
Properties), or to the selected component (atom, bond, etc.) or attribute
(spectra, graphical surface, etc.) of the selected molecule (Atom
Properties, Bond Properties, Surface Properties, etc.), or to a plot
constructed from data in a spreadsheet (Plot Properties, Curve
Properties, etc.), or to a fitting function (Regression Properties).
Selection of a different molecule (with a Properties dialog on screen)
leads to the Molecule Properties dialog for the newly selected
molecule. Dialogs which refer to components or attributes of the (newly
selected) molecule follow by clicking on the component or attribute.

Dialog selection operates in “toggle” mode, with the Molecule
Properties dialog being in the “neutral” or “off” position. In this
position (with the Molecule Properties dialog on screen), clicking
on a component or attribute (of the currently selected molecule) brings
up the appropriate Properties dialog. For example, clicking on an
atom brings up the Atom Properties dialog. Clicking on a different
component or attribute brings up the Properties dialog for this
component or attribute. However, clicking a second time on the same
component reverts back to the Molecule Properties dialog.

Each of the Properties dialogs has an associated Utilities or Style
dialog. For example, associated with the Molecule Properties dialog
is a Molecule Utilities dialog. These access additional information
about the molecule and its components or attributes, or provide style
and color controls unique to the selected molecule, component or
attribute. This is useful for highlighting (or dehighlighting) a particular
molecule, component or attribute. Utilities/Style dialogs are reached
by clicking on  at the bottom right of the appropriate Properties
dialog. Return to the Properties dialog follows from clicking on 
at the bottom right of the associated Utilities/Style dialog. Clicking

Chapter 14.1 12/31/03, 8:18 AM189



190

on a new molecule with a Utilities/Style dialog on screen leads to
the Molecule Properties dialog for that new molecule.

The Properties (or Utilities/Style) dialog may be removed from the
screen by clicking on .

(i) Molecule Properties

The Molecule Properties dialog displays the total
energy (in au), heat of formation in the case of a semi-
empirical calculation (in kcal/mol), or strain energy in
the case of a molecular mechanics calculation (in kcal/
mol), HOMO and LUMO energies (in eV), dipole
moment (in debyes), molecular weight (in amu), surface
area and volume of a space-filling model* (in Å2 and
Å3, respectively) and symmetry point group. It also
allows for changing total charge and multiplicity
(replicating functions in the Calculations dialog; see
Chapter 13) and for providing a title and a label for the
molecule. The title is reproduced in the text output, while
the label appears in the first column of the spreadsheet
(see Spreadsheet in this chapter), and is the name given
to the molecule as a database entry (see Appendix H).
Finally, it permits turning “on” and “off” the dipole
moment vector.

Clicking on  at the bottom right of the Molecule
Properties dialog brings up the Molecule Utilities
dialog (clicking on  at the bottom right of this dialog
returns to the Molecule Properties dialog).

* Surface area and volume calculations for “large” molecules may require “significant” (more than 1-2
seconds) computation time and are not performed (and reported) automatically. In these cases, a
button “Find Area and Volume” will appear. Clicking on this button will perform the required
calculations and report surface area and volume.
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This contains controls for resetting model color and style
(see Selected Properties below), for adding missing
hydrogens to the model, for adding “missing” bonds and
for providing information about amino acids in
polypeptides and for replacing coordinates by those
based on atomic connectivities. The dialog also allows
turning “on” and “off” display of constraint, frozen atom
and reaction markers as well as user-defined points and
planes. The dialog provides a second access point to
Global Model, which, if “on”, forces a common model
for all molecules in a list.

(ii) Atom Properties

Selection of an atom with a Properties dialog on screen,
or selection of Properties from the Display menu
following selection of an atom, leads the Atom
Properties dialog.

This displays the element name and allows for changing
of element type, R/S chirality, Mulliken, electrostatic-
fit and natural charges (in electrons) and chemical shifts
(in ppm relative to the appropriate standards; see
Appendix E) if the NMR spectrum has been requested.
It also allows the atom to be Frozen (see Freeze Center
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in Chapter 11), for changing its Mass Number, Formal
Charge and for changing the default atomic Label.

Clicking on  at the bottom right of the Atom Properties
dialog brings up the Atom Style dialog (clicking on 
at the bottom right of this dialog returns to the Atom
Properties dialog).

 

This contains controls for selecting atom color.

(iii) Bond Properties

Selection of a bond with a Properties dialog on screen,
or selection of Properties from the Display menu
following selection of a bond leads to the Bond
Properties dialog.

This displays the bond length (in Å). It also provides
for changing bond Type (also available in the expert
model kit; see Chapter 12) and the default bond Label.

Clicking on  at the bottom right of the Bond Properties
dialog brings up the Bond Style dialog (clicking on 
at the bottom right of this dialog returns to the Bond
Properties dialog).
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This contains controls for selecting bond color.

(iv) Constraint Properties

Selection of a constraint marker with a Properties dialog
on screen, or selection of Properties from the Display
menu following selection of a constraint marker, leads
to the Constraint Properties dialog.

This allows setting the Value of the selected constraint,
posting the constraint value to the spreadsheet, as well
as for changing the default constraint Label. Checking
Dynamic leads to an expanded dialog.

This allows specification of a series of constraints in order
to generate an energy profile (see Calculations... in
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Chapter 13). The value of the constraint for the first
member of the series is given in the lefthand box to the
right of Value, and the value of the constraint for the last
member of the series is given in the righthand box to the
right of Value. The number of members in the series is
given in the box to the right of Steps. Upon initial entry,
the numbers in both boxes to the right of Value will be
the same, and Steps will be set to 1. These may be altered
as required by typing the desired numbers into the
appropriate boxes and then pressing the Enter key. Note,
that an energy profile may involve constraints on more
than a single geometrical variable, that is, may involve
several variables changed in “lock-step” with one
another. In this case, the constraint ranges for the
individual variables need to selected. Note, however, that
the number of steps must be the same for each variable.

Clicking on  at the bottom right of the Constraint
Properties dialog brings up the Constraint Style  dialog
(clicking on  at the bottom right of this dialog returns
to the Constraint Properties dialog).

This contains controls for selecting the color of the
constraint marker.

(v) Point and Plane Properties

Selection of a user-defined point or plane (see Chapter
11 with a Properties dialog on screen, or selection of
Properties from the Display menu following selection
of a point or plane, leads to the Point Properties or Plane
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Properties dialog (not shown). These allow changes to
point or plane labels. Clicking on  at the bottom right
of the Point (Plane) Properties dialog gives rise to the
Point (Plane) Style dialogs (not shown), which contain
controls for adjusting point and plane colors, respectively.

(vi) Surface Properties

Selection of graphical surfaces (isosurface, slice or
property map) with a Properties dialog on screen, or
selection of Properties from the Display menu
following selection of a graphical surface, leads to the
Surface Properties dialog.

This displays the area (in Å2) and volume (in Å3) of the
selected surface. It also allows for turning “on” and “off”
and setting the range of a Property map (on top of an
isosurface), for changing IsoVal the isovalue (except
where a “fixed” isovalue has been requested) and for
altering display Style. It also provides a second access
point to Global Surface (also available in the Surfaces
dialog under the Setup or Display menu, see Chapter
13) which, if “on”, forces common property ranges for
property map displays for all molecules in a list. Finally,
the dialog reports the “value” of the property at the cursor
position on a property map. (To obtain the property value
at another position, move the cursor and click twice.)

In the event that the selected graphical surface is a slice,
a different Surface Properties dialog appears.
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The IsoVal setting in the previous dialog has been
replaced by a Frame menu which allows choosing the
type of slice (plane, cylinder or sphere).

Clicking on  at the bottom right of the Surface
Properties dialog brings up the Surface Style dialog
(clicking on  at the bottom right of this dialog returns
to the Surface Properties dialog).

This contains controls for selecting surface color.

(vii) Curve and Plot Properties

Plots created using data from the spreadsheet (see
discussion under both Spectra and Plots... later in this
chapter) may be edited using a set of closely-related
dialogs. These refer to “curves”, meaning a single
relationship between variables, and “plots” meaning a
set of relationships which share one variable (or two
variables in the case of a 3D plot).

Selection of a plot frame with a Properties dialog on
screen, or selection of Properties from the Display
menu following selection of a plot frame, leads to the
Plot Properties dialog (2D XY plot case shown).
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The X Axis menu and the Y Axes list duplicate
functionality under the Plots dialog (see Plots... later in
this chapter). They allow specification of a molecular
property to serve as the X axis of the plot and one or
more properties to serve as the Y axes. Initial selections
may be altered as desired (by selecting a new property
from the X Axis menu and/or adding or deleting properties
from the Y Axes list). In addition, a Grid can be added to
the plot, and the default Label can be changed.

The scale along the X axis (horizontal axis) may be altered
from default settings (from the minimum to maximum
value of the “X variable”) by clicking on the X Sca. tab
at the left of the dialog. This brings up the Plot X-Scale
Properties dialog (clicking on the Plot tab at the left of
this dialog returns to the Plot Properties dialog).

To alter the scale, type in new values inside the Range
boxes. You need to press the Enter key following each
entry. Controls are also available to alter characteristics
of labels associated with the X axis, Tics  (the number
of “tic marks”), Label Size and Precision.
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Clicking on  at the bottom right of either the Plot
Properties or Plot X-Scale Properties dialog brings
up the Plot Style dialog (clicking on  at the bottom
right of this dialog returns to either the Plot Properties
or Plot X-Scale Properties dialog).

This contains controls for selecting the color of the plot
frame, as well as the Label associated with the X axis.

The Style menu in the Plot Properties dialog allows
shifting between 2D (XY) and 3D (XYZ) plots. Selection
of XYZ Plot leads to an extended Plot Properties dialog.

This is identical to the previous (“XY Plot”) Plot
Properties dialog, except that it includes an additional
menu (Y Axis) from which one property needs to be
selected. In addition, the Y Axes list in the “XY Plot”
dialog has been renamed to Z Axes.

Scales along X and Y axes may be independently
adjusted by clicking on X Sca. and Y Sca. tabs to the
left of the dialog. This leads to either the Plot X-Scale
or Plot Y-Scale Properties dialog (clicking on the Plot
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tab at the left of either of these dialogs returns to the
Plot Properties dialog). These are analogous to the (Plot
X-Scale Properties) dialog discussed for XY plots.

The same Plot Style dialog available for XY plots may
be accessed here (by clicking on  at the bottom of the
appropriate dialog).

Selection of an individual curve in a plot with a
Properties dialog on screen, or selection of Properties
from the Display menu following selection of an
individual curve, leads to the Curve Properties dialog.

This allows for change in the presentation format for the
selected curve (or any other curve in the overall plot as
specified from the Axis menu). This includes designation
of the kind of Markers for the individual data points,
request for Marker Labels (molecule names associated
with the data points), designation of the kind of Fit to
the data points and the Line Width of the fitting curve.
Also optional is a Sphere showing the selected point
(selected molecule in the list) on the curve. Provision is
also made for including Error bars on the individual
data points (drawn from a column on the spreadsheet).

The scale along the Y axis (vertical axis) in the case of a
2D XY plot  (or Z axis in the case of a 3D XYZ plot)
may be altered from default settings (from the minimum
to maximum value of the “Y or Z variable”) by clicking
on the Scale tab at the left of the dialog .This brings up
the Curve Scale Properties dialog (clicking on the

Chapter 14.1 12/31/03, 8:18 AM199



200

Curve tab at the left of this dialog returns to the Curve
Properties dialog).

To alter the scale, type in new values inside the boxes
underneath “Range”. You need to press the Enter key
following each entry. Controls are also available to alter
characteristics of labels associated with the Y or Z axis:
Tics (the number of “tic marks”), Label Size and
Precision.

Clicking on  at the bottom right of either the Curve
Properties or Curve Scale Properties dialog brings up
the Curve Style dialog (clicking on  at the bottom
right of this dialog returns to either the Curve Properties
or Curve Scale Properties dialog).

This contains controls for selecting the color of the curve
(and the Label associated with the Y (or Z) axis).

(viii) Regression Properties

After performing a linear regression analysis on data in
the spreadsheet (see discussion later in this chapter), a

* More precisely, a fit row will be written for each fit, and labelled Fit1, Fit2, . . .”.
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new row, labelled “Fit1”*, appears at or near the bottom
of the spreadsheet. This contains information about the
fit. Clicking on this line with a Properties dialog on
screen, or selecting Properties from the Display menu
after clicking on the “fit line” in the spreadsheet, leads
to the Regression Properties dialog.

This reports “RMSD” and “R2” error statistics related
to the fit, as well as allows for changing “what is to be
fit” (Fit menu) and “what it is to be fit to” (list to the
right of Using). Following selection of either or both,
the error statistics will update, allowing the user
immediate feedback.

(ix) “Selected” Style

In addition to “Style” dialogs associated with each of
the Properties dialogs, there is “Selected” Style dialog
(for which there is no corresponding Properties dialog).
This is accessed either by defining a selection box (see
discussion in Chapter 2) with a Properties dialog on
screen, or by selecting Properties from the Display
menu after defining a selection box.
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This dialog contains controls for changing the color and
model type of whatever is included in the selection box.

Surfaces

This accesses the same dialog already described in Chapter 13.

Spectra

Spartan’04 provides for display of infrared, UV/visible and NMR
spectra. (All of these need to have been previously requested from
the Calculations dialog under the Setup menu; see Chapter 13.)
Access is via a series of tabbed dialogs under Spectra.

IR

Clicking on the IR tab leads to the IR Spectra dialog which not only
provides for display of an infrared spectrum, but also allows for
animated display of the vibrational modes as well as for generation
of a sequence of structures along a vibrational coordinate.

This contains an ascending list of frequencies (in cm-1) together with
(infrared) intensities and symmetry labels. Imaginary frequencies,
e.g., corresponding to the reaction coordinate for a transition state,
will appear first in the list, and will be designated by the letter “i” in
front of the frequency value. A frequency is selected for display by
clicking on it. Clicking again deselects it.

The amplitude of vibrational motion (the maximum displacement
away from “equilibrium” of any pair of atoms) may be changed from
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the default amplitude (0.5Å which is much larger than appropriate
for vibrational motion at room temperature) by altering the contents
of the box to the right of Amp. The default number of steps which
make up the display (11 frames) may be changed by altering the
contents of the box to the right of Steps*. The greater the number of
frames, the slower will be the vibration.

Make List creates a list containing a sequence of “Steps” structures
corresponding to motion along the selected normal mode. The original
molecule is not closed, and several sequences (corresponding to
different vibrations) can be created.

A spectrum may be drawn by clicking on Draw IR Spectrum.

The default range, from 4000 cm-1 to 500 cm-1, corresponds to that
commonly obtained experimentally, and may be changed by bringing
up the Properties dialog (Display menu), clicking on the horizontal
axis to bring up the Plot Properties dialog, clicking on the X Sca.
tab at the left of the dialog and editing the values under Range. The
spectrum is treated like any other graphical object, and may be
translated and scaled using the appropriate mouse operations. It may
not be rotated. The spectrum may be removed from the screen by
clicking on  (or alternatively by holding down the Delete key) and
then clicking on the spectrum.

* It is recommended that the number of steps be odd ensuring that the center point corresponds
to the actual equilibrium or transition-state structure.
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UV/vis

Clicking on the UV/vis tab leads to the UV/vis Spectra dialog.

This lists excitation energies (from lowest to highest) together with
intensities. A UV/visible spectrum may be drawn by clicking on Draw
UV Spectrum.

The default range, from 200 nm to 700 nm, corresponds to that
commonly obtained experimentally, and may be changed by bringing
up the Properties dialog (Display menu), clicking on the horizontal
axis to bring up the Plot Properties dialog, clicking on the X Sca.
tab at the left of the dialog and editing the values under Range. The
spectrum is treated like any other graphical object, and may be
translated and scaled using the appropriate mouse operations. It may
not be rotated. The spectrum may be removed from the screen by
clicking on  (or alternatively by holding down the Delete key) and
then clicking on the spectrum.
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NMR

Clicking on the NMR tab leads to the NMR Spectra dialog which
provides for display of 1H and 13C NMR spectra.

These are drawn by clicking on Draw 1H Spectrum/Draw 13C
Spectrum inside the dialog.

1H and 13C spectral plots are treated like any other graphical object,
and may be translated and scaled using the appropriate mouse
operations. They may not be rotated. Spectral plots may be removed
from the screen by clicking on  (or alternatively by holding down
the Delete key) and then clicking on the spectrum.

Only a single copy of one of the dialogs under Spectra may appear
on screen, and any actions relate to the currently selected molecule.
The dialog may be removed by clicking on .
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Spreadsheet

Associated with each list of molecules (including “lists” comprising
only a single molecule) is a spreadsheet. This may be displayed by
selecting Spreadsheet.

The spreadsheet comprises a series of rows (corresponding to the
different molecules in the list) and columns (corresponding to different
molecular properties). This gives rise to a series of “cells”, the number
of which is given by the number of rows (molecules) times the number
of columns (molecular properties). The spreadsheet can be expanded
or contracted as required for display of all relevant information by
positioning the cursor at any corner of the spreadsheet, pressing the
left mouse button and dragging the mouse.

Only one molecule from one list may be selected. Molecule selection
follows either by clicking on the spreadsheet cell containing the label,
or by using the  and  buttons or the scroll bar at the bottom left of
the screen. Molecules may be animated (stepped through in rapid
succession) using the  button. Molecule selection (for members of
a list) results in deselection of the previously selected molecule.
However, it does not need to result in its removal from view. A
molecule (in a list) may be designated for “permanent” display by
checking the button to the right of its “Label” in the spreadsheet.
This also selects the molecule, and deselects the previously selected
molecule (but does not remove it from view if it were previously
“checked”). The molecules in a list may either be translated and rotated
in concert or manipulated independently. This is controlled by
Coupled under the Model menu (see Chapter 10). The default is
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that molecules move in concert. Select Coupled to designate
independent motion.

Upon initial entry into the spreadsheet, all columns except the leftmost
column, are blank. The leftmost column (“Label”) contains a label
of the molecule. It may be changed from the default (“M001”,
“M002”, etc.) either by directly typing a new label into the spreadsheet
or into the Label box in the Molecule Properties dialog. The label
supplied will be used as the “molecule name” in a user-defined
database (see Appendix H).

Information may be added to the spreadsheet in several different ways:

(i) Molecular properties from the Add dialog: A variety of
“important” molecular properties may be easily entered into
the spreadsheet by first clicking on the header cell
corresponding to an “empty” column, and then clicking on
Add... at the bottom of the spreadsheet. An alternative is to
hold down the right mouse button (following clicking on
the header cell) and then to select Add... from the menu
which results.

Either leads to the Add Columns dialog.
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Columns (molecular properties) are added to the spreadsheet
by clicking on one or more entries in the window at the top
of the dialog, then specifying appropriate units from the
Energy and Length menus, and finally clicking on OK or
on Apply. In the former case, the dialog is dismissed and in
the latter it is left on screen. Clicking on Cancel or on 
removes the dialog without affecting the contents of the
spreadsheet.

Column totals and averages, as well as information relating
to the extent to which the data in the different columns are
“correlated”, may be accessed by clicking on the
Summaries tab. This leads to the Add Summaries dialog.

Clicking on “Totals”, “Averages” and/or “Correlations”
(which have replaced molecular properties in the window
at the top of the dialog) then clicking on OK or Apply,
leads to the requested summaries as rows at the bottom of
the spreadsheet, identified as “Totals”, “Averages” and
“Correlations” (one row for each molecular property),
respectively. Note, that the Add Summaries dialog can be
brought up directly by clicking on an empty row header
(instead of an empty column header) inside the spreadsheet
prior to clicking on Add....

Finally, a linear regression analysis may be performed on
the data in the spreadsheet. To access this functionality, click
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on the Linear Regression tab to bring up the Add Linear
Regression dialog.

Select one entry from the Fit menu and one or more entries
from the list under Using. Clicking on OK or Apply
performs the linear regression analysis and places the results
in a row at the bottom of the spreadsheet identified by “Fit”.
As many analyses as desired may be performed on the data
in the spreadsheet. These will each be entered as separate
rows in the spreadsheet, with names “Fit1”, “Fit2”, etc.
Additional information about the regression analyses is
available from the Regression Properties dialog (see
discussion earlier in this chapter).

(ii) Direct entry of numerical data: Numerical data may be
entered by typing directly into the spreadsheet. A column
header first needs to be specified. Click on an empty column
header cell, type in a name and press Enter. Then, type the
data into individual cells of the new column (press Enter
following each data entry).

(iii) User-defined expressions: An expression may be entered
either into a header cell (in which case it refers to all entries
in a column) or into an individual cell (in which case it refers
only to a single entry). Expressions in the column header
take the form “name=formula”, where “formula” is made
up of arithmetic operations (Table 14-1), specialty functions
(Table 14-2), quantities resulting from molecular mechanics
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Table 14-1: Arithmetic and Boolean Operations and Mathematical
Functions

arithemetic operations boolean operations
+ addition > greater than
_ subtraction >= greater than or equal to
* multiplication < less than
/ division <= less than or equal to
^ raise to a power == equal to

!= not equal to
| or
& and

mathematical functions
ABS(x) absolute value LN(x) natural logarithm
ACOS(x) inverse cosine LOG(x) log (base 10)
ASIN(x) inverse sine SIN(x) sine
ATAN(x) inverse tangent SQRT(x) square root
COS(x) cosine TAN(x) tangent
EXP(x) exponential

Table 14-2: Specialty Functions

AVG (column name) average of values in column

FITVAL (fit name) column of “fit” values from regression analysis

MIN (column name) minimum of values in column

MAX (column name) maximum of values in column

NUM (column name) number of “defined” entries in column

ROW the number of the row in the spreadsheet

ROW(molecule name) the number of the row of molecule

REF(i, x) the value of the x referenced to row i

STDEV (column name) standard deviation of values in column

SUM (column name) sum of values in column
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or quantum chemical calculations* (Table 14-3), conversion
factors and constants (Table 14-4) in addition to numerical
values. References to specialty functions, molecular
mechanics and quantum chemical functions and conversion
factors and constants need to be preceded by @. For
example, “mu = @DIPOLE” typed into a header cell gives
the dipole moment. Some quantities have arguments, for
example, “c1” and “c2” in the expression “c12=
@DISTANCE (c1,c2)” refer to atoms c1 and c2, while “3”
in the expression “orbitalE= @HOMO(-3)” designates the
energy of the molecular orbital three orbitals below the
HOMO. It is necessary to press Enter following entry of
the expression into a cell. The leading “name=” is optional
for entries in an “individual” (non-header) cell. Examples
of user-defined expressions are provided in Table 14-5.

(iv) Molecular and atomic properties from “Post” ( ) buttons:
A number of properties which require user specification
may be entered into the spreadsheet from “Post” buttons.
These include individual bond distances, angles and dihedral
angles (available from Measure Distance, Measure Angle
and Measure Dihedral under the Geometry menu; see
discussion in Chapter 11), bond distance, angle and
dihedral angle constraints (available from Constrain
Distance, Constrain Angle and Constrain Dihedral under
the Geometry menu; see discussion in Chapter 11), and
atomic charges and chemical shifts (available from the
Atom Properties dialog; see discussion earlier in this
chapter). “Post” generates an entire column of values based
on atom labels for the selected molecule in the list. Only

* Additionally, any quantity available in the “property archive” (viewable from the Output
window; see discussion earlier in this chapter) may be accessed in an expression using the
“@prop(argument 1, argument 2, . . .)”. Among the different argument lists are the following:
The name of the property (in the “property archive”), e.g., “SYM_STRING” for the symmetry
label. The name of the property followed by the (serial) number of the atom in the list of
atoms, e.g., “MM_CHARGE, 6” for the MMFF (molecular mechanics) charge on the sixth
atom in the list of atoms. The name of the property followed by a number to indicate the
desired member in the list of all members,e.g., “FREQ_VAL, 1” for the lowest vibrational
frequency in the list of frequencies.
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Table 14-3: Quantities from Molecular Mechanics or Quantum Chemical
Calculations

ANGLE(i, j, k) angle involving atoms i, j, k (degrees)
AREA area of a user-defined plane
CPKAREA surface area of a space-filling model (Å2)
CPKVOLUME volume of a space-filling model (Å3)
PAREA (i, j, . . .) partial surface area of a space-filling model due

to all atoms of type i, j, ..., where i, j, ... are either
atomic numbers or elemental symbols. i:, j:, ...
signifies that attached hydrogens are also
included. (the surface area due to nitrogen,
oxygen and any bonded hydrogen is commonly
referred to as the polar surface area) (Å2)

PVOLUME (i, j, . . .) partial volume of a space-filling model due to
all atoms of type i, j, ..., where i, j, ... are either
atomic numbers or elemental symbols. i:, j:, ...
signifies that attached hydrogens are also
included  (Å3)

DIHEDRAL(i, j, k, l) dihedral angle involving atoms i, j, k, l (degrees)
DIPOLE dipole moment (debyes)
DISTANCE(i, j) distance involving atoms i, j (Å)
ELECTROSTATIC (i) electrostatic charge on atom i (electrons)
ENERGY energy (hartrees)
ENERGYAQ energy including SM5.4 aqueous solvent

correction (hartrees)
ENTROPY entropy (cal/mol degree)
FREEENERGY free energy (kcal/mol)
HOMO(-n) energy of nth orbital below the HOMO (hartrees)
HOMOBETA(-n) energy of the nth orbital below the HOMO in the

β spin manifold (hartrees)
ISOTOPE(i) mass number of atom i
LENGTH (i) length of bond i (Å)
LOGPC LogP from Crippen model
LOGPV LogP from Villar model
LUMO(+n) energy of the nth orbital above the LUMO

(hartrees)
LUMOBETA(+n) energy of the nth orbital above the LUMO in the

β spin manifold (hartrees)
MULLIKEN(i) Mulliken charge on atom i (electrons)
NATURAL(i) natural charge on atom i (electrons)
ZEROPOINT zero-point energy (kcal/mol)
WEIGHT molecular weight (amu)
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Table 14-4: Conversion Factors and Constants

ANGS2AU Ångstroms to atomic units

AU2ANGS atomic units to Ångstroms

EV2HART eV to hartrees

EV2KCAL eV to kcal/mol

EVTOKJ eV to kJ/mol

HART2KCAL hartrees to kcal/mol

HART2EV hartrees to eV

HART2KJ hartrees to kJ/mol

KCAL2EV kcal/mol to eV

KCAL2HART kcal/mol to hartrees

KCAL2KJ kcal/mol to kJ/mol

KJ2EV kJ/mol to eV

KJ2HART kJ/mol to hartrees

KJ2KCAL kJ/mol to kcal/mol

PI π

Table 14-5: User Defined Expressions

E/area = @ENERGY/@AREA energy divided by surface
area

RelE = @ENERGY-@REF (6,@ENERGY) energy relative to energy of
molecule in row 6

Eq = @EXP (-@ENERGY/592.1) equilibrium constant at room
temperature

EnergyFilter = @ENERGY<-99.43 “true” (≠0) for all energies <-
99.43

RowFilter = @ROW>10 “true” (≠0) all entries past
row 10
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where the molecules in the list are closely related, for
example, molecules resulting from a conformational search
or from “driving” a particular geometrical coordinate, or
where labels have been explicitly reassigned*, is Post likely
to lead to the desired result.

(v) Molecular and atomic properties from the clipboard:
Properties of individual molecules in a list may be copied
into the clipboard and then pasted into individual spreadsheet
cells. These include bond distances, angles and dihedral
angles (Measure Distance, Measure Angle and Measure
Dihedral under the Geometry menu), bond distance, angle
and dihedral angle constraints (Constrain Distance,
Constrain Angle and Constrain Dihedral under the
Geometry menu), atomic charges and chemical shifts
(Atom Properties dialog), infrared frequencies and
chemical shifts (IR Spectra and NMR Spectra dialogs,
respectively) and the value of a property on a property map
(Surface Properties dialog). First, highlight the numerical
value of the property in the appropriate screen location
(distances, etc.) or dialog (charges, etc.), then select Copy
from the Edit menu, then click on the appropriate
(destination) cell in the spreadsheet, and finally select Paste
from the Edit menu.

Each row in a spreadsheet corresponds to a molecule in a list, and
new rows may be added by adding new molecules to the list. This
may be accomplished either by building a new molecule (New
Molecule from the File menu; Chapter 8), or by appending one or
more existing molecules (see Append Molecule(s)... from the File
menu; Chapter 8), or using the clipboard, or by dragging  from an
external window. Copy a molecule into the clipboard by first selecting
(clicking on) it, and then selecting Copy from the Edit menu.
Alternatively, click on its entry (“Label”) in its spreadsheet, and then
select Copy from the Edit menu. The latter permits several molecules

* Label reassignment is accomplished through the Atom Properties dialog (see discussion
earlier in this chapter).
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to be selected (and copied) at once using the Shift and Ctrl keys in
the usual manner. Move the contents of the clipboard to its destination
by clicking on an empty row header in the spreadsheet (for the
destination list), and then selecting Paste from the Edit menu. Copy
a molecule from an external (to Spartan’04) window, by first selecting
the molecule, and then dragging it from the external window onto the
open spreadsheet (associated with the destination list) inside of
Spartan’04. Several molecules can be selected (and dragged) at once
using the Shift and Ctrl keys in the usual manner.

A row may be deleted from a spreadsheet (causing the corresponding
molecule to be deleted form a list), either by first selecting the molecule
and then selecting Delete Molecule from the File menu, or by first
clicking on its “Label” in the spreadsheet (leftmost column) and then
either clicking on the Delete button at the bottom of the spreadsheet,
or by selecting Delete Selected from the menu which appears when
the right mouse button is pressed (with the cursor over the
spreadsheet). In all cases, a warning is provided prior to deletion. An
entire column in the spreadsheet may be deleted by first clicking on
the column header (the title) and then clicking on the Delete button
(or Delete Selected from the menu).

Rows in the spreadsheet may be sorted according to the numerical
values in any column by first clicking on the column header and then
either clicking on the Sort button at the bottom of the spreadsheet or
by selecting Sort from the menu which appears when the right mouse
button is pressed (with the cursor over the spreadsheet). The rows
are placed in ascending order, the smallest (least positive) value of
the selected property at the top, largest (most positive) value at the
bottom. To sort in descending order, hold down the Shift key before
you click on the Sort button.

Totals and averages of column values may be obtained by first
selecting new (blank) row header, then clicking on Add... and finally
selecting “Totals” and/or “Averages” from the (Add Summaries)
dialog which results.

A button at the bottom right of the spreadsheet toggles between
numerical representation of data “f(x)” and formula presentation “=?”.
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The spreadsheet may be printed by selecting Print Spreadsheet...
from the File menu (which has replaced Print... when a spreadsheet
is selected). It may be removed by clicking on .

Plots...

Plots may be constructed from data in a spreadsheet and a variety of
simple “curves” fit to these data. Selection of Plots... from the Display
menu leads to the Plots dialog.

This has two variants depending on the tab at the top of the dialog
“XY Plot” (two dimensions) or “XYZ Plot” (three dimensions). At
the outset, XY Plot will be selected.

The “XY Plot” variant incorporates an X Axis menu designating the
molecular property to be displayed among the X axis, and a list of
properties to be displayed along the Y axis. These properties correspond
one to one to the columns in the associated spreadsheet. To construct
a 2D plot, select an item from the X Axis menu, then click on one or
more items from the Y Axes list and finally click on OK. (Repeated
clicking on a property in the Y Axes list turns it “on” and “off”.) The
dialog is removed from the screen and a plot appears.
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The plot can be moved about the screen. Select (click on) either the
frame or on one of the curves (it will turn gold in response), then
hold down the right mouse button and drag the mouse. The plot may
also be scaled (expanded or shrunk) by first selecting either the frame
or one of the curves and dragging the mouse while holding down
both the right button and the Shift key. The plot may not be rotated.

The “XYZ Plot” variant is reached by clicking on the XYZ Plot tab
at the top of the dialog. This leads to a new dialog.

This is very similar to the “XY Plot” variant, except that it incorporates
X Axis and Y Axes menus to designate quantities to be displayed
along the X and Y axes, respectively, as well as a list of properties to
be displayed along the Z axis. To construct a 3D plot, select one item
from each of the X Axis and Y Axis menus, then click on one or more
items from the Z Axes list and finally click on OK. A plot appears.
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The plot can be moved about the screen. Select (click on) either the
frame or on one of the curves (it will turn gold in response), then
hold down the right mouse button and drag the mouse. The plot may
also be scaled (expanded or shrunk) by first selecting either the frame
or one of the curves and dragging the mouse while holding down
both the right button and the Shift key. Finally, 3D plots (unlike 2D
plots discussed earlier) may be rotated, by first selecting either the
frame or one of the curves and dragging the mouse while holding
down the left button.

Plots initially presented to the user draw smooth curves (cubic splines)
through the data points. Different types of “curve fits” as well as a
variety of different presentation formats are available under the Plot
Properties and associated dialogs (see Properties earlier in this
chapter).

A plot may be deleted by first selecting (clicking on) Delete from the
Build menu, or clicking on , or holding down the Delete key, and
then clicking on either the plot frame or on an individual curve.
Clicking on the frame removes it and all associated curves, while
clicking on a curve removes only this curve. However, the last curve
deleted also deletes the frame.
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Chapter 15
The Search Menu

This chapter describes functions available under the Search menu.
These provide substructure searching of the Cambridge Structural
Database of experimental X-ray crystal structures, both replacement
from and substructure searching of the Spartan Molecular Database
of calculated structures, energies and properties, a facility for
guessing transition states for “new” reactions based on their
similarity to transition states in an extensive reaction database, and
a procedure for identifying tautomers.

The Search menu provides access to the Cambridge Structural Database
of experimental X-ray crystal structures, as well as the Spartan
Molecular Database of calculated molecular structures, energies and
properties, a facility for guessing transition state geometries and a
procedure for identifying tautomers.

Databases ( )

Access to two databases is provided under this heading; the
Cambridge Structural Database (CSD) of experimental X-ray crystal
structures and the Spartan Molecular Database (SMD) of calculated
structures, energies and molecular properties. Both databases may
be searched on the basis of a “substructure”. In addition, SMD is
accessed automatically (and its results made available) whenever an
entry is selected on screen.
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Cambridge Structural Database (CSD)

The Cambridge Structural Database (CSD) is a collection of more
than 300,000 experimental X-ray crystal structures for organic and
organometallic molecules. It is maintained by the Cambridge
Crystallographic Data Centre (CCDC) and grows approximately 10%
per year.* CSD not only contains information about the molecular
geometry, but also about crystal packing and, more generally, about
intermolecular interactions. However, Spartan’04’s interface to CSD
permits access only to “molecular” information**. Even with this
limitation, the CSD represents a “gold mine” of detailed experimental
structural information (bond lengths and angles as well as
conformations), and also serves to identify molecules which can be
(and have been) synthesized and purified through crystallization.

Access to the data in CSD is via a substructure searching procedure.
A molecule is first constructed in the usual way, identifying one or
more free valences in places where the structure is to be “grown”.
For example, to search for all molecules related to camphor, i.e.,
with different substituents on the sp3 carbon occupying the bridgehead
position adjacent to the carbonyl group, the following “substructure”
would be constructed, and a growth point (a free valence on the *’ed
carbon) designated.

OC*

Access to CSD is provided by clicking on the CSD tab at the top of
the Database dialog. This gives rise to the CSD dialog.

* CSD is not included with Spartan‘04 but is available by subscription from CCDC or one of its
distributors. Contact Wavefunction for information. For installation instructions, see Appendix G.

** This additional information may be accessed using CCDC’s Windows’ program “ConQuest”, which
is supplied as part of the CSD subscription.
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This contains a window at the left for previewing structures, a box at
the right for listing “hits” on CSD as well as examining the text output
from the search, and buttons at the bottom to control various aspects
of the search and subsequent transfer of CSD data into Spartan’04’s
file system. A substructure search is set up by specifying one or more
of the following*:

(i) Attachment Points

Free valences are designated as attachment points by clicking
on them in the structure model. The “free valences” will be
replaced by orange cones. Clicking again will remove the
designation and return the free valences. As many attachment
points as desired may be specified. Anything may be “grown”
off an attachment point (including hydrogen). The coordination
of the atom where attachment is made is maintained. Note,
that free valences which are not identified as attachment points
are assumed to be hydrogens.

In the case of a search for camphor derivatives resulting from
substitution on the sp3 carbon at the bridgehead position adjacent

* If nothing is specified, a search for an “exact” match is carried out (all free valenes are assumed to be
hydrogens).
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to the carbonyl group, it is necessary to click on the free valence
at this position. The structure display will now appear as follows,
with an “orange cone” replacing the free valence.

The camphor search requires no further specifications of
substructure, although two other aspects of substructure
designation may be required to carry out other searches.

(ii) Wild-Card Atoms

An atom may be designated as a “wild card” (no checking of
atom type) by clicking on it. The ball in the model (designating
a specific atom type) will turn orange (designating any atom
type). Clicking on a wild-card atom removes the wild card
designation. As many wild-card atoms as desired may be
specified.

Use of wild card atoms will result in structures which
incorporate variants of the original substructure with different
atoms at designated positions. For example, use of a phenyl
ether substructure with one of the ring atoms designated as a
wild card (*) could result in “hits” with pyridyl ethers.

O

N

O

*

substructure CSD "hit"

Note, that coordination around a wild-card atom is not
maintained.
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(iii) Wild-Card Bonds

A bond may be designated as a “wild card” by clicking on it. A
orange cylinder will be drawn around it. Clicking on this cylinder
removes it and reverts designation of bond type back to the
original. As many wild-card bonds as desired may be specified.

Wild-card bonds are often essential in dealing with heteroatom-
containing molecules, in particular, heterocycles.* Their use
implies change in coordination.

After a substructure has been fully specified, search of CSD is carried
out by clicking on the Search button at the bottom right of the dialog.
If there are “hits” to be found, these will begin to appear in the box at
the right of the dialog after a few seconds. The entire search will
require between a few seconds and one or two minutes, depending
on the query (and on the speed of the computer). It can be terminated
at any time by clicking on  to the right of the Search button at the
bottom right of the dialog. Once completed (or stopped), the “CSD
ref codes” and the names for the “hits” are displayed in the box and
the number of “hits” is indicated immediately below. Actual structural
data are available only for entries preceded by a filled yellow circle
(the vast majority of entries). Other entries (designated by open
circles) for which structure data are not available are provided for
completeness only. A 3D structure for any entry for which it is
available (yellow circle) may be seen by clicking on its name in the
box. The ball-and-wire model is displayed in the window at the left
of the dialog, and its name appears immediately below the window.

* This is closely related to identification of tautomers. See discussion later in this chapter.
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The model can be manipulated (rotated, translated, scaled) inside the
window with the usual mouse/keyboard commands (you need to
position the cursor inside the window), but the model style cannot be
changed, nor can geometrical measurements be made. These require
that selected entries be transferred to the file system (see below).

Note, that the information available for preview is exactly as it appears
in CSD. In particular, it may contain two or more different molecules,
two or more different conformations of the same molecule and/or
extraneous molecules (most commonly solvent molecules and
counterions). Hydrogens will be shown only where they have been
assigned in the experimental structure. Finally, the preview may contain
errors in bonding due to uncertainties in the original data and/or crystal
imperfections. “Filters” are available to address some of these issues
prior to transfer of one or more hits to Spartan’04’s file system. In
addition, the destination of the retrieved data may be specified.
Available retrieval options are found in the Retrieve Options dialog
accessed by clicking on  to the right of the Retrieve button at the
bottom of the CSD dialog.
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(i) Retrieve to:
Selection toggles between New Document and Current
Document. Selection of the former results in request for a
file name; selection of the latter results in the retrieved
molecules being appended to the end of the current molecule
list.

(ii) Delete Extraneous Fragments
If checked, this deletes any “detached molecules” which
do not contain the original substructure. These will most
commonly be trapped solvent molecules or counterions.

(iii) Repair Bonds
If checked, this attempts to “fix” obvious bond typing errors
based on the actual geometry in the CSD entry, and on
normal rules of valence.

(iv) Grow Hydrogens
If checked, this “grows” hydrogens wherever they are (or
appear to be) missing. “Growth” is based on the actual 3D
structure and on normal valence rules. This is the same
function that is available under Grow Hydrogens in the
Molecule Utilities dialog (see Chapter 14).

(v) Freeze Heavy Atoms
If checked, this “freezes” all atoms except for hydrogens.
This allows experimental X-ray hydrogen positions, which
are typically much too short, to later be refined using
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molecular mechanics or quantum chemical methods, while
maintaining the heavy atom skeleton.*

The Retrieve Options dialog is dismissed with all changes to existing
settings maintained by clicking on OK. Clicking on Cancel or on 
also dismissed the dialog but any changes to settings are lost.

Retrieval is accomplished by first selecting (clicking on) one or more
“hits” in the box and then pressing the Retrieve button at the bottom
of the CSD dialog. The Shift and Ctrl keys may be used to specify
retrieval of multiple hits. A block of entries may be specified by clicking
on the top (or bottom) entry, then holding down the Shift key and
finally clicking on the bottom (or top) entry. Multiple entries may be
specified by clicking on each in turn while holding down the Ctrl key.
The retrieve process can be stopped at any time by clicking on  to
the right of the Retrieve button at the bottom of the CSD dialog.

If Implicit Search in the Miscellaneous Preferences dialog
(Preferences... under the Options menu; see Chapter 16) has been
set, a search of CSD is performed in “build mode” each time a change
is made to the molecular structure.** This search assumes that all free
valences are attachment points, insuring the maximum number of
hits. The CSD dialog does not need to be open on screen (but may be
opened at any time to examine the resulting “hits”). However, running
total of hits is provided at the bottom right of the screen whenever
implicit search has been invoked.

* Hydrogen positions may be refined using the MMFF molecular mechanics model using
Minimize from the Build menu (  button). Refinement using quantum chemical models is
specified in the Calculations dialog (Setup menu) by way of Frozen Atoms. See discussion
in Chapter 13.

** Use of implicit search may seriously degrade graphics performance during molecule building
and should be switched off unless desired.
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Spartan Molecular Database (SMD)

The Spartan Molecular Database (SMD) is a collection of more than
50,000 molecules, the structures, energies, and selected properties of
which have been obtained from up to five different theoretical models:
Hartree-Fock models with 3-21G and 6-31G* basis sets, EDF1/6-31G*
and B3LYP/6-31G* density functional models and the MP2/6-31G*
model. An entry is specified by a three-dimensional connectivity
encoded as a one-dimensional (SMILES like) character string together
with a theoretical model. Structural isomers, e.g., cis-trans isomers are
distinguished as are diasteromers, but enantiomers are not distinguished.

SMD is open-ended and users may construct parallel databases with
additional molecules and/or results from additional theoretical models
on existing molecules (see Appendix H). Future extensions of SMD
will include transition-metal inorganic and organometallic compounds
and transition states as well as calculations using higher-level models.

While the majority of entries are represented in terms of a single
“lowest-energy” conformer (see text box below), some entries are
represented in terms of two or more conformers. In these cases, the
available conformers will be ranked according to energy, and the
user needs to choose among them.

The individual entries supplied in SMD have been obtained according to
the following “recipe”.

1. Identify the lowest-energy conformer using molecular mechanics and
the MMFF (Merck) force field. Systems with only a few degrees of
conformational freedom are searched systematically “guaranteeing”
location of the global minimum, while a Monte-Carlo search is applied
to more complicated systems. The latter does not guarantee location
of the global minimum.

2. Starting from the best conformer located, perform a geometry
optimization using the appropriate quantum chemical model. This
generally means that all quantum chemical calculations for a particular
molecule will refer to the same conformer.
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At the present time, SMD may be accessed in one of two ways: “exact”
replacement of a structure with a database entry corresponding to a
particular quantum chemical model, and location of entries in the
database (corresponding to one or more quantum chemical models)
which contain a particular substructure. The latter is strictly analogous
to the way in which Spartan’04 accesses the Cambridge Structural
Database (see previous discussion).

Replacement

The existence of one or more database entries (corresponding to
different quantum chemical models) for the selected molecule is
indicated by its name being displayed at the bottom of the screen.

Details are provided by clicking on  to the immediate left of the
molecule name (it then changes to ). This brings up a dialog which
comprises a viewing screen on the left and a list of quantum chemical
models for which database entries exist on the left.

Upon initial entry, the topmost entry in the list is checked and a ball-
and-spoke model corresponding to its structure appears in the viewing
screen. This model can be rotated, translated and scaled using the
usual mouse/keyboard commands (you need to position the cursor
inside the viewing area). The model may be made to “tumble”
automatically by checking the box to the left of Replace All at the
bottom of the dialog. Model style may not be changed. A different
database entry (corresponding in this case to a different quantum
chemical model) may be selected by checking the box to the left of
the name of the quantum chemical model in the dialog.

The selected (on-screen) molecule may be replaced by the selected
database entry by clicking on Replace at the bottom of the dialog.
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(Replacement can be “undone” by selecting Undo from the Edit
menu; see Chapter 9). Note that replacement destroys any
information associated with the molecule being replaced.

Some database entries also comprise information on higher-energy
conformers (in addition to that on the “presumed” ground-state
conformer). These entries are designated by a  icon to the left of the
check box. Checking this icon leads to an expanded entry which allows
access to these higher-energy conformers, as well as provides their
relative energies (in kcal/mol).

Entries are selected as before, at which time they may be examined
in the viewing screen or used to replace the on-screen molecule.

In the event that the selected (on-screen) molecule is a member of a
list, it is possible to replace all members of the list for which database
entries are available. This is accomplished as above except that Replace
All instead of Replace is used. A warning message is provided prior
to replacement. Note that the lowest-energy conformer for all other
(non-selected) molecules in the list is used even though a higher-energy
conformer may be indicated for the selected molecule. (Replacement
of list entries with non lowest-energy conformations may be done one
by one using Replace instead of Replace All.) Also note that molecules
in the list for which there are no database entries are not affected.

Substructure Searching

Substructure searching from SMD is very similar to that from CSD
described previously, in that all that is required is specification of
one or more “growth points”. It differs in that SMD contains multiple
sets of results (corresponding to different theoretical models), and it
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is necessary to specify which model (or which set of models) is to be
employed.

Access to SMD is provided by clicking on the SMD tab at the top of
the Database dialog. This gives rise to the SMD dialog.

Like the CSD dialog, the SMD dialog contains a window on the left
for previewing structures and a box on the right for listing “hits” on
SMD, as well as buttons at the bottom to control various aspects of
the search and subsequent transfer of data into Spartan’04’s file
system.

A substructure search is set up by specifying one or more attachment
points, in the same manner as for CSD (see previous discussion).
“Wild-card” atoms and bonds are not available.

Prior to starting the actual search, it is necessary to specify which
theoretical model or set of models is to be included. Model
specification as accomplished by clicking on  to the right of the
Search button at the bottom right of the dialog. This brings up the
Search Options dialog.
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Checking the appropriate boxes specifies the appropriate model(s).

In general, SMD contains more data for the simpler models (3-21G and
6-31G*) than for the more complicated models (EDF1/6-31G*, B3LYP/
6-31G* and MP2/6-31G*). In fact, only a few thousand entries are
available with the MP2/6-31G* model in the initial release of the database.

Specification of Other provides access to data with theoretical models
other than those explicitly mentioned in the dialog. Clicking on OK
removes the dialog. (Clicking on Cancel or on  also removes the
dialog, but selections are not made.)

Following specification of attachment points and designation of theory
level(s), a search on SMD is carried out by clicking on the Search
button at the bottom right of the dialog. If there are hits to be found,
these will begin to appear in the box at the right of the dialog after a
few seconds. The entire search will require between a few seconds
and one or two minutes, depending on the query (and on the speed of
the computer). It can be terminated at any time by clicking on  to
the right of the Search button at the bottom right of the dialog.
Database hits are displayed in the box at the right of the dialog*. A 3D
structure for a particular hit may be previewed by clicking on its name
in the box. The ball-and-wire model is displayed in the window at the
left of the dialog, and its name appears immediately below the window.

* Normally, only the name of the molecule is visible, but molecular weight and basis set may also be
displayed by appropriately sliding the header cells at the top of the box.

Chapter 15 12/31/03, 8:22 AM231



232

The model can be manipulated (rotated, translated, scaled) inside the
window in the usual way, but the model style cannot be changed, nor
can geometrical measurements be made. These require that selected
entries be transferred to the file system (see below).

Prior to retrieval of one or more database hits, it is necessary to specify
a destination. This is accomplished with the Retrieve Options dialog,
brought up by clicking on  to the right of the Retrieve button at the
bottom center of the dialog.

Selection of destination is accomplished by toggling between New
Document and Current Document. Selection of the former results
in request for a file name; selection of the latter results in the retrieved
molecules being appended to the end of the current molecule list.
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The Retrieve Options dialog is dismissed by clicking on OK.
Clicking on Cancel or on  also dismissed the dialog but any changes
to settings are lost.

Retrieval is accomplished by first selecting (clicking on) one or more
hits in the box and then pressing the Retrieve button at the bottom of
the SMD dialog. The Shift and Ctrl keys may be used to specify
retrieval of multiple hits. A block of entries may be specified by clicking
on the top (or bottom) entry, then holding down the Shift key and
finally clicking on the bottom (or top) entry. Multiple entries may be
specified by clicking on each in turn while holding down the Ctrl key.
The retrieve process can be stopped at any time by clicking on  to
the right of the Retrieve button at the bottom of the SMD dialog.

Transition States ( )

Spartan’04 provides a facility for guessing transition state geometries
based on the similarity of the reaction of interest with one or more
entries in Spartan’s reaction database. An exact hit is possible, in
which case the guess will be the “exact transition state”*. More
commonly, this will not be the case, and Spartan will attempt to
provide as close a match as possible with a database entry. This will
generally involve a less substituted system or one in which substituents
differ. Here, Spartan will use those parts of the structure of the
transition state in the database which are common, and will optimize
the remaining parts (using molecular mechanics). No conformational
searching is performed, and it is essential that the reactants be properly
oriented to reflect the desired stereochemical outcome of the reaction.
In this regard, whenever a reaction involves a change in the
molecularity, i.e., A + B → C, it will generally be easier to start from
the “unimolecular side” (the product in the above).

Where a reaction is completely unknown to the database, a fallback
technique similar to the linear synchronous transit method is
automatically invoked.

* More precisely, the transition state supplied in this case will be exact for the particular theoretical
model entered in the database. At the present time, the majority of database entries derive from very
simple (semi-empirical and Hartree-Fock) quantum chemical models.
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Input to Spartan’04’s transition-state guessing procedure will be very
familiar to (organic) chemists, in that it is based on “arrow pushing”.
The reaction is specified using curved arrows, where each arrow
identifies the movement of one electron pair. The direction of electron
flow follows customary practice:

source of 
electron pair

destination of
electron pair

There are only two possible “sources” of an electron pair and only three
possible destinations, leading to six combinations:

lone pair → lone pair move lone pair

lone pair → bond use lone pair to increase bond order

lone pair → “space” use lone pair to create new (single) bond

bond → lone pair decrease bond order to make lone pair

bond → bond decrease order of one bond to increase order
of another bond

bond → “space” decrease order of one bond to make a new
(single) bond

Note that the first of these is a “null” operation, and its inclusion is
optional.

Selecting Transition States results in a message at the bottom left of
the screen.

The “tail” of the arrow corresponds to the source of the electron pair.
If the source is a lone pair, then select the appropriate atom. If the
source is a bond, then select the appropriate bond. Clicking on an
atom or bond highlights (colors gold) the atom or bond and leads to
a new message at the bottom left of the screen.

The “head” of the arrow corresponds to the destination of the electron
pair. If the destination is an atom (leading to a lone pair), then select

Chapter 15 12/31/03, 8:22 AM234



235

this atom. If the destination is an existing bond (leading to an increase
in bond order from single → double → or double → triple), then
select the appropriate bond. If no bond presently exists at the
destination, press the Shift key and select the two atoms that will
become bonded. All of these operations lead to a curved arrow being
drawn on the reactant structure, and to the original message at the
bottom left of the screen.

The process (tail selection followed by head selection) is repeated
as necessary to fully define the reaction. Incorrect reaction arrows
may be removed by selecting Delete from the Build menu ( )
followed by clicking on the arrow to be deleted. In the latter case,
you need to again select Transition States ( ) in order to continue
arrow selection. Alternatively, click on the arrow(s) to be deleted
while holding down the Delete key

After all reaction arrows have been designated, clicking on  at the
bottom right of the screen replaces the “reactant” with a “guess” at the
transition state. In the event that the guess is “unreasonable”, this last
operation may be “undone” by selecting Undo (Edit menu). This allows
you to review your assignment of arrows and make changes as needed.

Tautomers ( )

Spartan’04 provides a facility for automatically identifying isomers
arising from (rapid) transfer of hydrogens among heteroatoms, that
is, so-called tautomers. Tautomer identification is especially important
in dealing with heterocyclic compounds where two or more different
tautomers may exist in equilibrium and the identity of the dominant
tautomer may not be apparent, e.g.

N
H
N OOH

2-hydroxypyridine 2-pyridone
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Having the “correct” tautomer may be essential in searches of the
Cambridge Structural Database (CSD). For example, a search of the current
CSD for derivatives of 2-hydroxypyridine yields no “hits” whatsoever,
whereas a search for derivatives of 2-pyridone yields multiple hits.

The procedure incorporated into Spartan’04 is limited to tautomers
involving nitrogen, oxygen, phosphorous and sulfur. Tautomers
involving carbon, in particular, have been excluded. Within these
limits, the procedure attempts to locate all possible tautomers, but
makes no attempt either to remove duplicates or to remove tautomers
which are likely to be highly unfavorable.*

The existence of tautomers is automatically sensed by Spartan’04
and is signaled by the word “Tautomer” being displayed at the bottom
right of the screen. (No further action needs to be taken if tautomer
identification is not of interest.) If tautomers exist, individual
structures may be examined or a complete list of structures generated
by selecting Tautomers from the Search menu (or clicking on the

 icon from the Search toolbar). Following this, clicking on  and
 buttons at the bottom right of the screen moves backwards and

forwards through the list of tautomers. Clicking on  (at the bottom
right of the screen) leads to an informative dialog.

Clicking on OK dismisses the dialog and leads to a new (unnamed)
file containing the full list of tautomers. (The original file is
unaffected.) Clicking on either Cancel or  dismisses the dialog
without a tautomer list being generated.

* Of course, once a complete list of tautomers has been generated it is straightforward to calculate their
relative energies using any of Spartan’04’s quantum chemical models.
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Chapter 16
The Options Menu

This chapter describes functions under the Options menu. These set
colors and user preferences and monitor jobs.

Functions under the Options menu provide information and allow
for setting user preferences.

About...

Provides information about the user’s release of Spartan‘04.
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A menu at the bottom of the dialog provides version numbers and
release dates for specific components of Spartan’04. The dialog is
removed by clicking on OK.

Preferences...

This sets up a number of preferences relating to the graphical user
interface in general (Miscellaneous), to molecule displays (Molecules),
and to the change of van der Waals radii (VDW Radii). It also specifies
the locations of a user-defined molecule database (Paths).

Selection results in one of four dialogs, depending on whether the
Miscellaneous, Molecule, VDW Radii or Paths tab (at the top of
the dialog) has been selected in the previous entry.

Miscellaneous

Upon first entry, the Miscellaneous tab will be selected, and the
Miscellaneous Preferences dialog displayed

(i) View:  Orthogonal/Perspective
Controls the view of structural models and graphics.

(ii) Global Rotate:  Screen Centered/Molecule Centered
Screen Centered provides a single center for rotation
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of all molecules on screen, while Molecule Centered
rotates each molecule about its individual center.

(iii) JPEG Quality
A slider bar controls the resolution of JPEG output.

(iv) Toolbar Style
Controls presentation (text vs. icons) and size of the icons.

(v) Element Overlay
If checked, this highlights elements in the expert model
kit for which the model specified in the Calculations
dialog are available.

(vi) Fast Rotate
If checked, this lowers the resolution of structure models
(only) during rotation. This is used to improve graphics
performance for displays of larger molecules.

(vii) Split-Tubes
If checked, the “tubes” in tube and ball-and-spoke
models will be split to designate multiple bonds.

(viii) Stereo
If checked, this turns “on” stereo. The viewer must wear
red/blue glasses. Also turned “on” with the “3” key (see
Keyboard Functions in Chapter 2).

(ix) CSD Interface
If checked, this displays the CSD tab in the Database
dialog (Search menu). Turn “off” if CSD is not installed.

(x) Implicit Search
If checked, this performs a search of CSD every time a
change is made to the molecular structure, assuming that
all free valences are attachment points.

(xi) Classic Builder Style
If checked, this reverts to the builder style used in earlier
versions of Spartan.
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(xii) Animation Speed
A slider bar controls the maximum speed for vibrations
and animations.

(xiii) PDB Water Filter
If checked, removes water molecules from imported
PDB files.

Molecule

Clicking on the Molecule tab leads to the Molecule Preferences
dialog.

This specifies global default settings for model and label types as
well as specification of whether or not constraint and frozen atom
markers are shown, whether or not points, planes and reaction arrows
are shown and whether or not labels for bonds, points, planes,
constraints, amino acid residues and reaction arrows are shown. These
settings may be overridden for a specific molecule (or list of
molecules) using entries under the Model menu and for specific
portions of a molecule using entries associated with Properties under
the Display menu.
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VDW Radii

Clicking on the VDW Radii tab leads to the VDW Radii Preferences
dialog.

This provides as list of van der Waals radii for elements ordered either
by element name (click on “Element”) or by atomic radius (click on
“VDW Radius”). Individual entries can be changed from default
values by first clicking on the entry and then entering a new value.
The currently selected entry can be returned to its default radius by
clicking on Reset Selected at the bottom of the dialog, and the full
set of radii may be returned to their default values by clicking on
Reset All at the bottom of the dialog.
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Paths

Clicking on the Paths tab leads to the Paths Preferences dialog.

This allows the path to be set for a user-defined database (see
Appendix H).

To exit the Preferences dialog click on OK; clicking on Cancel or
on  exits the dialog without instituting any changes.

Colors

This is used to alter the default colors of most graphical objects.
Selection leads to the Colors dialog.
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An object first needs to be selected by clicking on it, after which its
color may be set by adjusting the Red, Green and Blue slider bars.
The default color (which depends on the object) may be selected by
clicking on Default. Color selection may be performed for as many
objects as desired, and applies to all objects of the same type, e.g.,
carbon atoms, and not just to the selected object. Further control of
colors is available under Properties in the Display menu (see
Chapter 14). Clicking on  removes the dialog.

Fonts...

This allows user selection of fonts, style and size of labels attached
to molecules (see Labels and Configure... under the Model menu;
Chapter 10), and attached to plots (Plots... under the Display menu;
Chapter 14). Selection leads to the Fonts dialog.

Selections need to be made from the Font, Font Style and Size menus.
Clicking on OK dismisses the dialog with selections kept. Clicking
on Cancel or on  dismisses the dialog but selections are lost.
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Monitor

Results in the Monitor dialog which lists all jobs which are presently
executing or are queued for execution.

The box at the top gives the name of the job and the job status, i.e,
either the name of the module presently executing or the word
“queued”. To see accumulated output for an executing job, click on
its name. To kill a job, click on its name, and then select Kill Selected
from the Edit menu at the top of the Monitor dialog. To start a queued
job (irrespective of the imposed queue limits; see below), click on its
name and then select Start Selected from the Edit menu.

Queue limits as well as limits on memory and disk for an individual
process may be set using Limits under the Options menu at the top
of the Monitor dialog.

Maximum Concurrent Jobs sets the maximum number of jobs that
can be run at one time and Memory and Disk Space set maximum
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amounts of memory and disk for a single job. The dialog is dismissed
with changes instituted by clicking on OK. Clicking on Cancel or on

 dismisses the dialog but changes are lost.

Hartree-Fock calculations (only) will automatically make use of a fast
“in memory” algorithm if sufficient memory is available. 100 basis
functions can be accommodated with 110MB, 110 basis functions with
150MB, 120 basis functions with 200MB and 130 basis functions with
300MB. In this case, it may be advantageous to limit the number of
maximum concurrent jobs to 1 in order to maximize available memory.

The Monitor may be removed either by selecting Exit from the File
menu or by clicking on  at the top of the dialog.

Calculator

Selection brings up a Calculator.

This functions the same way as a normal “pocket calculator”. The
Calculator is removed by clicking on .

Model Kit

If checked, this signifies that a model kit (entry, expert, peptide or
nucleotide) is to remain on screen.
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File Toolbar, Build Toolbar, Geometry Toolbar, Search Toolbar

If checked, this provides display of toolbars which access functions
contained in the File, Build, Geometry and Search menus, respectively.

Cascade, Tile

Arranges open windows in a cascade or as tiles on top of Spartan’04’S

main window.

Arrange Icons

Arranges icons at bottom of Spartan’04’S main window.
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Chapter 17
The Help Menu

This chapter describes on-line help.

Spartan’04’s on-line help facilities are available under the Help menu..

On-Line Help

This provides information relating to application of computational
methods in general, and to methods available in Spartan’04 in
particular, as well as technical details regarding the program’s
operation.

The following topics make up on-line help:

Using the Mouse
Keyboard Functions
Calculation Options

Relative Computation Times
General Operating Features

Selecting a Model
Memory Usage

The Spartan’04 Tutorial and User’s Guide (this document) is also
available under On-Line Help. Help files are HTML documents and
require that Internet Explorer be installed.

Finally, note that several of Spartan’s dialogs incorporate imbedded
help messages. These dialogs contain  at the upper right (to the
immediate left of ). Clicking on , followed by clicking on a menu,
button, etc. in the dialog gives rise to a brief informative message
about the menu, button, etc.
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Appendix A
Capabilities and Limitations

Essential Edition of Spartan’04 for Windows

Spartan’04 for Windows is available in two versions: a “full” version
which is referred to as Spartan’04 and a lower-cost version, which is
referred to as the “Essential Edition”. The latter shares the same
graphical user interface as the full version, but lacks a number of the
“more advanced” quantum chemical models as well as the ability to
follow an intrinsic reaction coordinate, to calculate UV/visible and
NMR Spectra and to perform molecular dynamics solvent calculations.

Molecular Mechanics Models1

The molecular mechanics module provides for the calculation of
equilibrium geometries, strain energies and vibrational frequencies,
as well as for conformational searching. SYBYL (Tripos, Inc.) and
MMFF94 (Merck Pharmaceuticals) force fields are available. There
are no atom limits for molecular mechanics calculations.

Molecular mechanics parameters are read from a set of files:
SYBYL.spp (SYBYL parameters) and MMFF94.spp (MMFF
parameters). New parameters may be added or existing parameters
modified by accessing these files.

Semi-Empirical Models1

The semi-empirical module provides for calculation of heats of
formation, wavefunctions, equilibrium and transition-state geometries
and vibrational frequencies, as well as for conformational searching.
MNDO, AM1 and PM3 models are supported. MNDO/d replaces
MNDO for second-row (and heavier) main-group elements, and PM3
parameterizations for transition metals are available. MNDO has been
parameterized for H, He, Li-F, Al-Cl, Ca, Zn, Ge, Br, Cd, Sn, I, Hg
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and Pb; AM1 for H, B-F, Al-Cl, Zn, Ge, Br, Sn and I; PM3 for H-Ne,
Mg-Ar, Ca, Ti-Br, Zr, Mo-Pd, Cd-I, Hf-Pt and Hg-Bi and Gd.

Preset limits for semi-empirical calculations are enumerated below.

maximum number of atoms (any type) 300

Semi-empirical parameters are read from a set of files: MNDO.spp
(MNDO parameters), MNDOD.spp (MNDO/d parameters), AM1.spp
(AM1 parameters), PM3.spp (PM3 parameters) and PM3D.spp (PM3
parameters for metals). New parameters may be added or existing
parameters modified by accessing these files.

Hartree-Fock Models1-3

The Hartree-Fock module provides for calculation of energies and
wavefunctions, equilibrium and transition-state geometries and
vibrational frequencies, as well as for conformational searching. Both
closed-shell and open-shell (either ROHF or UHF) calculations are
supported with minimal (STO-3G), split-valence (3-21G) and
polarization (6-31G*, 6-311G*, cc-pVDZ4, cc-pVTZ4 and cc-pVQZ4)
basis sets supplemented by additional polarization and/or diffuse
functions. Also available are pseudopotentials for calculations on
molecules incorporating heavy atoms.4

Preset limits for Hartree-Fock calculations are enumerated below.

maximum number of atoms 200
maximum number of basis functions 2000

Density Functional Models1,2,4

The density functional module provides for calculation of energies
and wavefunctions, equilibrium and transition-state geometries and
vibrational frequencies, as well as for conformational searching. The
module supports local density calculations and BP, BLYP, EDF1,
B3LYP density functional calculations. The same basis sets and
pseudopotentials supported for Hartree-Fock calculations are
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available, although use of the minimal STO-3G and split-valence
3-21G basis sets is strongly discouraged.

Preset limits for density functional calculations are enumerated below.

maximum number of atoms 200
maximum number of basis functions 2000

Møller-Plesset Models1,2,4

The Møller-Plesset module provides MP2, MP3 and MP4, as well as
“local” MP2 (LMP2) energy calculations. In addition, the MP2 model
(only) may be used for calculating equilibrium and transition-state
geometries and vibrational frequencies, as well as for conformational
searching. The same basis sets and pseudopotentials supported for
Hartree-Fock calculations are available, although use of the minimal
STO-3G and split-valence 3-21G basis sets is strongly discouraged.

Preset limits for MP2 calculations are enumerated below.

maximum number of atoms 200
maximum number of basis functions 2000

MP3 and MP4 calculations increase in cost very rapidly with
increasing molecular size and are presently practical only for small
molecules.

Advanced Correlated Models1,2,4

The advanced correlated module provides for calculation of energies
using the CCSD, CCSD(T), CCSD(2), OD, OD(T), QCISD,
QCISD(T), QCCD and QCCD(2) correlated models. The same basis
sets and pseudopotentials supported for Hartree-Fock calculations
are also available, although use of the minimal STO-3G and split-
valence 3-21G basis sets is strongly discouraged. Energy calculations
are also supported with the G2, G3, and G3(MP2) models, which
comprise a series of different models and are intended to provide
accurate thermochemical data.
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Advanced correlated calculations increase in cost very rapidly with
increasing molecular size, and are presently practical only for very
small molecules.

Excited-State Models

Two classes of models are available for calculations of excited states:
configuration interaction (CI) models and time dependent density
functional (TDDFT) models. The former comprises two models: CIS
(configuration interaction singles) and CISD (configuration
interaction singles with doubles correction), while the latter supports
the local density model as well as BP, BLYP, EDF1 and B3LYP density
functional models. At the present time, only the CIS model is available
for geometry optimization and frequency calculations, all other
models being restricted to single-point energy calculations.

Preset limits for excited-state calculations are enumerated below.

maximum number of atoms 200
maximum number of basis functions 2000

Properties and Spectra

The properties module (which is automatically called from the
molecular mechanics module or one of the quantum chemical
modules) provides for text output printing, population analyses
(Mulliken, natural bond orbital and based on fits to electrostatic
potentials), evaluation of thermodynamic quantities (enthalpy, entropy
and free energy), and calculation of the dipole moment. Aqueous
solvation energies, may be estimated using the SM5.4 model of
Cramer and Truhlar5 (available for H, C-F, S-Cl, Br and I), and added
to gas-phase total energies obtained at other levels of calculation.
Additionally, solvent effects on energies as well as molecular
properties and graphical surfaces, may be obtained from a molecular
dynamics procedure in which the solvent-solute electrostatic
interactions are incorporated into the Hamiltonian for the solute.4
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1. For discussion and original references, see: W.J. Hehre, A Guide to Molecular Mechanics
and Quantum Chemical Calculations, Wavefunction, Irvine, 2003

2. For a review of the quantum chemical methods used in Spartan’04 (except for semi-empirical
methods), see: J. Kong, C.A. White, A.I. Krylov, C.D. Sherrill, R.D. Adamson, T.R. Furlani,
M.S. Lee, A.M. Lee, S.R. Gwaltney, T.R. Adams, C. Ochsenfeld, A.T.B. Gilbert, G.S.
Kedziora, V.A. Rassolov, D.R. Maurice, N. Nair, Y. Shao, N.A. Besley, P.E. Maslen, J.P.
Dombroski, H. Daschel, W. Zhang, P.P. Korambath, J. Baker, E.F.C. Byrd, T. Van Voorhis,
M. Oumi, S. Hirata, C.-P. Hsu, N. Ishikawa, J. Florian, A. Warshel, B.G. Johnson, P.M.W.
Gill, M. Head-Gordon, and J.A. Pople, J. Computational Chem., 21, 1532 (2000).

3. For an older account see: W.J. Hehre, L. Radom, P.v.R. Schleyer and J.A. Pople, Ab Initio
Molecular Orbital Theory, Wiley, New York, 1986.

4. Not available in Essential Edition.
5. C.C. Chambers, G.D. Hawkins, C.J. Cramer and D.G. Truhlar, J. Phys. Chem., 100, 16385

(1996).

The properties module is also responsible for providing data for later
plotting of vibrational (infrared) spectra (all models except MP3, MP4
and advanced correlated models), UV/visible spectra4 (Hartree-Fock,
local density and density functional models only) and NMR spectra4

(chemical shifts only and only for Hartree-Fock models).

Graphics

The graphics module provides for data preparation associated with
the display as surfaces, property maps and slices of molecular orbitals,
electron densities, spin densities, electrostatic potentials and local
ionization potentials.
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Menus
File

New Brings up a model kit for molecule building
Open... Opens (imports) a molecule
Close Closes a molecule
Save Saves (exports) a molecule
Save As... Saves a molecule under a user-specified name
New Molecule Adds a molecule to an existing list; brings up

a model kit for molecule building
Delete Molecule Deletes a molecule (or molecules) from a list
Append Molecule(s)... Appends a molecule (or molecules) to an

existing list
Print... Prints on-screen display
Print Setup... Setup for printing
Exit Exits Spartan’04

Edit

Undo Undoes previous operations
Cut Moves the current molecule or contents of the

selection box to the clipboard
Copy Copies the current molecule or contents of the

selection box to the clipboard
Paste Pastes contents of the clipboard to the screen
Find... Locates a text string in the output dialog or an

on-screen molecular fragment
Find Next Locates next occurrence of a text string or

molecular fragment
Center Centers the molecule on screen
Clear Clears the screen (build mode only)

Appendix B
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Model

Wire Displays structure as wire-frame model
Ball and Wire Displays structure as ball-and-wire model
Tube Displays structure as tube model
Ball and Spoke Displays structure as ball-and-spoke model
Space Filling Displays structure as space-filling model
Hide Hides structure model from view
Global Model Applies model type and labels of current

molecule to all molecules in the list
Coupled Couples motions of all molecules in the list
Hydrogens Toggles hydrogens “on” and “off”
Labels Toggles labels “on” and “off”
Ribbons Toggles ribbons “on” and “off”
Hydrogen Bonds Toggles hydrogen bonds “on” and “off”
Configure... Specifies labels for atoms, bonds, points,

planes, etc., in addition to information about
individual residues in polypeptides and
polynucleotides and ribbon displays

Geometry

Measure Distance Displays and/or sets bond distance
Measure Angle Displays and/or sets bond angle
Measure Dihedral Displays and/or sets dihedral angle
Freeze Center Freezes selected atomic positions
Set Torsions Selects bonds and rings for conformational

searching
Constrain Distance Constrains bond distance
Constrain Angle Constrains bond angle
Constrain Dihedral Constrains dihedral angle
Define Point Defines a point as a geometric mean of a set

of atoms
Define Plane Defines a plane made by three atoms
Align Molecules Aligns molecules in a list
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Build

View Removes the model kit
Add Fragment Adds atomic fragment, functional group, ring,

ligand or custom fragment
Delete Deletes atoms, bonds, points, planes, etc.
Make Bond Makes a bond between two free valences, two

atoms or a free valence and an atom
Break Bond Breaks a bond
Minimize Performs molecular mechanics energy

minimization

Setup

Calculations... Sets up molecular mechanics and quantum
chemical calculations

Surfaces Sets up generation of and displays graphical
surfaces

Submit Submits job to the execution queue

Display

Output Displays text output
Properties Displays molecule, bond and atom properties

as well as information about geometrical
constraints, graphical surfaces, plots and
statistical analyses

Surfaces Sets up generation of and displays graphical
surfaces (same as entry in Setup menu)

Spectra Displays IR, NMR and/or UV/visible spectra
and animates vibrational modes (associated
with IR spectra).

Spreadsheet Displays spreadsheet

Plots... Creates plots from the data in the spreadsheet
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Search

Databases Performs substructure search on the
Cambridge Structural Database (CSD) and/or
the Spartan Molecular Database (SMD)

Transition States Provides guess at transition states based on
reaction database or, in the absence of a
suitable database entry, based on the linear
synchronous transit method

Tautomers Identifies tautomers

Options

About... Provides information about Spartan’04,
Wavefunction and Q-Chem

Preferences... Sets various run-time preferences

Colors Sets screen and model colors

Fonts... Sets fonts for molecule labels and plot displays

Monitor Monitors and allows for “killing” executing
jobs as well as control job queue

Calculator “Pocket” calculator

Model Kit Keeps a model kit on screen

File Toolbar Toggles File toolbar “on” and “off”

Build Toolbar Toggles Build toolbar “on” and “off”

Geometry Toolbar Toggles Geometry toolbar “on” and “off”

Search Toolbar Toggles Search toolbar “on” and “off”

Cascade Arranges open windows in a cascade

Tile Arranges open windows as tiles

Arrange Icons Arranges icons at bottom of screen

Help

On-Line Help Provides information about computational
methods in Spartan’04 and details about
program usage.
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Appendix C
Commonly-Used
 Program Options

This appendix describes a number of commonly-used program
options. These are specified using keywords input into the Options
box in the Calculations dialog (Setup menu). Keywords are case
insensitive. An equals sign (“=”) separates a keyword from its integer,
real or character string value. Keywords may either be single words
or expressions. Keyword=N indicates an integer argument,
keyword=C indicates a character argument, and keyword=F indicates
a floating point argument. Real values can optionally include an “e”
floating point power of ten. Default values for keywords are indicated
in bold, and alternative values in italics.

Conformational Search

Keywords associated with conformational searching are as follows:

keyword value description

SearchMethod C conformational searching method employed;
overrides default choice which depends on
complexity of system may be overridden with
one of the following:
Systematic use systematic method
MonteCarlo use Monte-Carlo method

MaxConfs N set maximum number of conformers to N; the
program attempts to select the most diverse
set representing the entire population; default
is 100

Window F sets the maximum energy (in kcal/mol) at
which a conformer will be kept to (minimum
energy + F), where minimum energy is the
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energy of the lowest energy conformer
encountered at that point in the search; default
is 10 kcal/mol

MaxItr N sets the number of iterations allowed for a
Monte Carlo search (only) to N; default is a
function of the number of bonds and rings
involved in the search

StartTemperature F sets initial “temperature” (in K) for a Monte
Carlo search (only) to F; high temperatures
will result in the molecule further “exploring”
global space, while low temperatures will
result in the molecule further “exploring” local
space; default is 5000K

Geometry Optimization

Keywords associated with equilibrium geometry optimization (all
methods) and transition-state geometry optimization (quantum
chemical methods only) are as follows:

keyword value description

GeometryCycle N set maximum number of equilibrium and
transition-state geometry optimization cycles
to N; default is number of independent
variables +20 for equilibrium geometry
optimization and 3x number of independent
variables for transition-state geometry
optimization

GradientTolerance F set convergence criterion in equilibrium and
transition-state) geometry optimization for the
maximum gradient component (in hartrees/
bohr) to F; default is 4.5 x 10-4

DistanceTolerance F set convergence criterion in equilibrium and
transition-state geometry optimization for the
maximum change in a bond length (in Å) to
F; default is 1.8 x 10-3

Hess C Choose Hessian (matrix of second derivatives)
for start of geometry (transition-state geometry)
optimization (in the absence of a Hessian from
a previous calculation, the default is MMFF
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molecular mechanics for geometry
optimization and PM3 semi-empirical for
transition-state geometry optimization; may be
overridden with one of the following:

unit unit matrix
MMFF MMFF molecular mechanics
AM1 AM1 semi-empirical
STO-3G STO-3G Hartree-Fock
3-21G 3-21G Hartree-Fock
6-31G* 6-31G* Hartree-Fock

Quantum Chemical Calculations

Keywords associated with all quantum chemical calculations are as
follows:

keyword value description

Diis N switch on diis all the time in SCF procedure.
N is the size of the iterative subspace; it should
be an integer between 2 and 10; default is 5

NoDiis turn off diis SCF convergence accelerator

Energy F set SCF energy convergence criterion (in
hartrees) to F; default is 1.0 x 10-6

ScfCycle N set maximum number of SCF iterations to N;
default is 50

Guess C choose initial wavefunction guess; in the
absence of a guess from a previous calculation,
the default is either sad or PM3 depending on
the calculation type, and may be overridden
with one of the following:

core diagonalize the core Hamiltonian
sad superposition of atomic densities
PM3 PM3 semi-empirical

Scf C SCF procedure; default is restricted for closed-
shell systems and unrestricted for open-shell
systems, either of which may be specified for
both closed and open-shell systems

Core C use of frozen core approximation in Møller-
Plesset and advanced correlated calculations;
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default is frozen which may be changed to
thawed

ScfTolerance C control of all tolerances in SCF procedure;
default is normal which may be changed to
high or veryhigh

F set SCF energy convergence criterion (in
hartrees) to F; default is 1.0 x 10-6

BigGrid – uses very large grid in density functional
calculations

Mix – specifies that α and β HOMO’s in the guess
wavefunction should be constructed according
to:

useful for generating a guess wavefunction for
singlet diradical

SmallMemory, – forces use of direct methods in Hartree-Fock
BigMolecule calculations

SmallMolecule – attempts to use in-core methods in Hartree-
Fock calculations

PrintCoords – prints Cartesian coordinates

PrintLev C print level; default is normal which may be
changed to verbose or debug

Semi-Empirical Calculations

Keywords unique to semi-empirical calculations are as follows:

keyword value description

NoPseudo – turns “off” pseudodiagonalization in response
to convergence difficulties

NoAmideFix – turns “off” molecular mechanics amide
correction in PM3 calculations

hhOff – turns “off” hydrogen-hydrogen repulsion term
in PM3 calculations; default only where no

HOMOα =
HOMO + LUMO

√2

HOMOβ =
HOMO - LUMO

√2
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transition metals are involved for compatibility
with “standard” PM3

hhOn – turns “on” hydrogen-hydrogen repulsion term
in PM3 calculations; default where transition
metals are involved

Property and Spectra Calculations

Keywords associated with properties calculations are as follows:

keyword value description

NBO C specify details of NBO population analysis;
default is normal which may be overridden
for ionic and 3C (three center) systems

NoElCharge – turns “off” calculation of electrostatic charges

NoMulCharge – turns “off” calculation of Mulliken charges

NoNatCharge – turns “off” calculation of NBO charges

ElCharge N adjusts size of grid used to calculate charge
from electrostatic potential; default is 1 point/
atomic unit

Temperature F temperature (in K) used in calculation of
thermodynamic properties; default is 298°K

Pressure F pressure (in atm) used in calculation of
thermodynamic properties; default is 1 atm

Moments – calculates and prints principal moments of
inertia

NoSolvent – turns “off” calculation of aqueous solvation
energy using SM5.4 model

FScale F scales calculated vibrational frequencies by F;
default is 1

DynamicsTime N time (in fs) for molecular dynamics simulation
for solvent calculations; default is 1500 fs

SampleTime N time (in fs) between sample points in
molecular dynamics simulation for solvent
calculations; default is 50 fs

MaxSamples N maximum number of sample configurations
in molecular dynamics simulation for solvent
calculations; default is 10
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Cutoff F maximum solute-solute distance (in Å) for
interactions to be explicitly treated in
molecular dynamics simulations for solvent
calculations; default is 14.0Å

IRCSteps N maximum number of steps allowed in
constructing IRC; default is 40

IRCStepSize N maximum step size (in mass-weighted atomic
units x 100) for IRC; default is 150
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Appendix D
Units

Geometries

Cartesian coordinates are typically given in Ångstroms (Å), but are
also available in atomic units (au).

Bond distances are typically given in Å but are also available in au.
Bond angles and dihedral angles are given in degrees (°).

Surface areas are typically given in Å2 and volumes in Å3, but are
also available in au2 (au3).

1 Å = 0.1 nm=1.889762 au

Energies, Heats of Formation and Strain Energies

Total energies from Hartree-Fock, local density, density functional
and correlated calculations are typically given in au, but are also
available in kcal/mol, kJ/mol and electron volts (eV).

Heats of formation from semi-empirical calculations are typically
given in kcal/mol, but are also available in au, kJ/mol and eV.

Strain energies from molecular mechanics calculations are typically
given in kcal/mol, but are also available in au, kJ/mol and eV.

Orbital Energies

Orbital energies are typically given in eV, but are also available in
kcal/mol, kJ/mol and au.
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Energy Conversions

au kcal/mol kJ/mol eV

1 au - 627.5 2625 27.21
1 kcal/mol 1.593 (-3) - 4.184 4.337 (-2)
1 kJ/mol 3.809 (-4) 2.390 (-1) - 1.036 (-2)
1 eV 3.675 (-2) 23.06 96.49 -
a) exponent follows in parenthesis, e.g., 1.593 (-3) = 1.593 x 10-3

Electron Densities, Spin Densities, Dipole Moments, Charges,
Electrostatic Potentials and Local Ionization Potentials

Electron densities and spin densities are given in electrons/au3.

Dipole moments are given in debyes.

Atomic charges are given in electrons.

Electrostatic potentials are given in kcal/mol.

Local ionization potentials are given in eV.

Vibrational Frequencies

Vibrational frequencies are given in wavenumbers (cm-1).

Chemical Shifts

Chemical shifts are given in parts-per-million (ppm) relative to
appropriate standards: proton, tetramethylsilane; carbon,
tetramethylsilane. See Appendix E for numerical values.

UV/visible Spectra

λmax is given in wavenumbers (cm-1).
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Appendix E
NMR Chemical Shift Standards

Listed below are calculated absolute chemical shifts for 1H, 13C, 15N,
19F, 29Si and 31P from Hartree-Fock models with the following basis
sets for the usual “reference” compounds.

nuclei reference compound 3-21G 6-31G* 6-31G**

1H tetramethylsilane 33.61 32.89 32.33

13C tetramethylsilane 213.15 201.67 203.10

15N nitromethane 251.02 169.28 160.43

19F fluorotrichloromethane 279.76 269.48 269.48

29Si tetramethylsilane 508.94 450.14 448.39

31P phosphoric acid 504.17 423.64 423.16

nuclei reference compound 6-31+G* 6-311G* 6-311+G**

1H tetramethylsilane 32.82 32.83 32.78

13C tetramethylsilane 201.85 195.92 195.87

15N nitromethane 159.64 177.41 184.80

19F fluorotrichloromethane 260.87 247.02 246.38

29Si tetramethylsilane 446.69 395.43 396.84

31P phosphoric acid 415.38 368.32 363.65

Chemical shift values reported by Spartan’04 for these nuclei with
these Hartree-Fock models are in ppm relative to these standards.
Chemical shift values for Hartree-Fock models with other basis sets
are reported as absolute values.
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Appendix F
Citation

The proper citation for Spartan’04 is as follows:

Spartan’04
Wavefunction, Inc.

Irvine, CA

Except for molecular mechanics and semi-empirical models, the
calculation methods used in Spartan’04 have been documented in: J.
Kong, C.A. White, A.I. Krylov, C.D. Sherrill, R.D. Adamson, T.R.
Furlani, M.S. Lee, A.M. Lee, S.R. Gwaltney, T.R. Adams, C.
Ochsenfeld, A.T.B. Gilbert, G.S. Kedziora, V.A. Rassolov, D.R.
Maurice, N. Nair, Y. Shao, N.A. Besley, P.E. Maslen, J.P. Dombroski,
H. Daschel, W. Zhang, P.P. Korambath, J. Baker, E.F.C. Byrd, T. Van
Voorhis, M. Oumi, S. Hirata, C.-P. Hsu, N. Ishikawa, J. Florian, A.
Warshel, B.G. Johnson, P.M.W. Gill, M. Head-Gordon, and J.A. Pople,
J. Computational Chem., 21, 1532 (2000).

A discussion and assessment of commonly-used calculation methods
is found in: W.J. Hehre, A Guide to Molecular Mechanics and
Quantum Chemical Calculations, Wavefunction, Irvine, 2003.

Appendix F 12/31/03, 8:01 AM269



Appendix F 12/31/03, 8:01 AM270



271

Appendix G
Installing the

Cambridge Structural Database
Access to the Cambridge Structural Database (CSD) from Spartan’04
should be “automatic”, following successful installation of the
ConQuest program (supplied with CSD) according to the detailed
instructions provided. If access is denied, the following steps need to
be taken:

(i) Click on the square box immediately to the left of the Retrieve
button at the bottom of the CSD dialog. This brings up the
Configure CSD dialog,

This will list any files which are “missing”. Click on Setup Paths
at the bottom of the dialog to bring up the CSD File Paths dialog,
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This dialog should show one or more “red lights”.

(ii) Make certain that the path to ConQuest is correctly specified.
The most common error will be that the version number is not
current. (At the time of writing, the current version is 1.5.) You
can get the current version number from your installation of
ConQuest.

(iii) Given the proper version number for ConQuest, update the file
names in the boxes below “MSK file”, “TCD file”, “IND file”
and “INV file”. You can get the current file names from your
installation of ConQuest. As you enter the current file names,
the “red lights” should turn to “green lights”. When all lights
are “green”, click on OK to dismiss the CSD File Paths dialog
and then click on OK to dismiss the Configure CSD dialog.
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Appendix H
Constructing Custom Databases

The user is free to add molecules to the Spartan Molecular Database,
or to add different calculation levels for molecules which already
exist. These new entries will not actually supplement (or replace)
existing SMD entries, but rather will go into one or more (user defined)
directories which will be accessed in addition to the existing SMD
directory. At the present time, database information (abstracted from
the original calculations) is limited to geometry, total energy, HOMO
and LUMO energies, dipole moment, Mulliken, NBO and
electrostatic-fit atomic charges, chemical shifts and vibrational
frequencies. Future versions of the database may extend this list.

Creation of new database entries follows by saving a molecule (or
list of molecules) as a Spartan Entry (.spentry) file (Save As under
the File menu with Save as type set to Spartan Entry). The file
name is not important, but the path to the directory must be entered
into the Paths Preferences dialog (under Preferences... in the
Options menu; see Chapter 16). This will typically follow the name
of the default (SMD) directory “.\Standard Names” and be preceded
by a semicolon “;”. As many user-defined directories as desired may
be defined (separated by semicolons).

Note that a “name” for each molecule needs to be specified. This is
done as a Label either in the Molecule Properties dialog (see
Properties under the Display menu in Chapter 14) or in the
spreadsheet (see Spreadsheet under the Display menu in Chapter
14).

IT IS IMPORTANT THAT ALL ORIGINAL DATA BE SAVED.
ACCESS INFORMATION (SMILES-LIKE STRINGS) WILL
BE EXTENDED AND/OR CHANGED TO INCLUDE NEW
DATA TYPES (IN PARTICULAR, TRANSITION METAL
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SYSTEMS AND TRANSITION STATES). PROCEDURES
WILL BE SUPPLIED WITH FUTURE RELEASES TO
CREATE UPDATED ACCESS INFORMATION BASED ON
YOUR DATA.
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Appendix I
Installing a Network HASP

Spartan’04 requires a hardware license key which is normally installed
on each machine. However, a network hardware key can be obtained
from Wavefunction and installed on a server. This allows Spartan’04
to be run on a specified number of “client” machines on the network.
A one-time installation is required.

On the Server:

1. Install Spartan and HASP device driver on the server. The server
must be running Windows 98 or higher (Wavefunction strongly
recommends Windows NT/2000 or higher).

2. Copy Lmsetup.exe from the Spartan CD ROM onto the server’s
hard drive and install the program by double-clicking on the icon.

3. When the program is finished installing, restart the server and
verify that the NetHASP license manager has loaded the
necessary protocols for your network.

On Each Client Computer:

4. Install software on the network clients that will access the NetHASP
through the network. The HASP device driver is not required for
installing the program on client computer. DO NOT install the
NetHASP license manager.This is typically an auto-install.

5. Verify that the license manager is functioning correctly by trying
to access Spartan from a network client computer (computer
without the NetHASP hardware).
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Additional:

6. If you want to run Spartan locally on the server, you must also
install Spartan on the server.If client computers are on a dif ferent
subnet from the license server, a Nethasp.ini file must be created
and included in the directory with the Wavefunction program files.

Need additional help? Please visit our “Network Installation
Frequently Asked Questions” (FAQ) page:

http://www.wavefun.com/support/pc/faqpcnetwork1.html
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A

About; Options menu, about ....... 237

Absorption maximum (λmax),
units ............................................. 266

Add Columns dialog ............... 52,207

Add Fragment; Build menu,
add fragment ........................... 33,161

Add Linear Regression dialog 63,209

Add Summaries dialog ................ 208

Add Surface dialog ................. 28,182

Align Molecules; Geometry
menu, align molecules ............ 56,144

Alt key, use of ........................ 11,12ff

AM1 ............................................. 249

AM1 calculations, on
acrylonitrile .............................. 51
allyl vinyl ether ........................ 56
androsterone............................. 99
3-cyano-4-methylcyclohexenyl
radical ...................................... 38
decaglycine ............................ 105
1,1-dicyanoethylene ................. 51
1,2-dicyanoethylene ................. 51
SN2 reaction of bromide and
methyl chloride ........................ 90

tetracyanoethylene ................... 51
transition state for Diels-Alder
cycloaddition of
cyclopentadiene and
acrylonitrile .............................. 83
transition state for Diels-Alder
cycloaddition of
5-fluorocyclopentadiene and
acrylonitrile .............................. 84
transition state for Diels-Alder
cycloaddition of
5-methylcyclopentadiene and
acrylonitrile .............................. 84
tricyanoethylene....................... 51
vitamin E ................................. 95
vitamin E radical ...................... 96

AM1 parameters .......................... 250

Amino acids, in peptide builder ... 155

Angles
constraining ........................... 141
measuring .............................. 136
“posting” to spreadsheet ........ 137
units ....................................... 265

Append Molecule(s); File
menu, append molecule(s) ...... 88,122

Archive ........................................ 188

Area ...................................... 195,212

Arrange Icons; Options menu,
arrange icons ................................ 246

Note: Items in bold type refer to entries in Spartan‘04 menus.

Index
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Atomic charges
displaying ....................... 134,191
electrostatic ............................ 252
for SN2 reaction of bromide
and methyl chloride ................. 90
for sulfur tetrafluoride ........... 112
Mulliken ................................ 252
natural .................................... 252
units ....................................... 266

Atomic fragments, in entry
model kit ...................................... 146

Atomic hybrids, in expert
model kit ...................................... 153

Atomic radii,
used in space filling models... 131
changing ................................ 241

Atomic weight ........................ 87,191

Atom colors .......................... 129,192

Atom labels ............................. 23,132

Atom Properties dialog ........... 28,191

Atom replacement................... 30,160

Atom Style dialog ........................ 192

AVI............................................... 120

B

B3LYP/6-31G* calculations on
dimethylperoxide ..................... 61
1-pentene ................................. 78
transition state for ene reaction
of 1-pentene ............................. 78

Ball and Spoke; Model menu,
ball and spoke ......................... 22,130

Ball-and-spoke model ............. 22,130

Ball and Wire; Model menu,
ball and wire ........................... 22,128

Ball-and-wire model ............... 22,128

Bitmap ......................................... 120

Boltzmann equation ....................... 70

Bond density, for
SN2 reaction of bromide and
methyl chloride ........................ 91
transition state for ene
reaction 1-pentene.................... 77

Bond distances
constraining ........................... 141
measuring .............................. 136
“posting” to spreadsheet ........ 136
units ....................................... 265

Bond Properties dialog ................ 192

Bonds
rotation ................................... 160
stretching ............................... 160

Bond Style dialog ........................ 193

BP/6-31G* calculations, on
benzene .................................. 114
benzene chromium tricarbonyl.114
bis(cyclopentadienyl)(methyl)
zirconium cation .................... 116
ethylene .................................. 116

Index 12/31/03, 8:27 AM278



279

transition state for ethylene
insertion into
bis (cyclopentadienyl) (methyl)
zirconium cation .................... 116

Break Bond; Build menu,
break bond ................................... 163

Builders .................................145-164

Building
acetaldehyde ............................ 62
acetic acid ................................ 65
acetone ..................................... 62
acetophenone ........................... 62
acrylonitrile .............................. 19
allyl vinyl ether ........................ 55
androsterone............................. 97
benzaldehyde ........................... 62
benzene .................................. 113
benzene chromium tricarbonyl.113
benzoic acid ............................. 65
benzyne .................................... 41
bis(cyclopentadienyl) (methyl)
zirconium cation .................... 116
tert-butylaldehyde .................... 62
2-butyne ................................... 42
camphor ................................... 33
chloroacetic acid ...................... 65
3-cyano-4-methylcyclohexenyl
radical ....................................... 38
cyclohexane ............................. 44
cyclohexanone ......................... 30
decaglycine ............................ 104
decalin ...................................... 44
dichloroacetic acid ................... 65
1,1-dicyanoethylene ................. 50
1,2-dicyanoethylene ................. 50
Diels-Alder cycloaddition
of cyclopentadiene and
Maleic anhydride ..................... 79
dimethylcyclohexane ............... 44

dimethylperoxide ..................... 58
ethinamate ................................ 36
ethylene .................................. 116
formaldehyde ........................... 62
formic acid ............................... 65
hexafluoroacetone .................... 62
2-hexene................................... 68
2-hydroxypyridine ................... 70
1-methylcytosine ..................... 69
2-methylnorbornane................. 69
1-pentene ................................. 75
pivalic acid ............................... 65
2-pyridone ................................ 73
SN2 reaction of bromide and
methyl chloride ........................ 89
sulfur tetrafluoride ................. 111
tetracyanoethylene ................... 50
transition state for Diels-Alder
cycloaddition of cyclopentadiene
and acrylonitrile ....................... 82
transition state for Diels-Alder
cycloaddition of
5-fluorocyclopentadiene and
acrylonitrile .............................. 83
transition state for Diels-Alder
cycloaddition of
5-methylcyclopentadiene and
acrylonitrile .............................. 84
transition state for
difluorocarbene addition to
cyclohexene ............................. 87
transition state for
difluorocarbene addition to
ethylene .................................... 85
transition state for ene
reaction of 1-pentene ............... 75
transition state for ethylene
insertion into
bis(cyclopentadienyl)
(methyl) zirconium cation ..... 115
trichloroacetic acid .................. 65
tricyanoethylene....................... 50

Index 12/31/03, 8:27 AM279



280

trifluoroacetaldehyde ............... 62
trifluoroacetone ........................ 62
trifluoroacetophenone .............. 62
triglycine ................................ 102
vitamin E ................................. 95
vitamin E radical ...................... 96

Build menu
add fragment ..................... 33,161
break bond ............................. 163
delete ................................. 38,162
make bond ........................ 33,162
minimize ........................... 21,164
view .................................. 21,161

Build Toolbar; Options menu,
build toolbar ................................. 246

C

13C chemical shifts, for
cyclohexane ............................. 44
decalin ...................................... 44
dimethylcyclohexane ............... 44
2-hexene................................... 68
2-methylnorbornane................. 69

13C spectrum, of decalin ................. 44

Calculate ................................. 24,167

Calculation options ...................... 177

Calculations; Setup menu,
calculations ...................... 24,166,167

Calculations dialog ................. 24,167

Calculations dialog, essential
edition .......................................... 178

Calculator; Options menu,

calculator ..................................... 245

Calculator dialog.......................... 245

Cambridge Structural Database
..............................................219-226

Cambridge Structural Database
dialog .......................... 34,35,221,224

Carbonyl compounds
hydration of ............................. 62
nucleophilic reactivity ............. 30

Carboxylic acids, acidities of......... 65

Cascade; Options menu, cascade .246

CCSD, CCSD(T), CCSD(2)
models .......................................... 251

Center; Edit menu, center ........... 126

Charge .......................................... 176

Chemical shifts
displaying ....................... 134,191
standards ................................ 267
units ....................................... 266

Chirality
displaying .................. 34,134,191
inverting ................................... 13

CIS, CIS(D) models ..................... 252

Clear; Edit menu, clear .......... 20,126

Clipboard
copying to ............................... 50,
use of in entry builder ....... 50,151
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Close; File menu, close .......... 29,120

Colors; Options menu, colors ..... 129

Colors
atom ................................ 129,192
bond ................................ 128,193
constraint ............................... 194
curve ...................................... 200
plane ...................................... 195
plot ......................................... 198
point ....................................... 195
setting .................................... 242
surface .................................... 196

Colors dialog ............................... 242

Compute ................................. 42,173

Configure; Model menu,
configure ................................. 22,133

Configure CSD dialog ................. 271

Configure Labels dialog ......... 22,133

Configure Ribbons dialog ............ 134

Conformational search, on
allyl vinyl ether ........................ 55
3-cyano-4-methylcyclohexenyl
radical ...................................... 38
ethinamate ................................ 37

Conformer distribution .................. 55

ConQuest ..................................... 220

Constrain Angle; Geometry
menu, constrain angle .................. 141

Constrain Dihedral; Geometry

menu, constrain dihedral......... 58,141

Constrain Distance; Geometry
menu, constrain distance......... 71,141

Constraint Properties dialog .. 59,193

Constraints, turning on ................ 173

Constraint Style dialog ................ 194

Control key, use of ...................... 12ff

Convergence difficulties .............. 178

Copy; Edit menu, copy........... 50,125

Copyright information ................. 237

Correlated models available in
Spartan’04

CCSD, CCSD(T), CCSD(2) .. 251
OD, OD(T) ............................ 251
QCISD, QCISD(T) ................ 251
QCCD, QCCD(2) .................. 251

Coupled; Model menu,
coupled ................................... 67,132

CPK models ................................. 130

CSD ............................34,35,219-226

CSD data ...................................... 188

CSD dialog ................. 34,35,221,224

CSD file paths dialog ................... 272

Cubic spline .............................. 53,60

Curve Properties dialog .......... 54,199
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Curve Scale Properties dialog...... 200

Curve Style dialog ....................... 200

Cut; See Edit menu, cut

D

d and l amino acids, in peptide
builder .......................................... 156

Databases; Search menu,
databases ...............................219-233

Define Ligand Point; Geometry
menu, define ligand point ............ 143

Define Plane; Geometry
menu, define plane ....................... 143

Define Point; Geometry
menu, define point ....................... 143

Delete; Build menu, delete ..... 38,162

Delete key, use of ...................... 14,41

Delete Molecule; File menu,
delete molecule ....................... 56,122

Density .................................. 170,266

Density functional calculations;
See B3LYP/6-31G* calculations,
BP/6-31G* calculations

Density functional models
available in Spartan’04

B3LYP ................................... 250
BLYP ..................................... 250
BP .......................................... 250
EDF1...................................... 250

local ....................................... 250
range of applications .............. 251

Density functional models ........... 250

Dialogs, in Spartan’04 ................... 15

Dihedral angles
constraining ........................... 141
measuring .............................. 137
“posting” to spreadsheet ........ 138
units ....................................... 265

Dipole moments
display of .......................... 27,190
for acrylonitrile ........................ 27
units ....................................... 265

Dipole moment vector ............ 27,190

Display menu
output ................................ 26,187
plots .................................. 53,215
properties .......................... 27,189

atom properties ................... 191
bond properties ................... 192
constraint properties ........... 193
curve properties .................. 196
molecule properties............. 190
plane properties................... 194
plot properties ..................... 196
point properties ................... 194
regression properties ........... 200
selected style ....................... 201
surface properties ................ 195
Spectra ........................... 42,202

IR ..................................... 202
UV/vis .............................. 204
NMR ................................ 205

spreadsheet........................ 51,206
surfaces ............................. 28,202
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E

Edit menu
center ..................................... 126
clear .................................. 20,126
copy .................................. 50,125
cut .......................................... 125
find ......................................... 126
find next ................................. 126
paste ....................................... 125
undo .................................. 20,125

Edit menu (monitor)
kill selected ............................ 244
start selected .......................... 244

Electron density
for androsterone ....................... 99
units ....................................... 266

Electrostatic charges .................... 252

Electrostatic potential map, for
acrylonitrile .............................. 28
benzene .................................. 114
benzene chromium tricarbonyl 114
decaglycine ............................ 105
SN2 reaction of bromide
and methyl chloride ................. 91
transition state for ene
reaction of 1-pentene ............... 77
vitamin E ................................. 96

Element overlay .................... 159,239

Element symbol, display of ......... 191

Ending jobs .................................. 144

End key, use of ............................... 14

Energy
conversions ............................ 266
display of ............................... 190
units ....................................... 265

Energy profile ................................ 59

Entropy ........................................ 175

Entry model kit ....................... 19,146

Equilibrium conformer .................. 37

Equilibrium geometry .................... 24

Error log ....................................... 188

Excited-state models available
in Spartan’04

CIS, CIS(D) ........................... 252
TDDFT .................................. 252

Expert model kit ................... 111,151

Exit; File menu, exit; File
menu (monitor) exit ................ 11,123

F

File formats
AVI......................................... 121
Bitmap ................................... 121
JPEG ...................................... 121
MacroModel .......................... 120
PDB ....................................... 120
PNG ....................................... 121
SDF ........................................ 120
SKC ....................................... 120
SMILES ................................. 120
Spartan collection .................. 120
SPARTAN exchange .................. 120
SYBYL MOL and MOL2 ........ 120
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TGF........................................ 120

File menu
append molecule(s) ........... 88,122
close .................................. 29,120
delete molecule ................. 56,122
exit .................................... 11,123
new ................................... 19,119
new molecule .................... 50,122
open .................................. 33,119
print ........................................ 122
print output ............................ 123
print setup .............................. 122
print spreadsheet .................... 123
save ........................................ 121
save as ............................... 33,121

File menu (monitor)
exit ......................................... 245

File Toolbar; Options menu,
file toolbar ................................... 246

Find; Edit menu, find .................. 126

Find Next; Edit menu, find next . 126

Fonts; Options menu, fonts ......... 243

Fonts dialog ................................. 243

Force fields .................................. 249

Fourier fit ....................................... 60

Fourier series, for describing
torsional potential .......................... 58

Free valence ............................ 20,147

Freeze Center; Geometry
menu, freeze center ................. 87,138

Freezing atoms, for output from
the Cambridge Structural
Database................................ 139,225

Frequencies
displaying .............................. 202
units ....................................... 266

Frozen atoms, turning on ........ 87,173

G

G2, G3, G3(MP2) models ........... 251

Geometry menu
align molecules ................. 56,144
constrain angle ....................... 141
constrain dihedral ............. 58,141
constrain distance ............. 79,141
define plane............................ 143
define point ............................ 143
freeze center ...................... 87,138
measure angle ................... 23,136
measure dihedral ............... 23,137
measure distance ............... 23,136
set torsions ............................. 139

Geometry Toolbar; Options
menu, geometry toolbar ............... 246

Global calculations ................. 51,178

Global minimum .......................... 227

Global Model; Model menu,
global model ................................ 132

Global rotate .................................. 12

Global surfaces ....................... 77,185

Graphics module .......................... 253
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Graphical surface selection ..... 32,195

H

Hartree-Fock calculations; See
HF/3-21G(*) calculations,
HF/6-31G* calculations

Hartree-Fock models, range
of application ............................... 250

Heat of formation
displaying ............................... 190
units ........................................ 265

Help, in dialogs ............................. 247

Help menu, on-line help ................ 247

Help menu (monitor) ..................... 244

HF/3-21G calculations, on
acetaldehyde ............................. 62
acetic acid ................................. 66
acetone ..................................... 62
acetophenone ............................ 62
acrylonitrile .......................... 24,51
benzaldehyde ........................... 62
benzoic acid ............................. 66
benzyne .................................... 41
tert-butylaldehyde .................... 62
2-butyne ................................... 42
chloroacetic acid ...................... 66
3-cyano-4-methylcyclohexenyl
radical ...................................... 38
cylohexanone ........................... 31
dichloroacetic acid ................... 66
1,1-dicyanoethylene ................. 51
1,2-dicyanoethylene ................. 51
formaldehyde ........................... 62
formic acid ............................... 66
hexafluoroacetone .................... 62

1-methylcytosine ................... 100
1-pentene ................................. 78
pivalic acid ............................... 66
tetracyanoethylene ................... 51
transition state for Diels-Alder
cycloaddition of
5-fluorocyclopentadiene
and acrylonitrile ....................... 84
transition state for Diels-Alder
cycloaddition of
5-methylcyclopentadiene
and acrylonitrile ....................... 84
transition state for
difluorocarbene addition to
cyclohexene ............................. 88
transition state for
difluorocarbene addition to
ethylene .................................... 87
transition state for ene reaction
of 1-pentene ............................. 76
trichloroacetic acid .................. 66
tricyanoethylene....................... 51
trifluoroacetaldehyde ............... 62
trifluoroacetone ........................ 62
trifluoroacetophenone .............. 62
triglycine ................................ 104
sulfur tetrafluoride ................. 112

HF/6-31G* calculations, on
allyl vinyl ether ........................ 56
cyclohexane ............................. 44
decalin ...................................... 44
dimethylcyclohexane ............... 44
1,2-dimethylperoxide ............... 59
2-hexene................................... 68
2-methylnorbornane................. 69

Hide; Model menu, hide .............. 131

Home key, use of ........................... 14

HOMO energy, displaying ........... 190
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HOMO-LUMO gap ....................... 49

Hydrogen Bonds; Model
Menu, hydrogen bonds ................ 133

Hydrogen bonds, displaying . 108,133

Hydrogens
growing .................................. 191
removing from model;
See Model menu, hide

Hydrogens; Model menu,
hydrogens .................................... 132

I

Iconifying Spartan’04 .................... 16

Imaginary frequency ...................... 76

Implicit search of CSD ......... 226,239

Infrared spectrum, for
benzyne .................................... 43
2-butyne ................................... 43

Insert key, use of ....................... 14,89

Intrinsic reaction coordinate ... 78,171

IRC ......................................... 78,171

IR Spectra dialog .................... 42,202

IR Spectrum, requesting .............. 176

Isotopes ................................... 87,191

Isovalue, fixed ............................. 184

J

Job queue ..................................... 185

JPEG ..................................... 120,239

K

Keystroke equivalents............. 11,255

Killing jobs .................................. 244

Kill Selected; Edit menu
(monitor), kill selected ................. 244

Kinetic product .............................. 79

L

Labels; Model menu, labels ... 23,132

Labels
atoms ...................................... 134
bonds ...................................... 134
charges ................................... 134
chemical shifts .................. 45,134
constraints .............................. 134
planes ..................................... 134
points ..................................... 134
residue .................................... 134
ribbons ................................... 134
R/S .................................... 34,134
strand ..................................... 134

Least squares........................ 53,64,67

Ligand points, defining ................ 143

Ligands ................................. 113,154

Limits; Options menu
(monitor), limits ........................... 244
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Limits dialog ................................ 244

Linear synchronous transit ............. 73

LMP2/6-31G* calculations,
on 1-methylcytosine .................... 101

Local ionization potential ............ 182

Local ionization potential map,
utility ............................................ 181

Localized ..................................... 170

LogP ............................................ 174

LUMO, for cyclohexanone ............ 31

LUMO energy, for
acrylonitrile .............................. 52
1,1-dicyanoethylene ................. 52
1,2-dicyanoethylene ................. 52
tetracyanoethylene ................... 52
tricyanoethylene....................... 52

LUMO energy, displaying ........... 190

LUMO map
for cyclohexanone.................... 31
utility of ................................. 181

M

MacroModel ................................ 120

Make Bond; Build menu,
make bond .............................. 33,162

Mass number
changing ........................... 87,191
displaying .............................. 191

Measure Angle; Geometry
menu, measure angle .............. 23,136

Measure Dihedral; Geometry
menu, measure dihedral .......... 23,137

Measure Distance; Geometry
menu, measure distance .......... 23,136

Mechanics models inSpartan’04 .. 249

Menus ............................................ 11

Minimize; Build menu,
minimize ................................. 21,164

MNDO ......................................... 249

MNDO/d ...................................... 249

MNDO parameters ...................... 249

MMFF.......................................... 249

MMFF calculations,
allyl vinyl ether ........................ 55
3-cyano-4-methylcyclohexenyl
radical ...................................... 38
ethinamate ................................ 37

MMFF parameters ....................... 249

Model ........................................... 170

Model kit; Options menu,
model kit ...................................... 245

Model menu
ball and spoke ................... 22,130
ball and wire ..................... 22,128
configure ........................... 22,133
coupled ............................. 67,132
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global model .......................... 132
hide ........................................ 131
hydrogen bonds ..................... 133
hydrogens .............................. 132
labels ................................. 23,132
ribbons ................................... 133
space filling ...................... 22,128
tube ................................... 22,128
wire ................................... 22,128

MOL, MOL2 ............................... 120

Molecular dynamics, use in
solvation calculations ........... 104,174

Molecular mechanics calculations;
See MMFF calculations

Molecular mechanics models,
range of application ..................... 249

Molecular models
3D ....................................... 14,16
atom colors ............................ 129
ball-and-spoke ......................... 22
ball-and-wire ............................ 22
bond colors ............................ 128
coupling of motions ............... 132
CPK ....................................... 130
global model style .................. 132
hiding ..................................... 131
hydrogen bonds ..................... 133
hydrogens .............................. 132
labels ................................. 28,132
orthogonal projections ........... 128
perspective projections .......... 128
ribbons ................................... 133
rotation of ........................... 12,13
scaling ................................. 12,13
space filling ............................. 22
split tubes ........................ 130,239
translation ........................... 12,13

tube .......................................... 22
wire .......................................... 22

Molecular size.............................. 190

Molecular volume ........................ 190

Molecule builders
amino acids ............................ 155
atomic fragments ................... 146
atomic hybrids ....................... 153
atom/hybrid replacement .. 30,160
bond rotation .......................... 160
bond stretching ...................... 160
bond types .............................. 153
breaking bonds; See Build
menu, break bond
chirality inversion .................. 161
clipboard ........................... 50,151
custom.................................... 150
delete; See Build menu, delete
entry model kit .................. 19,146
expert model kit .............. 111,151
going between builders
................................. 151,155,158
groups ............................... 20,147
ligands ............................. 113,154
making bonds; See Build
menu, make bond
manipulating molecular
fragments ............................ 13,86
minimizing; See Build
menu, minimize
nucleotide bases ..................... 158
nucleotide model kit .............. 158
peptide model kit ............ 102,155
Periodic Table... ..................... 152
rings .................................. 30,148
sequencing polypeptides/
polynucleotides ............... 156,159
terminating polypeptides ....... 157
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Molecule centered rotation ............ 12

Molecule names ............................. 66

Molecule Properties dialog ..... 27,190

Molecule selection ......................... 14

Molecule Utilities dialog ............. 191

Møller-Plesset models available in
Spartan’04

LMP2 ..................................... 251
MP2 ....................................... 251
MP3 ....................................... 251
MP4 ....................................... 251

Monitor; Options menu, monitor.244

Monitor dialog ............................. 244

Mouse ......................................... 12ff

Mulliken charges ......................... 252

Multiplicity ............................. 38,177

N

Names ............................................ 66

New; File menu, new .............. 19,119

New Molecule; File menu,
new molecule .......................... 50,122

NMR chemical shifts ..................... 44

NMR Spectra dialog .................... 205

NMR spectra
plotting ................................... 205

requesting .............................. 176

NOEs, setting ............................... 140

Normal modes of vibration ... 202,266

O

OD, OD(T) models ...................... 251

On-Line Help; Help menu,
on-line help .................................. 247

Open; File menu, open ........... 33,119

Open valence .......................... 20,147

Options menu
about ...................................... 237
arrange icons .......................... 246
build toolbar ........................... 246
calculator ............................... 245
cascade ................................... 246
colors ..................................... 242
file toolbar ............................. 246
fonts ....................................... 243
geometry toolbar .................... 246
model kit ................................ 245
monitor .................................. 244
preferences ............................. 228

miscellaneous ..................... 238
molecule ............................. 240
paths .................................... 242
VDW radii .......................... 241

search toolbar ......................... 246
tile .......................................... 246

Options menu (monitor)
limits ...................................... 244

Orbital energies, units .................. 265
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Output; Display menu, output .26,187

Output window ....................... 26,187

P

Page Up/Down keys ...................... 14

Partial surface area....................... 212

Partial volume .............................. 212

PDB ............................................. 120

PDB files, removing water
molecules ..................................... 240

Paste; Edit menu, paste............... 125

Peptide model kit .................. 102,155

Periodic Table ....................... 159,239

Picking ...................................... 12,13

Plot Properties dialog ........... 197,198

Plots; Display menu, plots ..... 53,216

Plots dialog ............... 53,215,216,217

Plot Style dialog .......................... 198

Plot X-Scale (Y-Scale)
Properties dialog .......................... 197

PM3 ............................................. 249

PM3 calculations, on
benzene .................................. 113
benzene chromium tricarbonyl.113
bis(cyclopentadienyl) (methyl)

zirconium cation .................... 116
Diels-Alder cycloaddition of
cyclopentadiene and maleic
anhydride ................................. 80
ethylene .................................. 116
transition state for ethylene
insertion into
bis(cyclopentadienyl)
(methyl) zirconium cation ..... 115

PM3 parameters ........................... 250

PNG ............................................. 120

Polar surface area......................... 212

Post buttons ..................... 136ff,140ff

Preferences; Options menu,
preferences ................................... 278

Preferences dialog
(miscellaneous) ............................ 238

Preferences dialog (molecule) ..... 240

Preferences dialog (paths) ........... 242

Preferences dialog (VDW Radii) . 241

Preferences, setting ...................... 238

Print; File menu, print ......... 122,123

Print Output; File menu,
print output ........................... 122,123

Print Setup; File menu,
print setup .................................... 122

Print Setup dialog ........................ 122
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Print Spreadsheet; File
menu, print spreadsheet ........ 122,123

Printing
atomic charges ....................... 177
on-screen graphics;
See File menu, print
orbitals and orbital energies ... 177
thermodynamic quantities...... 177
vibrational modes .................. 177

Properties; Display menu,
properties .........................27,189-200

Property archive ........................... 188

Pseudopotential ............................ 171

Q

QCCD, QCCD(2) models ............ 251

QCISD, QCISD(T) models ......... 251

Quitting Spartan’04 ................ 11,123

R

Regression Properties dialog .. 64,201

Retrieve Options dialog .......... 72,232

Rotation about single bonds ........ 160

Rotation, of molecules on screen..12,13

R/S Chirality ............... 13,34,134,191

S

Save; File menu, save .................. 121

Save As; File menu, save as ... 33,121

Save As dialog ........................ 25,121

Scaling ...................................... 12,13

Screen centered rotation ................ 12

SDF .............................................. 120

Search menu
databases ........................... 34,219

Cambridge Structural
Database (CSD) ............. 34,219
Spartan Molecular
Database (SMD)
..................... 37,66,68,70,226ff

tautomers ........................ 100,235
transition states ................. 75,233

Search Options dialog ............. 71,230

Search Toolbar; Options
menu, search toolbar .................... 246

Selection box .......................... 50,126

“Selected” Style dialog ......... 107,201

Semi-empirical calculations;
See AM1 calculations; PM3
calculations

Semi-empirical models
available in Spartan’04 .......... 249
range of application ............... 250

Set Torsions; Geometry menu,
set torsions ................................... 139

Setup menu
calculations ....................... 24,166

Index 12/31/03, 8:27 AM291



292

submit ............................... 24,185
surfaces ............................. 28,179

Shift key, use of .......................... 12ff

Single-point energy........................ 38

Size restrictions in Spartan’04
advanced correlated models... 252
density functional models ...... 251
excited state models ............... 252
Hartree-Fock models ............. 250
molecular mechanics models . 249
Møller-Plesset models ........... 251
semi-empirical models ........... 250

SKC ............................................. 120

SM5.4 ................................... 174,252

SM5.4, calculations for
reaction coordinate for SN2
addition of bromide to
methyl chloride ........................ 91

SM5.4, parameters ....................... 252

SMD; See Spartan Molecular
Database

SMD dialog .. 71,72,228,229,230,232

SMD preview dialog ...................... 37

SMILES ................................ 120,227

Solvation
for decaglycine ...................... 104
for SN2 addition of bromide
to methyl chloride .................... 91
molecular dynamics model .... 174
SM5.4 model .................. 174,252

SOMO, for 3-cyano-
4-methylcyclohexenyl radical........ 40

Space-Filling; Model menu,
space-filling ............................ 22,128

Space-filling model................. 22,128

Spartan’04
advanced correlated models... 251
density functional models ...... 250
dialogs ...................................... 15
essential edition ..................... 249
excited state models ............... 252
graphics .................................. 253
Hartree-Fock models ............. 250
iconifying ................................. 16
keyboard functions .................. 14
keystroke equivalents .............. 11
keywords ................................ 178
killing jobs ............................. 244
mechanics models .................. 249
menus ....................................... 11
molecule selection ................... 14
Møller-Plesset models ........... 251
monitor .................................. 244
monitoring jobs ...................... 244
options ................................... 178
properties ............................... 252
quitting .............................. 11,123
semi-empirical models ........... 249
spectra .................................... 252
starting ..................................... 11
submitting jobs ...................... 185
toolbars .................................... 12
using the mouse .................... 12ff

Spartan Molecular Database
content ................................... 226
generation of .......................... 227
replacement from .... 37,66,68,228
substructure search of ....... 70,229
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user-defined entries ................ 273

Spartan Molecular
Database dialog...........71,72,228-230

Spectra; Display Menu,
spectra ..............................42,202-204

Spin density, for
3-cyano-4-methylcyclohexenyl
radical ...................................... 39
vitamin E radical ...................... 96

Spin density map, for
3-cyano-4-methylcyclohexenyl
radical ...................................... 39

Spin multiplicity ..................... 38,177

Spreadsheet; Display menu,
spreadsheet.............................. 51,205

Spreadsheet
adding columns ................... 207ff
deleting columns .................... 215
deleting rows (molecules) ...... 215
entering numerical data.63,66,209
expressions ............................ 209
printing .................................. 216
regression analyses ................ 208
sorting ............................... 63,215
summarizing columns ............ 208
using the clipboard ................ 215

Spreadsheet dialog ............. 51,52,206

Start from ................................ 38,172

Starting jobs ................................. 244

Starting Spartan’04 ........................ 11

Start Selected; Edit menu
(monitor), start selected ............... 244

Stereo display ................................ 14

Stopping jobs ............................... 144

Strain energy
display of ............................... 190
units ....................................... 265

Subject to ..................................... 173

Submit; Setup menu, submit .. 24,185

Submit dialog ............................... 185

Submitting jobs ............................ 185

Surface area
of CPK model ........................ 212
of graphical surface ............... 195
partial ..................................... 212
polar ....................................... 212
units ....................................... 265

Surface Properties dialog . 32,195,196

Surfaces; Display menu,
surfaces; Setup menu,
surfaces ............................ 28,179,202

Surfaces dialog .................. 28,29,182

Surface Style dialog ..................... 196

SYBYL ........................................ 249

Symmetry, using .......................... 173
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T

Tautomers; Search menu,
tautomers .............................. 100,235

TDDFT (time-dependent
density functional) models........... 252

Terminate dialog ................... 103,157

TGF.............................................. 120

Theoretical model ........................ 170

Thermodynamic product................ 79

Thermodynamic properties,
printing .................................. 177
requesting .............................. 176

Three key, use of in stereo
displays .......................................... 14

Tile; Options menu, tile ............... 246

Toolbars ......................................... 12

Total charge ................................. 176

Transition state geometry .............. 76

Transition States; Search
menu, transition states ............ 75,233

Transition states, guessing ...... 75,233

Translation, of molecules
on screen ................................... 12,13

Tube; Model menu, tube ........ 22,128

Tube model .............................. 22,128

U

Undo; Edit menu, undo .......... 20,125

Units ............................................ 265
Units, conversion factors ...... 213,266

UV/vis spectra dialog .................. 204

UV/vis spectrum
plotting ................................... 204
requesting .............................. 175

V

Valence checking ......................... 160

Van der Waals radii
use in space-filling models .... 131
changing ................................ 241

Verbose output ............................. 188

Vibrational frequencies
displaying .............................. 202
units ....................................... 266

Vibrational frequencies, for
benzyne .................................... 42
2-butyne ................................... 43
transition state for Diels-Alder
cycloaddition of
cyclopentadiene and
acrylonitrile .............................. 83
transition state for
difluorocarbene addition
to ethylene ............................... 87
transition state for ene reaction
of 1-pentene ............................. 76
transition state for ethylene
insertion into
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bis(cyclopentadienyl)
(methyl) zirconium cation ..... 116

View; Build menu, view ......... 21,161

Volume
of CPK model ........................ 212
of graphical surface ............... 195
partial ..................................... 212
units ....................................... 265

W

Wire; Model menu, wire ........ 22,128

Wire model ............................. 22,128

Z

Zooming ................................... 12,13
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